To our customers,

Old Company Name in Catalogs and Other Documents

On April 1%, 2010, NEC Electronics Corporation merged with Renesas Technology
Corporation, and Renesas Electronics Corporation took over all the business of both
companies. Therefore, although the old company name remains in this document, it is a valid
Renesas Electronics document. We appreciate your understanding.
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Send any inquiries to http://www.renesas.com/inquiry.
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Notice

All information included in this document is current as of the date this document isissued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful atention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

Y ou should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. Y ou are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any lossesincurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. Y ou should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the devel opment of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errorsin or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific”. The recommended applications for each Renesas Electronics product depends on the product’ s quality grade, as
indicated below. Y ou must check the quality grade of each Renesas Electronics product before using it in aparticular
application. You may not use any Renesas Electronics product for any application categorized as “ Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not bein any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “ Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “ Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances, machine tools; personal electronic equipment; and industrial robots.
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.
“Specific”: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or heathcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose adirect threat to human life.
Y ou should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especialy with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physica injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as aresult of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sdes office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics’ as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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Keep safety first in your circuit designs!

. Renesas Technology Corp. puts the maximum effort into making semiconductor products better and
more reliable, but there is always the possibility that trouble may occur with them. Trouble with
semiconductors may lead to personal injury, fire or property damage.

Remember to give due consideration to safety when making your circuit designs, with appropriate
measures such as (i) placement of substitutive, auxiliary circuits, (ii) use of nonflammable material or
(iii) prevention against any malfunction or mishap.

Notes regarding these materials

. These materials are intended as a reference to assist our customers in the selection of the Renesas
Technology Corp. product best suited to the customer's application; they do not convey any license
under any intellectual property rights, or any other rights, belonging to Renesas Technology Corp. or
a third party.

. Renesas Technology Corp. assumes no responsibility for any damage, or infringement of any third-
party's rights, originating in the use of any product data, diagrams, charts, programs, algorithms, or
circuit application examples contained in these materials.

. All information contained in these materials, including product data, diagrams, charts, programs and
algorithms represents information on products at the time of publication of these materials, and are
subject to change by Renesas Technology Corp. without notice due to product improvements or
other reasons. It is therefore recommended that customers contact Renesas Technology Corp. or
an authorized Renesas Technology Corp. product distributor for the latest product information
before purchasing a product listed herein.

The information described here may contain technical inaccuracies or typographical errors.
Renesas Technology Corp. assumes no responsibility for any damage, liability, or other loss rising
from these inaccuracies or errors.

Please also pay attention to information published by Renesas Technology Corp. by various means,
including the Renesas Technology Corp. Semiconductor home page (http://www.renesas.com).

. When using any or all of the information contained in these materials, including product data,
diagrams, charts, programs, and algorithms, please be sure to evaluate all information as a total
system before making a final decision on the applicability of the information and products. Renesas
Technology Corp. assumes no responsibility for any damage, liability or other loss resulting from the
information contained herein.

. Renesas Technology Corp. semiconductors are not designed or manufactured for use in a device or
system that is used under circumstances in which human life is potentially at stake. Please contact
Renesas Technology Corp. or an authorized Renesas Technology Corp. product distributor when
considering the use of a product contained herein for any specific purposes, such as apparatus or
systems for transportation, vehicular, medical, aerospace, nuclear, or undersea repeater use.

. The prior written approval of Renesas Technology Corp. is necessary to reprint or reproduce in
whole or in part these materials.

. If these products or technologies are subject to the Japanese export control restrictions, they must
be exported under a license from the Japanese government and cannot be imported into a country
other than the approved destination.

Any diversion or reexport contrary to the export control laws and regulations of Japan and/or the
country of destination is prohibited.

. Please contact Renesas Technology Corp. for further details on these materials or the products
contained therein.







IMPORTANT INFORMATION
READ FIRST

* READ this user's manual before using thisemulator product.
* KEEP the user's manual handy for futurereference.

Do not attempt to use the emulator product until you fully understand its mechanism.

Emulator Product:
Throughout this document, the term "emulator product” shall be defined as the following
products produced only by Renesas Technology Corp. excluding al subsidiary products.

e Emulator station

o User system interface cables

e PCinterface board

e Optiona SIMM memory module
e Optional board

The user system or a host computer is not included in this definition.
Purpose of the Emulator Product:

This emulator product is a software and hardware development tool for systems employing the
Renesas microcomputer (hereinafter referred to asthe MCU). This emulator product must only
be used for the above purpose.

Limited Applications:

This emulator product is not authorized for usein MEDICAL, atomic energy, aeronautical or
space technology applications without consent of the appropriate officer of a Renesas sales
company. Such use includes, but is not limited to, use in life support systems. Buyers of this
emulator product must notify the relevant Renesas sal es offices before planning to use the product
in such applications.

Improvement Policy:

Renesas Technology Corp. (including its subsidiaries, hereafter collectively referred to as
Renesas) pursues a policy of continuing improvement in design, performance, and safety of the
emulator product. Renesas reserves the right to change, wholly or partialy, the specifications,
design, user's manual, and other documentation at any time without notice.

Target User of the Emulator Product:

This emulator product should only be used by those who have carefully read and thoroughly
understood the information and restrictions contained in the user's manual. Do not attempt to use
the emulator product until you fully understand its mechanism.

It is highly recommended that first-time users be instructed by users that are well versed in the
operation of the emulator product.
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LIMITED WARRANTY

Renesas warrants its emulator products to be manufactured in
accordance with published specifications and free from defectsin
material and/or workmanship. Renesas, at its option, will repair or
replace any emulator products returned intact to the factory,
transportation charges prepaid, which Renesas, upon inspection,
determine to be defective in material and/or workmanship.

The foregoing shall constitute the sole remedy for any breach of
Renesas warranty. See the Renesas warranty booklet for details on
the warranty period. Thiswarranty extends only to you, the origina
Purchaser. It isnot transferable to anyone who subsequently purchases
the emulator product from you. Renesasis not liable for any claim
made by athird party or made by you for athird party.

DISCLAIMER

RENESAS MAKES NO WARRANTIES, EITHER EXPRESS OR
IMPLIED, ORAL OR WRITTEN, EXCEPT ASPROVIDED
HEREIN, INCLUDING WITHOUT LIMITATION THEREOF,
WARRANTIESASTO MARKETABILITY, MERCHANTABILITY,
FITNESS FOR ANY PARTICULAR PURPOSE OR USE, OR
AGAINST INFRINGEMENT OF ANY PATENT. IN NO EVENT
SHALL RENESASBE LIABLE FOR ANY DIRECT, INCIDENTAL
OR CONSEQUENTIAL DAMAGES OF ANY NATURE, OR
LOSSES OR EXPENSES RESULTING FROM ANY DEFECTIVE
EMULATOR PRODUCT, THE USE OF ANY EMULATOR
PRODUCT, OR ITSDOCUMENTATION, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES. EXCEPT AS
EXPRESSLY STATED OTHERWISE IN THISWARRANTY,
THISEMULATOR PRODUCT ISSOLD "ASIS", AND YOU
MUST ASSUME ALL RISK FOR THE USE AND RESULTS
OBTAINED FROM THE EMULATOR PRODUCT.

RENESAS




State Law:

Some states do not alow the exclusion or limitation of implied warranties or liability for
incidental or consequential damages, so the above limitation or exclusion may not apply to you.
Thiswarranty gives you specific legal rights, and you may have other rights which may vary from
State to state.

The Warranty is Void in the Following Cases:

Renesas shall have no liahility or legal responsibility for any problems caused by misuse,
abuse, misapplication, neglect, improper handling, installation, repair or modifications of the
emulator product without Renesas' prior written consent or any problems caused by the user
system.

All Rights Reserved:

This user's manual and emulator product are copyrighted and all rights are reserved by
Renesas. No part of this user's manual, al or part, may be reproduced or duplicated in any form,
in hard-copy or machine-readable form, by any means available without Renesas' prior written
consent.

Other Important Things to Keep in Mind:

1. Circuitry and other examples described herein are meant merely to indicate the characteristics
and performance of Renesas' semiconductor products. Renesas assumes no responsibility for
any intellectual property claims or other problems that may result from applications based on
the examples described herein.

2. Nolicenseis granted by implication or otherwise under any patents or other rights of any third
party or Renesas.
Figures:

Some figuresin this user's manual may show items different from your actual system.

Limited Anticipation of Danger:

Renesas cannot anticipate every possible circumstance that might involve a potential hazard.
The warnings in this user's manual and on the emulator product are therefore not al inclusive.
Therefore, you must use the emulator product safely at your own risk.

1
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SAFETY PAGE
READ FIRST

* READ this user'smanual before using thisemulator product.

« KEEP the user's manual handy for futurereference.

Do not attempt to use the emulator product until you fully under stand its mechanism.

DEFINITION OF SIGNAL WORDS

A This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

A DANGER DANGER indicates an imminently hazardous situation which, if not

avoided, will result in death or serious injury.

lAA WARNING]|

WARNING indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

A CAUTION CAUTION indicates a potentially hazardous situation which, if not

avoided, may result in minor or moderate injury.

| CAUTION | CAUTION used without the safety alert symbol indicates a

potentially hazardous situation which, if not avoided, may result
in property damage.

NOT E emphasizes essential information.

RENESAS



AWARNING

Observe the precautions listed below. Failure to do so
will result in a FIRE HAZARD and will damage the user
system and the emulator product or will result in
PERSONAL INJURY. The USER PROGRAM will be
LOST.

1. Do not repair or remodel the emulator product by
yourself for electric shock prevention and quality
assurance.

2. Always switch OFF the E6000 emulator and user system
before connecting or disconnecting any CABLES or
PARTS.

3. Always before connecting any CABLES, make sure that
pin 1 on both sides are correctly aligned.

4. Supply power according to the power specifications and
do not apply an incorrect power voltage. Use only the
provided power cable.

RENESAS




CAUTION

This equipment has been tested and found to comply
with the limits for a Class A digital device, pursuant to part 15
of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own
expense.

\
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I ntroduction

The E6000 emulator is an advanced realtime in-circuit emulator, which allows programs to be devel oped and debugged
for the H8S family microcomputers.

The E6000 emulator can either be used without a user system, for developing and debugging software, or connected viaa
user system interface cable to a user system, for debugging user hardware.

High-performance Embedded Workshop is a Graphical User Interface intended to ease the development and debugging of
applications written in C/C++ programming language and assembly language for Renesas microcomputers. Itsaim isto
provide a powerful yet intuitive way of accessing, observing and modifying the debugging platform in which the
application is running.

High-performance Embedded Workshop is a powerful development environment for embedded applications targeted at
Renesas microcontrollers. The main features are:

e A configurable build engine that allows you to set-up compiler, assembler and linker options via an easy to use
interface.

e Anintegrated text editor with user customizable syntax coloring to improve code readability.
e A configurable environment to run your own tools.

e Anintegrated debugger which alows you to build and debug in the same application.

e Version control support.

High-performance Embedded Workshop has been designed with two key aims; firstly to provide you, the user, with a set
of powerful development tools and, secondly, to unify and present them in away that is easy to use.
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About This Manual

Thismanual contains the following information.
Emulator Debugger Part:  Preparation before use, EG000 emulator functions, debugging function, tutorial, and hardware
and software specifications of the EG000 emulator.

Refer to the High-performance Embedded Workshop User's Manual for details on the information on the basic usage of
the High-performance Embedded Workshop, customization of the environment, build functions, and debugging functions
common to each High-performance Embedded Workshop product.

This manual does not intend to explain how to write C/C++ or assembly language programs, how to use any particular
operating system or how best to tailor code for the individua devices. These issues are | eft to the respective manuals.

Microsoft®, MS-DOS, Windows®, Windows NT® are registered trademarks of Microsoft Corporation.

Visual SourceSafe isatrademark of Microsoft Corporation.

IBM is aregistered trademark of International Business Machines Corporation.

All brand or product names used in this manual are trademarks or registered trademarks of their respective companies or
organizations.

Document Conventions
This manual uses the following typographic conventions:

Tablel Typographic Conventions

Convention Meaning
[Menu->Menu Option] Bold text with ‘->" is used to indicate menu options
(for example, [File->Save As...]).
FILENAME.C Uppercase names are used to indicate filenames.
“enter this string” Used to indicate text that must be entered (excluding the “” quotes).
Key + Key Used to indicate required key presses. For example, CTRL+N means

press the CTRL key and then, whilst holding the CTRL key down,
press the N key.

2 When this symbol is used, it is always located in the left hand margin.
It indicates that the text to its immediate right is describing “how to”

(The “how to” symbol) .
do something.

Components

Check all the components described in the component list unpacking. If the components are not complete, contact a
Renesas sales office.
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Section1 Overview

11 Features

The breakpoint, memory map, performance, and trace can be set through the dialog box.
— Intuitive user interface

— Online help

— Common display and operability

Supported host interfaces

The PCI interface, PC card (PCMCIA) interface, USB interface, or LAN interface can be used for connecting
to the host computer.

Realtime emulation

Realtime emulation of the user system is enabled at the maximum operating frequency of the CPU.
Excellent operability

Using the High-performance Embedded Workshop enables user program debugging using a pointing device

such asamouse. The High-performance Embedded Workshop enables high-speed downloading of 1oad
modulefiles.

Various debugging functions

Various break and trace functions enable efficient debugging. Breakpoints and break conditions can be set
by the specific window, trace information can be displayed on a window, and command-line functions can be
used.

Memory access during emulation
During emulation, the memory contents can be read and modified.
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12 Warnings

CAUTION

READ the following warnings before using the emulator product.
Incorrect operation will damage the user system and the emulator
product. The USER PROGRAM will be LOST.

1. Check al components against the component list after unpacking the emulator.
2. Never place heavy objects on the casing.
3. Do not place the emulator in places where:

e Thetemperature becomes high such asin direct sunlight or near a heater. For details, refer to section 1.3,
Environmental Conditions.

e Thetemperature or humidity changes gresatly.

e Thereisalot of dust.

e Thereisalot of vibration. For details, refer to section 1.3, Environmental Conditions.

. Protect the emulator from excessive impacts and stresses.

. Only supply the specified voltage and power-supply frequency.

When moving the emulator, take care not to vibrate or damage it.

. After connecting the cable, check that it is connected correctly. For details, refer to section 2, Preparation
before Use. Supply power to the connected equipment after connecting all cables. For the supplying
procedures, refer to section 2.7, System Check. Cables must not be connected or disconnected while the
power ison.

N o oA
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13 Environmental Conditions

CAUTION

Observe the conditions listed in table 1.1 when using the emulator.
Failure to do so will cause illegal operation in the user system, the
emulator product, and the user program.

Table1.1 Environmental Conditions

Item Specifications
Temperature Operating: +10°C to +35°C
Storage: —10°C to +50°C
Humidity Operating: 35% RH to 80% RH, no condensation
Storage: 35% RH to 80% RH, no condensation
Vibration Operating: 2.45 m/s’ max.
Storage: 4.9 m/s® max.

Transportation: 14.7 m/s* max.

Ambient gases

No corrosive gases may be present

14 Emulator External Dimensions and Mass

Table1.2 Emulator External Dimensionsand Mass

Item Specifications
Dimensions 219 x 170 x 54 mm
Mass Approximately 1,000 g
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Section 2 Preparation before Use

21 Emulator Preparation

Unpack the emulator and prepare it for use as follows:

A WARNING

READ the reference sections shaded in figure 2.1 before using the
emulator product. Incorrect operation will damage the user system and
the emulator product. The USER PROGRAM will be LOST.

Reference

Unpack the emulator Component list
T

Check the components against
the component list

I Setup
Section 3

Set up the emulator

- Insert the optional board

- Install the High-performance Embedded Workshop
- Connect the interface cable

Turn on the user system Section 4
(Only when the user system is connected)

Activation

Turn on the emulator |
I

Start the High-performance Embedded Workshop |

Figure2.1 Emulator Preparation Flowchart

22 Installing Emulator’s Software

Toinstall the High-performance Embedded Workshop, refer to the Setup Guide for the E6000 Emulator supplied
together with the emulator.
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23 Connecting to the User System
To connect the emulator to a user system, proceed as follows:

o Connect the user system interface cable head to the user system.
e Plug the cable body into the emulator.
e Plug the cable body into the cable head.

For details of these steps, refer to the User System Interface Cable User’s Manual.

Figure 2.2 gives details of the connectors provided on the emulator.

EB000 < PC interface cable

connector
User system P\\_/\

interface connector

<— Power connector

External probe ——> <~ Power switch
connector — —
Screw Screw

Figure2.2 E6000 Emulator Connectors

231 Example of Connecting the User System Interface Cable Head to the User System

Screw (x 4)

RN
f ¥

] User system interface
| cable hea

]

Figure 2.3 Example of Connecting User System Interface Cable Head to User System

e Ensurethat al power isoff to the emulator and the user system.
o Insert the cable head into the socket on the user system.

Note: Depending upon the package, it may be possible to orientate this cable head in any position on the socket,
so care should be taken to correctly identify pin 1 on the emulator and socket when installing.

RENESAS




e Screw the cable head to the socket with the screws provided. Progressively tighten the screws in the sequence
shown in figure 2.4 until all are ‘finger tight'.

© 06

<]

®

Figure2.4 Seguence of Screw Tightening

Note:  Be careful not to over-tighten the screws as this may result in contact failure on the user system or
damage the cable head. Where provided, use the ‘solder lugs' on the QFP socket to provide extra
strength to the emulator/user system connection.

232 Plugging the User System Interface Cable Body into the Emulator

Plug the cable body into the emulator, taking care to insert it straight, and push it firmly into place.

User system interface cable body

User system interface cable head

| \

User system interface cable

Figure2.5 Plugging User System Interface Cable Body to Emulator

233 Plugging the User System Interface Cable Body into the Cable Head

Plug the cable body into the cable head on the user system.
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24 Power Supply

241  AC Adapter

The AC adapter supplied with the emulator must be used at all times.

242 Polarity

Figure 2.6 shows the polarity of the power-supply plug.

5V (outside)

GND (inside)

Figure2.6 Polarity of Power Supply Plug

243 Power Supply Monitor Circuit

The emulator incorporates a power supply monitor circuit which only lights the red LED when a voltage higher
than 4.75 V is supplied. If thisLED is not illuminated, you should check the emulator voltage level. An input
voltage less than 4.75 V could indicate that enough current cannot be supplied to the emulator.

Note: Use the provided AC adapter for the emulator.

25 SIMM Memory Module

E6000 emulator’s optional SIMM memory modules are available which provide emulation memory for user
code without needing a user system. The optional SIMM memory modules are available in different memory
size, but all are partitioned into four equal banks. These banks can be relocated on page boundaries anywhere in
the user area. Note that, however, some products do not support the SIMM memory module.

251 Optional SIMM Memory M odule Configuration

The configuration of the optional SIMM memory module is controlled by the mapping RAM. Opening the
[Memory] sheet of the [System Status] window allows you to check which optional SIMM memory module, if
any, isinstalled and also allows the four banks to be relocated to the required addresses from the [Memory
Mapping] dialog box.
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2.6 Hardwar e I nterface

All signals are directly connected to the MCU in the emulator with no buffering with the exception of those
listed in section 7, Hardware Specifications Specific to This Product.

26.1 Signal Protection on the emulator
All signals are over/under voltage protected by use of diode arrays. The only exceptions being the AV and Vref.
All ports have pull-up resistors except for analog port.

All V. pins on the cable head assembly are connected together (with the exception of the AV . pin), and are
then monitored by the emulator to detect powered user system presence.

2.6.2 User System Interface Circuits

Theinterface circuit between the MCU in the emulator and the user system has a signal delay of about 8 ns due
to the user system interface cable and it includes pull-up resistors. Therefore, high-impedance signals will be
pulled up to the high level. When connecting the emulator to auser system, adjust the user system to compensate
for propagation delays.

The following diagrams show the equivalent circuit examples of the interface signals. The interface circuits
depend on the MCU type. For details, refer to section 7, Hardware Specifications Specific to This Product.

2.6.3 Clock Oscillator

The oscillator circuit has been implemented on the user system interface cable head. For details on the oscillator
circuit, refer to the user's manual for each user system interface cable.

26.4 External Probe 1 (EXT1)/Trigger Output

An 8-pin connector, marked EXT1 (on the right under the user system interface cable connector), on the
emulator case accommodates four external probe inputs and two trigger outputs. The pin assignment of this
connector is shown in figure 2.7.

[
GND| GND |
Tuvce Tsv

OOO0OOO000| exm
[ |
T 11

Probe Trigger output

Figure2.7 External Probe Connector 1
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Theinterface circuit for the external probe 1 isshownin figure 2.8.

Vce
10 kQ
HD151015 External probe 1, 2, 3, 4

22Q

Figure2.8 Interface Circuit for External Probe 1
The trigger output is controlled by event channel 8 and is an active low signal. The trigger output is available as

either T5V (within the range from 2.5V to 5 V; does not depend on the user V . level) or TUV . (the user V.
level).

265 External Probe 2 (EXT2)/Trigger Output

A 6-pin connector, marked EXT2 (on the left under the user system interface cable connector), on the emulator
case accommodates four trigger outputs. The pin assignment of this connector is shown in figure 2.9.

OOOOOO |exr
| | | | 56
T 11

Trigger output

Figure2.9 External Probe 2 Connector

The trigger output is an active high signal which is output during the read or write cycles when a trace condition
(1 to 4) of the bus monitor function is satisfied. The trigger output is available as user V. level. Note that,
however, some products do not support the external probe 2 (EXT2).

10
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2.6.6 Voltage Follower Circuit

CAUTION

1. Do not connect the user system interface cable to the emulator
without user system connection.
2. Turn on the user system before starting up the emulator.

A voltage follower circuit isimplemented on the emulator which allows the user system voltage level from the
user system to be monitored. This monitored voltage level is automatically supplied to the logic on the emulator
and is derived from the emulator power supply unit. This means that no power is taken from the user system
board.

If no user system interface cable is connected to the emulator, the emulator will operate at a specified voltage
and all clock frequencies will be available to the user. If the user system interface cable is attached, the emulator
will match the voltage supplied to the user target in &l cases; i.e. even when the user V. is below the operating
voltage for the MCU. Y ou must be careful not to select an invalid clock frequency. When the emulator is
connected to the user system and the user system is turned off, the voltage follower circuit output voltage level is
0V. Inthis case, the emulator will not operate correctly.

You can set auser V. threshold in the range Vcc max. — 0 V by using the emulator configuration dialog box. If
the user V. drops below this threshold, [User System Voltage] in the [Extended Monitor] window will display
Down, otherwise OK is displayed.

33V - - o o

User Vcc level threshold

oV - - - - ------ - Y-
User Vcc oK — - .
threshold b | | |

own - - - - - - - .- R

E6000
Vcc level

The user system interface
cable is not connected.

Figure2.10 Voltage L evel Monitoring (Examplefor Vcc = 3.3 V)
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2.7 System Check

When the software is executed, use the procedure below to check that the emulator is connected correctly. Here,
use the workspace for atutorial provided on the product.

Refer to section 2.9, Other Methods for Activating the Emulator, for the other activating method to create a new
project or use a workspace for the High-performance Embedded Workshop of the old version.

. Connect the emulator to the host computer.

. Connect the user system interface cable to the connector of the emulator.

. Turn on the emulator.

. Activate the High-performance Embedded Workshop from the [Programs] in the [Start] menu (figure 2.11).

A W DN P

4 @ Accessories P
@ [ 3 @ Startup 3
B et fn Hich
@ %4 Renesas Autolpdate
@ Renesas Tools HomePage

e
=]
|
g
El
3
=
b

) nce Embe: B
@ High-performance Embedded Workshop Help

@ High-performance Embedded Workshop Read Me

Figure2.11 [Start] Menu

Note: If ‘LAN Driver’ isnot selected at installation, [Tools] is not displayed.

12
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5. The[Welcome!] dialog box is displayed.

2lxl
r— Options:
% Create a new project workspace Cancel |
é =) Open arecent project workspace: édministration.._l
| |
o) .
. g " Browse to another project workspace

Figure2.12 [Welcome!] Dialog Box

To use aworkspace for the tutorial, select the [Browse to another project workspace] radio button and click the
[OK] button.

When the [Open Workspace] dialog box is opened, specify the following directory:
OSinstallation drive \Workspace\Tutorial\E6000\xxxx

Note: The directory mentioned above cannot be specified depending on the version of the software. In such
cases, specify the following directory instead.

High-performance Embedded Workshop installation destination directory
\T ool s\Renesas\DebugComp\Platform\E6000\xxxx\T utorial

After the directory has been specified, select the following file and click the [Open] button.

21X

Laak in: Ia Tutarial j - £ Eg-

Debug_HS5_2237_EA000_Emulator_CP
Source

File narne: IT utornial. hws Open I
Files af type: IWorkspaces [ hwsz) j Cancel |
2|

Figure2.13 [Open Workspace] Dialog Box

13
RENESAS




When no compiler package or that of a different version isinstalled, the following message box will be displayed.

High-performance Embeddes il

Tutarial

': Taol Chain ‘Hitachi HES,HEI300 Standard Toolchain', version z:wed is missing from the Following projeckis)
there is no compatible toolchain available

Figure2.14 Message Box

6. The[E6000 Driver Details] dialog box isdisplayed. Thisdialog box isonly displayed at the first initiation.
When only one of interface driversis selected, this dialog box is not displayed.

E&O00 Dr
Driver: |Emu|ator PCI Gard Driver ;I
—Detailz
Interface:  [PCI =
Channel: IEmuIator PCI Gard Interface LI

—Configuration

Confieure.. |

[~ Change driver in start up

Figure2.15 [E6000 Driver Details] Dialog Box

e Inthe[Driver] combo box, select the driver to connect the emulator.
o [Interface] displaysthe name of the interface to be connected.
e Click the[Close] button.

14
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7. Set upthe emulator. During this process, the following dialog box is displayed.

Connecking

Attempting to connect the emulatar,
The driver program has been initialized(Emulator PGI Card Drlver)
Starting to transfer a firmware file.

[” Chanee driver in start up

Close |

Figure2.16 [Connecting] Dialog Box

RENESAS
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8. When "Connected" is displayed in the [Output] window of the High-performance Embedded Workshop, the
emulator initiation is completed.

: ol
Eile Edt Wew Project Buld Debug Setup Tools ‘Window Help == x|
£ Tutorial
=7 Tutorial
ey b eurcel 1 PR T T T T T T L T DT T T T T T T LT T T —
-3 dbset.c 2 ‘e s
Q shrk.c 3 /% FILE :Tutorial.cpp L7s
53 v sowcefie 4 /% DESCRIPTION :Main Program w/
2] resetpra.cpp s o i
Q sort.epp 3 ;: This file is generated by Hitachi Project Generator (Ver.zZ.4). :j
b o IR 2 VUV LSOV .
[ Tutorial.abs g
£ Dependencies 10 #ifdef _ cplusplus
11 extern "CM
1z #endif
13 void sbort(void):
14 #ifdef _ cplusplus
15 ¥
16 #endit
17 #include "sort.h"
18 #include <stdlib.h>
19
20 void tutorial (void):
21
2z void wain(void)
23 1
24 while (1)1
25 tutorial();
26 i
K1l of

The memory map information have been initialized. -
The trace wemory has been initialized.

User Reset signal is Inactive

User NMI signal is Inactive

User Wait signal iz Inactive

User standby signal iz Inactive

Connection to the emulator has been completed successfully.

Connected

4+, Build }, Debug j Findiin Files i Version Control [

Ready =

7| |pefaultl desktop  [Read-writs [1je4 1 S [ um

Figure2.17 High-performance Embedded Workshop Window
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2.8 Communication Problems

The following message box will be displayed when the emulator power is turned off or the PC interface cable is
not correctly connected.

xxxxx E6000 Emulator x|

& A verification error has occurred during the bransfer of a firmware file.,

This is probably because the emulator has been turned off or another emulator has been connected.

Figure2.18 Error Message

For information on other errors, refer to the Setup Guide for the EG000 Emulator.
2.9 Other Methodsfor Activating the Emulator
Refer to section 4, Preparation before Use.

2.10 Uninstalling the Emulator’s Software

For details on uninstallation, refer to the Setup Guide for the E6G000 Emulator.

17
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Section 3 E6000 Emulator Functions

31 Debugging Features

311 Breakpoints

The emulator provides a comprehensive range of aternative types of breakpoints, to give you the maximum
flexibility in debugging applications and user system.

Hardware Break Conditions. Up to 12 break conditions can be defined using the event and range channelsin
the complex event system (CES). For more information about the hardware break conditions, see section 3.2,
Complex Event System (CES).

Softwar e Breakpoints: Up to 256 software breakpoints can be defined. These software breakpoints are set by
replacing the user instruction by a BREAK instruction. In target ROM, only one breakpoint (on-chip break) can
be set.

312 Trace

The emulator incorporates a powerful realtime trace facility which allows you to examine MCU activity in detail.
The realtime trace buffer holds up to 32768 bus cycles, and it is continuoudly updated during execution. The
buffer is configured as arolling buffer, which can be stopped during execution and read back by the host
computer without halting emulation.

The data stored in the trace buffer is displayed in both source program and assembly languages for ease of
debugging. However, if trace filtering is used, only assembly language can be displayed.

The buffer can be set up to store all bus cycles or just selected cycles. Thisis called trace acquisition and uses the
complex event system (CES) to select the parts of the program you are interested in.

It isalso possible to store al bus cycles and then just look at selected cycles. Thisis called trace filtering.

313 Execution Time M easur ements

The emulator allows you to measure the total execution time, or to measure the time of execution between
specified events in the complex event system. Y ou can set the resolution of the timer to any of the following
values:

20 ns, 125 ns, 250 ns, 500 ns, 1 s, 2 s, 4 ps, 8 pis, or 16 ps.

At 20 ns the maximum time that can be measured is about six hours, and at 16ps the maximum time is about 200
days.

314 Performance Analysis

The emulator provides functions for measuring the performance of aprogram. The performance of the specified
program range can be displayed either as a histogram or in percentage form. A timer resolution of 20 ns, 40 ns,
or 160 ns can be selected. In addition, the execution count of the specified program range can be measured (1 to
65535).

19
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315 BusMonitoring

The emulator incorporates a bus monitoring function that monitors and displays the contents of the accessed area
in High-performance Embedded Workshop windows without stopping the program execution. Up to eight
blocks of 256 bytes can be monitored. In addition, the emulator can output trigger signals from external probe 2
(EXT2) when specified addresses (four points max.) are accessed. Note that, however, some products do not
support the bus monitoring function.

32 Complex Event System (CES)

In most practical debugging applications, the program or hardware errors that you are trying to debug occur
under a certain restricted set of circumstances. For example, a hardware error may only occur after a specific
area of memory has been accessed. Tracking down such problems using simple software breakpoints can be very
time-consuming.

The emulator provides a very sophisticated system for giving a precise description of the conditions you want to
examine, called the complex event system. This allows you to define events which depend on the state of a
specified combination of the MCU signals.

The complex event system provides a unified way of controlling the trace, break, and timing functions of the
emulator.

321 Event Channels

The event channels allow you to detect when a specified event has occurred. The event can be defined as a
combination of one or more of the followings:

e Addressor addressrange

e Address outside range

e Read or Write or either

e Data, with an optional mask

e MCU accesstype (e.g., DMAC and instruction prefetch)

e MCU access area (e.g., on-chip ROM and on-chip RAM)
e A signal state on one or more of the four external probes
e A certain number of times that the event must be triggered
o Delay cycles after an event

Up to eight events can be combined into a sequence, in which each event is either activated or deactivated by the
occurrence of the previous event in the sequence. For example, you can cause a break if an 1/0 register is written
to after a specified area of RAM has been accessed.

20
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322 Range Channels

The range channels can be set up to be triggered on a combination of one or more of the following:

Address or address range (inside the range)

Read or Write or either

Data, with an optional mask

MCU access type (e.g., DMAC and instruction prefetch)
MCU access area (e.g., on-chip ROM and on-chip RAM)
A signal state on one or more of the four external probes
Delay cycles after an event

The complex event system can be used to control the following functions of the emulator:

323 Breaks

Use breaks to interrupt program execution when a specified event, or sequence of events, is activated. For

example, you can set up a break to halt execution when the program reads from one address, and then writes to
another address. The break can also optionally be delayed by up to 65535 bus cycles.

324 Timing

Y ou can set up two events and then measure the execution time of the program between the activation of the first
event and second event.

RENESAS
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33 Hardwar e Features

331 Memory

The emulator provides standard emulation memory as the substitute for on-chip ROM memory and on-chip
RAM memory. When a device type or device mode without an on-chip ROM or on-chip RAM is selected, the
standard emulation memory is disabled. When debugging with only the emulator and the user program and data
are stored in an external address space, an optional SIMM memory module must be used. The optional SIMM
memory modules can be separately purchased.

The emulation memory can be mapped in 64-byte units to any number of separate memory blocksin the MCU
address space. Each memory block can be specified using the memory mapping function as user (Target) or
emulator (SIMM memory module) and, in each case, the access can be specified as read-write, read-only, or
guarded.

The definition of each type of memory is as follows:

Table3.1 Memory Types

Memory Type Description

On-chip Uses the MCU on-chip memory.

User Accesses the user system memory.

Emulator Accesses the emulator SIMM memory module.

The contents of a specified block of memory can be displayed using the memory function. The contents of
memory can be modified at any time, even during program execution and the results are immediately reflected in
all other appropriate windows.

Note that modifying memory contents during program execution has the following time requirements:

1. MCU on-chip ROM or RAM, or emulator SSIMM memory module
The emulator modifies the memory contents by temporarily switching the memory bus to the emulator side
without stopping the user program execution. Therefore, the emulator uses the memory bus for up to 80 psin
reading of 256 bytes (25 MHz, on-chip ROM).

2. MCU on-chip I/0, DTCRAM, or user system memory
The emulator stops the user program execution, then modifies the memory contents. Therefore, the user
program stops for a maximum of 2 msin reading 256 bytes (25 MHz, emulation memory).

22
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332 Clocks

The clock can be specified as emulator internal clock or target clock. The frequencies that can be specified as
the emulator internal clock depend on the MCU. For details, refer to section 8, Software Specifications Specific
to This Product.

333 Probes

External probes 1 and 2 (EXT1 and EXT2) can be connected to the emulator, to make use of signals on the user
system for break or trace. The signal for external probe 1 can be set as the condition for the event detection
system depending on the low or high level. Since the signal for external probe 2 outputs high level when the
trigger setting (1 to 4) condition is matched in the bus monitor function, the signal can be used for the trigger
condition for such as an oscilloscope.

3.4 Stack Trace Function

The emulator uses the stack’ s information to display the name of the calling function for afunction at which the
program counter is currently pointing. This function can be used only when the load module that has the
Dwarf2-type debugging information is loaded. For the usage of thisfunction, refer to section 6.17, Stack Trace
Function.

3.5 OnlineHelp

An online help explains the usage of each function or the command syntax that can be entered from the
command line window.

Select [Emulator Help] from the [Help] menu to view the emulator help.
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Section 4 Preparation before Use

41 Method for Activating High-performance Embedded Workshop
To activate the High-performance Embedded Workshop, follow the procedure listed below.

1. Connect the emulator to the host computer.

2. Connect the user system interface cable to the connector of the emulator if you use the user system interface
cable. Thisis not necessary when you do not use the user system interface cable.

3. Turn on the emulator. Be sure to turn on the user system before supplying power to the emulator if you use
the user system.

4. Activate the High-performance Embedded Workshop from [Programs] in the [Start] menu.

5. The[Welcome!] dialog box is displayed.

21|

— Options: ok

¥ iCreate a new project workspace -

% . Open arecett project workspace: Administration. .

=)

g2 Browse to another project workspace

Fl

Figure4.1 [Welcome!] Dialog Box
[Create a new project workspace] radio button: Creates a new workspace.

[Open arecent project workspace] radio button: Uses an existing workspace and displays the history of the
opened workspace.

[Browse to another project workspace] radio button: Uses an existing workspace; this radio button is used when
the history of the opened workspace does not remain.

In this section, we describe the following three ways to start up the High-performance Embedded Workshop:

e [Create anew project workspace] - atoolchain is not in use

e [Create anew project workspace] - atoolchainisin use

e [Browseto another project workspace]

The method to create a new workspace depends on whether atoolchain is or is not in use. Note that this emulator
product does not include atoolchain. Use of atoolchain is available in an environment where the H8S, H8/300

series C/C++ compiler package has been installed. For details on this, refer to the manual attached to the H8S,
H8/300 series C/C++ compiler package.

25
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411 Creating a New Workspace (Toolchain Not Used)

1. Inthe [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is activated,
select [Create a new project workspace] radio button and click the [OK] button.

21

oK

— O ptiotis:

% iCreate a new project workspace Bere]

Adminigtration...

Fll

=) Open arecent project workspace:
— | =l

=
£ " Browse to another project workspace

Figure4.2 [Welcome!] Dialog Box
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2. Creation of anew workspace is started. The following dialog box is displayed.

21

Wwiorkspace Hame:

Isample

Project Name:

Isample

Directory:

IE:\HewS\sample Browsze... |

LCPL farnily:
[Has Ha/300 =l

Tool chain:

INone j

Properties.... |

Ok I Cancel

Figure4.3 [New Project Workspace] Dialog Box

[Workspace Name] edit box: Enter the new workspace name.

[Project Name] edit box: Enter the project name. When the project name is the same as the workspace name,
it needs not be entered.

[Directory] edit box: Enter the directory name in which the workspace will be created. Click the [Browse...]
button to select adirectory.

[CPU family] combo box: Select the target CPU family.

Other list boxes are used for setting the toolchain; the fixed information is displayed when the toolchain has not
been installed.

Click the [OK] button.
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3. Select the target platform of the session file. The following dialog box is displayed.

sebugging ﬂﬁl

— Targets :

wiryy EBOO0 Emulator CPU 2600
000 E rmulatar CPL 1]

Target type ; I 2600 ﬂ

< Back I Mest » I Finizh | Cancel |

Figure4.4 [New Project — Step 7] Dialog Box

Thetarget platform for the session file used when the High-performance Embedded Workshop is
activated must be selected here. Check the box against the target platform and then click the [Next]
button. For details on the session file, refer to the High-performance Embedded Workshop user’s manual.
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4. Set the configuration file name.

2]

Target name :

1 Ernulator CP

Configuration name :
|Debug_yyyy_EGO00_Emulatar_CF

— Detail options :

Item | Yalue |

I odify |

< Back I Mest » I Finizh | Cancel |

Figure4.5 [New Project — Step 8] Dialog Box

If multiple target platforms were selected in the [New Project — Step 7] dialog box shown in figure 4.5, set
the name of a configuration file for each of them, each time pressing the [Next] button to proceed to the next
target.

Setting of the configuration file name is the end of the emulator settings.

Click the [Finish] button to display the [Summary] dialog box. Pressing the [OK] button activates the High-
performance Embedded Workshop.

5. After the High-performance Embedded Workshop has been activated, the emulator is automatically
connected. The message “ Connected” is displayed on the [Debug] tab in the [Output] window to indicate the
completion of connection.
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4.1.2 Creating a New Workspace (Toolchain Used)
1. Inthe [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is activated,
select [Create a new project workspace] radio button and click the [OK] button.

21

oK

— O ptiotis:

% iCreate a new project workspace Bere]

Adminigtration...

Fll

=) Open arecent project workspace:
— | =l

=
£ " Browse to another project workspace

Figure4.6 [Welcome!] Dialog Box
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2. Creation of anew workspace is started. The following dialog box is displayed.

il d
Wwiorkspace Hame:
& Aszembly Application Isample
o j
D emonstlatllon . Eiet M
@ Emply Application
& Import Makefile Isample
@ Library Diirectany:
ID:\HewB\sampIe Browsze... |
LCPL farnily:
[Hes Has00 |
Tool chain:
[ Hitachi H85 H8/300 Standard =l
Properties.... |
Ok I Cancel

Figure4.7 [New Project Workspace] Dialog Box

[Workspace Name] edit box: Enter the new workspace name. Here, enter ‘test’.

[Project Name] edit box: Enter the project name. When the project name is the same as the workspace name,
it needs not be entered.

[Directory] edit box: Enter the directory name in which the workspace will be created. Click the [Browse...]

button to select adirectory.

[CPU family] combo box: Select the target CPU family.

[Tool chain] combo box: Select the target toolchain name when using the toolchain. Otherwise, select
[None].

[Project type] list box: Select the project type to be used.

Notes: 1. When [Demonstration] is selected in the emulator, note the followings:
The [Demonstration] isa program for the simulator attached to the H8S, H8/300 compiler package.
To use the generated source file, delete the Printf statement in the source file.

31
RENESAS




3. Make the required setting for the toolchain. When the setting has been completed, the following dialog box
isdisplayed.

fed 4
— Targets :
wyyy EG000 Emulatar GPL
0 Emula 1]
Target type : IAII Targets j
< Back I Hext » I Finizh | Cancel |

Figure4.8 [New Project — Step 7] Dialog Box

The target platform for the session file used when the High-performance Embedded Workshop is activated
must be selected here. Check the box against the target platform and then click the [Next] button. For details
on the session file, refer to the High-performance Embedded Workshop user’s manual.
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4. Set the configuration file name.

21|

Target name :

Configuration name :

IDEbUE_W_EﬁDDD_E mulator GP

— Detail options :

Item | Yalue |

T odify |

< Back I Mest » I Finizh | Cancel |

Figure4.9 [New Project — Step 8] Dialog Box

If multiple target platforms were selected in the [New Project — Step 7] dialog box shown in figure 4.9, set
the name of aconfiguration file for each of them, each time pressing the [Next] button to proceed to the next
target.

Setting of the configuration file name is the end of the emulator settings.

Complete the creation of a new workspace according to the instructions on the screen. This activates the
High-performance Embedded Workshop.

. After the High-performance Embedded Workshop has been activated, connect the emulator. However, itis
not necessary to connect the emulator immediately after the High-performance Embedded Workshop has
been activated.

Select either of the following two ways to connect the emulator: connecting the emulator after the setting at
emulator activation or without the setting at emulator activation. For details on the connection of the
emulator, refer to section 4.2, Connecting the Emulator.
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4.1.3 Selecting an Existing Workspace

1. Inthe [Welcome!] dialog box that is displayed when the High-performance Embedded Workshop is activated,
select [Browse to another project workspace] radio button and click the [OK] button.

el d
r— Options:
" Lreate a new project workspace Cancel |
é =) Open arecent project workspace: édministration.._l
| -
= : : :
> (% Brawse o another project workspace:

Figure4.10 [Welcome!] Dialog Box

2. The[Open Workspace] dialog box is displayed. Select a directory in which you have created a workspace.
After that, select the workspace file (.hws) and press the [Open] button.

Loak im: I@ zample j = =5 Ed-

sample

File narne: |sample. hwig Open I
Files of twpe: IWorkspaces [# hiwis) j Cancel |/
A

Figure4.11 [Open Workspace] Dialog Box

3. Thisactivates the High-performance Embedded Workshop and recovers the state of the selected workspace
at thetime it was saved.
When the saved state information of the selected workspace includes connection to the emulator, the
emulator will automatically be connected. To connect the emulator when the saved state information does not
include connection to the emulator, refer to section 4.2, Connecting the Emulator.
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4.2 Connecting the Emulator
Select either of the following two ways to connect the emulator:

(a) Connecting the emulator after the setting at emulator activation
Select [Debug -> Debug Settings...] to open the [Debug Settings] dialog box. It is possible to register the
download module or the command chain that is automatically executed at activation.

When the dialog box is closed after setting the [Debug Settings] dialog box, the emulator will automatically
be connected.

(b) Connecting the emulator without the setting at emulator activation

Connect the emulator by simply switching the session file to one in which the setting for the emulator use has
been registered.

Al —
- R i

~ Serojects [ B Temeius | nwagaton

= 0 = s [ W

Figure4.12 Selecting the Session File

In thelist box that iscircled in figure 4.12, select the session name including the character string that has been
set in the [Target name] text box in figure 4.9, [New Project — Step 8] dialog box. The setting for using the
emulator has been registered in this session file.

After the on name is selected, the emulator will automatically be connected. For details on the session file,
refer to the High-performance Embedded Workshop user’s manual.
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4.3 Reconnecting the Emulator
When the emulator is disconnected, use the following way for reconnection:
Select [Debug -> Connect] or click the [Connect] toolbar button (). The emulator is connected.

Note: Before reconnecting the emulator, aload module must be registered to the High-performance Embedded
Workshop.

4.4 Ending the Emulator
When using the toolchain, the emulator can be exited by using the following two methods:

e Canceling the connection of the emulator being activated
e Exiting the High-performance Embedded Workshop

(1) Canceling the connection of the emulator being activated
Select [Debug -> Disconnect] or click the [Disconnect] toolbar button (% ).
(2) Exiting the High-performance Embedded Workshop

Select [File -> Exit].

A message box is displayed. If necessary, click the[Yes] button to save asession. After saving a session, the
High-performance Embedded Workshop exits. If not necessary, click the [No] button to exit the High-
performance Embedded Workshop.

High-performance Embedde, 0 x|

& Session has been modified - do you want ko save it

Yes Mo | Cancel |

Figure4.13 [Session has been modified] M essage Box
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Section 5 Debugging

This section describes the debugging operations and their related windows and dialog boxes.

Refer to the High-performance Embedded Workshop user's manual about High-performance Embedded
Workshop common functions as below.

— Preparations for Debugging

— Viewing a Program

— Operating Memory

— Displaying Memory Contents as Waveforms
— Displaying Memory Contents as an Image
— Modifying the variables

— Viewing the /0O Memory

— Looking at Registers

— Executing Your Program

— Viewing the Function Call History

— Debugging with the Command Line Interface
— Elf/Dwarf2 Support

— Looking at Labels
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51 Setting the Environment for Emulation

511 Opening the [Configuration Properties] Dialog Box

Selecting [Setup -> Emulator -> System...] or clicking the [Emulator System] toolbar button ([t]) opensthe
Configuration Properties] dialog box.

2]
General |
Devics: Uzer Signals
Lomiliee ¥ User Beset enable
Mode: I? [adwanced mode, single chip) j ¥ User Nl enable
B ™ Wser Standby enable
ing i v UserBus Reguest enable
Clock:  [Mair10MHz, Sub:32kHz =
Timer R esolution: |'|25n3 ﬂ

Flazh b emory Contral: I vl

[ Enable read and writs on the fly
v Break on access emor
[" Enable intemal ROM area wiite

User VCC Theshold = 4.00v 4 | Il o

Diiver: |[FB000 USB Diiver

[ Change diiver in start up

ak I Cancel |

Figure5.1 [Configuration Properties| Dialog Box ([General] Page)

This dialog alows the user to set conditions for the target MCU before downloading a program to the emulator.
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[General] page

[Device] Selects the MCU to be emulated. To use an MCU not included in the list,
select CUSTOM to specify the functions required for this MCU. See the
hardware manual for details.

[Mode] Selects the MCU's operating mode.

[Clock] Selects the speed of the MCU'’s clock and sub-clock.

[Timer Resolution]

Selects the resolution of the timer for use in execution time measurement.
The value 20 ns, 125 ns, 250 ns, 500 ns, 1 us, 2 us, 4 us, 8 us, or 16 us
can be selected.

The timer for execution time measurement has a 40-bit counter.

At 20 ns the maximum time that can be measured is about six hours, and
at 16 ps the maximum time is about 200 days.

When the counter overflows, the maximum time possible for
measurement will be displayed with prompt “>" that indicates that the
counter has overflowed.

[Enable read and write on the
fly]

When this box is checked, it is possible to access the target system
memory while the user program is running. Do not check this check box if
you require realtime emulation.

[Break on access error]

When this box is checked, a break (the user program stops) occurs if
your program accesses a guarded memory area or writes to a write-
protected area.

[Enable internal ROM area write]

When this box is checked, writing to the internal ROM area is enabled.
For the result of writing, see the [Extended Monitor] window.

[User VCC Threshold]
[User Signals]

[Driver]

Sets the voltage level for the user system.

When this box is checked, the reset, NMI, standby, and bus request
signals from the user system are enabled.

Displays the E6000 driver that is currently installed.

[Change driver in start up]

When this box is checked, selection of a driver will be available next time
the emulator is connected.

Note: Theitemsthat can be set in this dialog box vary according to the emulator in use. For details, refer to
section 8, Software Specifications Specific to This Product, or the online help.
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512 Selecting an MCU Not Included in the List

Selecting [Custom] in [Device] of the [Configuration Properties] dialog box adds the [Custom Device] page to
the dialog box.

2]

General  Custom Device

ROk: [ Enable Flash memary
RaM:  [16kB |
Fin:  [120/123FirB =
— Module:
¥ Enabls DTC ¥ Enable 1D —Mg Corerter—
¥ Enable D/& Converter ¥ Enable [ICD (: ;reg
eq
¥ Enable Refresh Contraller W Enable 11C1
[V Enable DMAC ¥ Enable wWDT1 ~ 5 Select
¥ Enatle TPU3E ¥ Enatle TMRZ-3 50104
€ SCIn2
[¥ Enable Prhi14  sona
¥ Enable MuliProcesserComurication [SC11-4) 5004

ak. I Cancel |

Figure5.2 [Configuration Properties] Dialog Box ([Custom Device] Page)

Use this page to specify functions for an MCU not included in the list of MCUs. The items are adopted by the
device last selected.

[Custom Device] page

[ROM] Specify the internal ROM area size.

[RAM] Specify the internal RAM area size.

[Pin] Specify the product package.

[Modules] Check this box to validate on-chip peripherals.

Note: Theitems that can be set in this dialog box vary according to the emulator in use. Some emulators may
not support the [Custom Device] function. For details, refer to section 8, Software Specifications

Specific to This Product, or the online help.
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5.13 Selecting the I nterface to be Connected

Checking [Change driver in start up] on the [Configuration Properties] dialog box allows a selection of the driver
next time the emulator is connected.

E&000 D

DI E EO00 LISE Driver

— Details
Interface; IUSB interface j
Chaniek IEBDUU IUSE Interface j

= Canfiguration

Canfigure... |
r Change driver in start up

Figure5.3 [Driver Details] Dialog Box
[Driver]: Selects the driver that connects the High-performance Embedded Workshop and the emulator.
[Details]: Sets the detail s of the driver being connected.

[Interface]: The name of the interface to be connected. This should not be changed in this
emulator.

[Channel]: Channel for the selected interface. This should not be changed in this emulator.
[Configuration]: Driver setting.

[Configure...]: A dialog box for setting will be displayed when the driver supports the configuration
dialog. Note that thisitem is not available with this emulator.

[Change driver in start up]:
Checking this box selects the driver when the emulator is connected the next time.
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514 Opening the [Memory Mapping] Dialog Box

Selecting [Setup -> Emulator -> Memory Resource...] or clicking the [Emulator Memory Resource] toolbar
button opens the [Memory Mapping] dialog box.

21

Spstem Memory Resounces From To  Mapping 2dd..
SIMM Module: ;I Q0000000 - DO03FFFE . On Chip Read-anly

1ME SIMM fitted 00040000 - DOFFAFFF User Guarded Modi |
Fiam B ases: OOFFEO00 - DOFFEFEF On Chip Read-write podiy...

0: not uzed DOFFEFCO - DOFFF?FF User Guarded .

1: niot uzed O0FFF300 - DOFFFFFF Orn Chip Read-write Reset |

2 niot uzed

3 not uzed Close |

Target Device Configuration

00000000 - 0003FFFF Intemal ROM ﬂ
O0FFENDD - OOFFEFBF Internal RAR

DOFFFBO00 - D0FFFF3F Intemal O

DOFFFFEO - OOFFFFBF Internal 10

O0FFFFCO - OOFFFFFF Interal Rk

-]

Figure5.4 [Memory Mapping] Dialog Box

This dialog box displays the current memory map. The E6000 H8S or H8/300 series supports four blocks of user
memory. These can be 256 kbyte or 1 Mbyte each, depending on the SIMM fitted. Each block can be placed in
the address space on a 256-kbyte or 1-Mbyte boundary.

The memory mapping has a granularity of H'40 (D'64) byte. Each 64-byte block can be set to the internal
(emulation) or external memory and can be guarded (access-prohibited), write-protected or read-write.

The H8/300 series E6000 generally incorporates an emulation memory.

In the memory map, the memory can be set as an internal (emulation) or external, guarded (access-prohibited),
write-protected, or read/write in a byte unit.

[Add...]: Displays the [Edit Memory Mapping] dialog box, alowing the user to modify the address
range and attributes of a memory map.

[Modify...]: Displays the [Edit Memory Mapping] dialog box, allowing the user to modify the address
range and attributes of a memory map.

[Reset]: Resets the map memory to its default settings.

[Close]: Closes the dialog box.

The memory configuration of the device being emulated is displayed by the [Memory] sheet in the [Status]
window.

Note:  Some emulators may not support the emulation memory or the memory mapping function. For details,
refer to section 8, Software Specifications Specific to This Product, or the online help.
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515 Changing the Memory Map Setting

Clicking the[Add...] button on the [Memory Mapping] dialog box or clicking the [Modify...] button after
selecting the information on the memory map setting you want to change opens the [Edit Memory Mapping]
dialog box.

: ing 2l
temaory Mapping

Erom: I Cancel

To I

Setting: IDn Chip Read-write j

Figure5.5 [Edit Memory Mapping] Dialog Box

Use this dialog box to change the address range and attributes of a memory map.

[From]: Enter the start address of the map range.
[To]: Enter the end address of the map range.
[Setting]: Enter the memory map setting.

The choices given are listed below. The User (external memory) and Emulator (emulation
memory) attributes can be modified.

e On-chip Read-write (Cannot be changed)

e On-chip Read-only (Cannot be changed)

e On-chip Guarded (Cannot be changed)

e User Read-write (Cannot be selected when the single chip mode is selected.)
e  User Read-only (Cannot be selected when the single chip mode is selected.)
e User Guarded

e Emulator Read-write

e Emulator Read-only

e Emulator Guarded

RENESAS
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52 Downloading a Program
This section describes how to download a program and view it as source code or assembly-language mnemonics.

Note:  After abreak occurs, the High-performance Embedded Workshop displays the location of the program
counter (PC) on the editor. In most cases, for exampleif an Elf/Dwarf2 based project is moved from its
original path (at the build), the source file may not be automatically found. In this case, the High-
performance Embedded Workshop will open a source file browser dialog box to alow you to manually
locate the file. This path will then be used to update any other source files in this debug project.

521 Downloading a Program
A load module to be debugged must be downloaded.

To download a program, select the load module from [Debug -> Download] or select [Download] from the
popup menu opened by clicking the right-hand mouse button on the load module in [Download modules] of the
[Workspace] window.

Note: Before downloading a program, it must be registered to the High-performance Embedded Workshop as a
load module.
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522 Viewing the Sour ce Code

To view asourcefile's code, double-click onitsicon in thefile tree, or right-click on the source file and select
the [Open] option on the pop-up menu. The [Editor] window is displayed.

10/
<]

29 oo1038 void tutorial (wvoid) j

30 ooi1044 H

31 long &[10]

32 long 3:

33 int ir

34 class Sample ¥p sam;

35

36 | 001046 |4 |G| @ p_sam= Sample;

37 | 0o0104e |*H|*E for | i=0; i<10; i++ )4

38 | oo10s0 |~&| (O 3 = rand():

39 001058 (= if{j < 0){

40 | 00105a |&5 j=-1:

41 ¥

4z | DO10Sc |& o ali]l = i;

43 i

44 aoiovo p_sam->sS0rtia);

45 00107a p_sam->change (a) ;

46

47 oo10sz p_sam->=0=a[0];

45 a0i108a p_sam->s1=a[l]:

49 001096 b_sam->s2=al2];

j=1n} 0010az p_sam-»23=al3];

51 a0i0ae p_sam->s4=a[4] ;

52 0010kha p_sam->s5=a[5] ;

53 0010ce p_sam->36=al6];

54 oo10dz p_sam->sT=alv];

55 0010de p_sam->s58=a[8] : b

=13 0010ea p_sam->39=a[5] ;

57 oo10f6 p_=Sam:

58 00i0fe H =
K1l 1

Figure5.6 [Editor] Window
In thiswindow, the following items are shown on the | eft asinformation on lines.

e 1st column (Line Number column): A line number for the source file

e 2nd column (Source Address column): Address information for the source line

e 3rd column (Event column): Event information (break)

e 4th column (EXT.2 Trigger column): EXT.2 Trigger information

e 5th column (S/W Breakpoints column): PC, bookmark, and breakpoint information
Thetext areais displayed in theright part of the [Editor] window.

Line Number column
This column displays the line number for the source file.
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Source Address column

When a program is downloaded, an address for the current source file is displayed on the Source address column.
These addresses are helpful when setting the PC value or a breakpoint.

Event column
The Event column displays the following items:
@ : Address condition break by an event or arange channel
*@: Starts time measurement by an event channel
“@: Ends time measurement by an event channel
& Starts a point-to-point range trace
& Ends a point-to-point range trace
®" Haltstrace
These are al'so set by using the popup menu.
EXT.2 Trigger column
The EXT.2 Trigger column displays the following items:
i EXT.2-1 trigger condition
ihs: EXT.2-2 trigger condition
s EXT.2-3 trigger condition
ks EXT.2-4 trigger condition
“h-: Two or more EXT.2 trigger conditions
It isalso possible to set them by using the popup menu.
S/W Breakpoints column
This column displays the following items:
: A bookmark is set.
& A Software Break is set.
5*: PC location
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= To switch off acolumn in al source files

. Right-click on the [Editor] window or select the [Edit] menu.

. Click the [Define Column Format...] menu item.

. The [Global Editor Column States] dialog box is displayed.

. A check box indicates whether the column is enabled or not. If it is checked, the column is enabled. If
the check box is gray, the column is enabled in some files and disabled in others. Deselect the check box
of acolumn you want to switch off.

5. Click the [OK] button for the new column settings to take effect.

AW N R

Global Editor Column S

[w]|E vent
[w|EXT.2 Trigger
[w|Line Mumber Cancel |
[w]S A Breakpoints

[w]S A/ Breakpoints - ASK

[w]5ource Address

Figure5.7 [Global Editor Column States] Dialog Box

> To switch off acolumn in one source file
1. Click the right-hand mouse button on the [Editor] window which contains the column you want to
remove to display the popup menu.
2. Click the [Columns] menu item to display a cascaded menu item. The columns are displayed in this
popup menu. If acolumnisenabled, it has atick mark next to itsname. Clicking the entry will toggle
whether the column is displayed or not.
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523 Viewing the Assembly-L anguage Code

I1f you have a source file open, right-click to open the pop-up menu and select the [View Disassembly] option to

open a Disassembly view at the same address as the current Source view.

Itisaso possible to view the disassembly using the new integrated [Disassembly view] in the sourcefile.

If you do not have a source file, but wish to view code at assembly-language level, then select one of the
following operations:

O Click on the View Disassembly toolbar button .
0 Choosethe [View -> Disassembly...] menu option.

0 PressCtrl +D.
The [Disassembly] window opens at the current PC location.

ol
@ |*hs| @ 001046 1480 SUE.L ERO, ERO g
001045 SE002000 JSE BSample: :Sample ()24
00104C OFB6 MOV .L ERO,ERE
‘G |G| 00104E 1944 SUE.W R4, R4
“®|"h| 001050 SEOO11EE ISR @_rand:24
001054 17F0 EXTS.L ERO
001056 OFBS MOV .L ERO, ERS
= 001058 4C02 BGE BH' 105C: 5
= 001054 17BS NEG.L ERS
= 5r00105C 17F4 EXTS.L ER4
00105E OFCO MOV .L ER4,ERO
001060 1070 SHLL.L #2,ERO
001062 OABO LDD.L ER3,ERO
001064 01006985 MOV.L ERS, RERO
001065 0BS54 INC. W #1,R4
0O01064 79240004 CHF.W #H' OOOA, R4
00106E 4DEQ BLT BH'1050:5
001070 OFBS MOV.L ER3,ERS
001072 OFD1 MOV .L ERS,ER1
001074 OFEQ MOV.L ERG, ERO
001076 SEQOZ065 J3R [Zample: isort|long *):24
001074 OFD1 MOV.L ERS,ER1
00107C OFEQ MOV .L ERG,ERO
0O0107E SEO0ZODE JSE @Sample: jchange (long 7) 124
001052 01006950 MOV .L BERS, ERO
001086 010069E0 MOV.L EROD, RERG
001084 01006F500004 MOV .L @ (H'O0O4:16,ERS),ERD
001050 01006FED0ODO4 MOV.L ERO, [ (H'0O004:16,ER6G)
001096 01006F500008 MOV .L @ (H'O008:16,ERS), ERD -
KN H

Figure5.8 [Disassembly] Window

In thiswindow, the following information is shown on the left as information lines.

e 1st column (Event column): Event information (break)

e 2nd column (EXT.2 Trigger column): EXT.2 Trigger information

e 3rd column (S'W Breakpoints - ASM column): PC and breakpoint information

Thiswindow is used in the same way as the source code window.
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524 Modifying the Assembly-L anguage Code

Y ou can modify the assembly-language code by double-clicking on the instruction that you want to change. The
[Assembler] dialog box will be opened.

2]

Addresz Code Mnemanic:
00001040 79370028

QK | Cancel |

Figure5.9 [Assembler] Dialog Box

The address, instruction code, and mnemonic are displayed. Enter the new instruction or edit the old instruction
in the [Mnemonics] field. Pressing the [Enter] key will replace the memory content with the new instruction and
move on to the next instruction. Clicking the [OK] button will replace the memory content with the new
instruction and close the dialog box. Clicking the [Cancel] button or pressing the [Esc] key will close the dialog
box without modifying the memory contents.

Note: The assembly-language code being displayed is the current memory content. If the memory contents are
changed the [Assembler] dialog box and the [Disassembly] window will show the new assembly-
language code, but the source file displayed in the [Editor] window will be unchanged. Thisis the same
even if the source file contains an assembler.

525 Viewing a Specific Address

When you are viewing your program in the [ Disassembly] window, you may wish to look at another area of your
program's code. Rather than scrolling through alot of code in the program, you can go directly to a specific
address. Select [Set Address...] from the popup menu, and the dialog box shown in figure 5.10 is displayed.

2]

Address oK

_rnain
Cancel |

Figure5.10 [Set Address] Dialog Box

Enter the address in the [Address] edit box and either click on the [OK] button or press the Enter key. A label
name can aso be specified as the address. The [Disassembly] window will be updated to show the code at the
new address. When an overloaded function or a class nameis entered, the [ Select Function] dialog box opens for
you to select afunction.

5.2.6 Viewing the Current Program Counter Address

Wherever you can enter an address or value into the High-performance Embedded Workshop, you can also enter
an expression. If you enter aregister name prefixed by the # character, the contents of that register will be used
asthe vauein the expression. Therefore, if you open the [Set Address] dialog box and enter the expression #pc,
the [Editor] or [Disassembly] window will display the current PC address. It also allows the offset of the current
PC to be displayed by entering an expression with the PC register plus an offset, e.g., #PC+0x100.
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5.3 Viewing the Current Status

Choose [View -> CPU -> Status] or click the [View Status] toolbar button () to open the [ Status] window and
see the current status of the debugging platform.

_|olx
ITtem IStatus I

Target Dewice Configuaration 0ooooooo - O001FFFF  Internal ROM
OOFFEOOD - OOFFEFEF Internal RAM
OOFFF200 - OOFFFF3F Internal IO
OOFFFFED - OQOOFFFFEF Internal IO
OOFFFFCO - OOFFFFFF  Internal RAM
System Memory Resources STMM Module:
1ME SIMM fitted
Pam Bases:
0: not used

1: not used
Z: not used
31 not used
Program Name Memory Loaded Area
..ator_cphTutorial. abs H'00000000 - H'00000003
H'0o0000400 - H'OOOOO4ZE
H'00001000 - H'OOQOLEFE
H'0000Z000 - H'O000Z139

|4 Memory £ Platiorm } Events f

Figure5.11 [Status] Window
The [Status] window has three sheets:

e [Memory] sheet
Contains information about the current memory status including the memory mapping resources and the
areas used by the currently loaded object file.

e [Platform] sheet
Contains information about the current status of the debugging platform, typically including CPU type and
mode; and run status.

o [Events] sheet
Contains information about the current event (breakpoint) status, including resource information.

Note: Theitemsthat can be set in this dialog box vary according to the emulator in use. For details, refer to
section 8, Software Specifications Specific to This Product, or the online help.
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54 Reading and Displaying the Emulator | nformation Regularly

Use the [Extended Monitor] window to know the changing information on the emulator no matter the user
program isrunning or halted.

Note:  The Extended Monitor function does not affect the execution of the user program since it monitors the
user system or the signal output from the MCU in the emulator by using the emulator’ s hardware circuit.

54.1 Opening the [Extended Monitor] Window

Selecting [View -> CPU -> Extended Monitor] or clicking the [Extended Monitor] toolbar button ( displays
thiswindow. Theinterval of updating the display is approximately 100 ms during user program execution or
1,000 ms while breaking, respectively.

~=1ol ]|
5
Item Value I
Tser Standby Inactive
User NMI Inactive
User Reset Inactive
User Wait Inactive
User System Voltage OK
User System Voltaged Domwn
User Cable Not Connected
Running status Break = Software Break
ROM Trite Done
Target Mode 7
Target Clock No Clock
Target Sub Clock No Clock

Figure5.12 [Extended Monitor] Window
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5.4.2 Selecting Itemsto be Displayed

Selecting [Properties...] from the popup menu displays the [Extended Monitor Configuration] dialog box.

onfiguration

— Update millzecond

Bunning: 100 Break: I 1000

Lancel |
Settings:
Item | Walue <
Uszer Standby |nactive
Uszer Ml |nactive
Uszer Resst |nactive
Uzerwait |nactive
User Syztem Yoltage QK. l
User System Woltage2 Down
Uszer Cable Mot Connected

Running status Break = Ready _l;l
Pl | E

Figure5.13 [Extended Monitor Configuration] Dialog Box
This dialog box allows the user to set the items to be displayed in the [Extended Monitor] window.

Note: Theitemsthat can be set in this dialog box vary according to the emulator in use. For details, refer to
section 8, Software Specifications Specific to This Product, or the online help.
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55 Displaying Memory Contentsin Realtime

Use the [Monitor] window to monitor the memory contents during user program execution. In the Monitor
function, the realtime operation is retained since the bus monitoring circuit of the emulator sets the read/write
signal of the MCU as atrigger and holds the address bus and data bus values to update the displayed contents of
the memory.

Up to eight points can be set by using the eight monitoring channels on the bus monitoring circuit. 1 to 256 bytes
can be monitored at one point. It is possible that a part or al of monitoring ranges is overlapped.

Note:  Monitoring isimpossible for an area, such as an internal timer counter, where no internal read/write
signal is generated to update avalue.

551 Opening the [Monitor] Window

To open the [Monitor] window, select [View -> CPU -> Monitor -> Monitor Setting...] or click the [Monitor]
toolbar button ) to display the [Monitor Settings] dialog box.

21 %]
tdonitar Setting |
Mame : |monitor‘|
r Optiary
Address
Size [byte]: [Hronz0 4|
Accesz Format) : IBYTE [ASCI) ﬂ

v Zuto-Refresh at rate (ms) ; ID'DDEDD

¥ Reading the Initial % alue

r— Color
Chanae Indicatar ; IChange j
Foreground : _I'I Background I:II'I
|l Ei
r Detail
|DETAIL MOT SUPPORTED! Dietail... |
— Histom

| =
QK I Cancel |

Figure5.14 [Monitor Setting] Dialog Box
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[Name]:

[Optiong]:

[Color]:

[Detal]:

[History]:

[Address]:

[Size]:

[Access]:

[Auto-Refresh at rate (ms)]:

[Reading the Initial Value]:

[Change Indicator]:

[Foreground)]:
[Background]:

[Mayfly]:

Decides the name of the monitor window.

Sets monitor conditions.

Sets the start address for monitoring.

Sets the range for monitoring.

Sets the access size to be displayed in the monitor window.

Sets the interval for acquisition by monitoring (500 ms at minimum).

Selects reading of the values in the monitored area when the monitor
window is opened.

Sets the method to update monitoring and the attribute of colors.

Selects how to display the values that have changed during monitoring
(available when [Reading the Initial Vaue] has been selected).
No change: No color change.

Change: Color is changed according to the [Foreground] and [Background]
options.

Gray: Those data with values that have not been changed are displayed in
gray.

Appear: A valueisonly displayed after changed.

Sets the color used for display (available when [Change] has been selected).

Sets the background color (available when [Change] has been selected).

A check in this box selects restoration of the color of those data which have
not been updated in a specified interval to the color selected in the
[Background] option. The specified interval istheinterval for monitor
acquisition (available when [Change], [Gray], or [Appear] has been selected).

Sets the items specific to the emulator. Not used with this emulator.

Displays the previous settings.

Notes: 1. Inthisemulator, odd addressees cannot be specified as the start addresses for monitoring.
2. Selection of the foreground or background color may not be available depending on the operating

systemin use.

After setting, clicking the [OK] button displays the [Monitor] window.
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- monitor: monitor] - FFEFE0 =10 x|
# 2 |15 =]|[eveHen =]

address | +0 | +1| 42| 3| +a| +5| +6| +7| 48| 40| +a| 48| +c| 40| +E| +F |
FFEFE0 00 00 13 72 00 00 28 47 00 0O Zc¢ &7 00 00 33 50
FFEFO0 00 00 42 87 00 00 4p A 00 00 50 OF 00 00 64 88
FFEFA0 00 00 69 56 00 00 75 66 00 02 12 24 00 00 Aa AA

FFEFED 57 790 00 00 OO 01 B0 Y4 00 OO0 10 36 00 OO0 04 1E
FFEFCO 6A 18 6A 18 6A 18 6A 18 6A 18 6A 18 6a 18 6A 18

Figure5.15 [Monitor] Window
During user program execution, the display is updated according to the setting value of the auto-update interval.

Note:  Select [Refresh] from the popup menu when datais not displayed correctly after changing the address or
content of memory.

55.2 Changing the Monitor Settings

Selecting [Monitor Setting...] from the popup menu of the [Monitor] window displays the [Monitor Setting]
dialog box, which allows the settings to be changed.

Colors, the size of accesses, and the display format can be easily changed from [Color] or [Access] of the popup
menu.

553 Temporarily Stopping Update of the Monitor

During user program execution, the display of the [Monitor] window is automatically updated according to the
auto-update interval. Select [Lock Refresh] from the popup menu of the [Monitor] window to stop the update of
display. The charactersin the address section are displayed in black, and the update of display is stopped.

Selecting [Lock Refresh] again from the popup menu cancels the stopped state.

554  Deleting the Monitor Settings

Selecting [Close] from the popup menu of the [Monitor] window to be deleted closes the [Monitor] window and
deletes the monitor settings.

555 Monitoring Variables
Using the [Watch] window refers to the value of any variables.

When the address of the variable registered in the [Watch] window exists within the monitoring range that has
been set by the Monitor function, the value of the variable can be updated and displayed.

This function allows checking the content of a variable without affecting the realtime operation.
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55.6 Hiding the [Monitor] Window

When using the Monitor function to monitor the value of a variable from the [Watch] window, hide the
[Monitor] window for the effective use of the screen.

The current monitoring information is listed as the submenu when selecting [Display -> CPU -> Monitor]. The
list consists of the [Monitor] window name and the address to start monitoring.

When the left of thelist is checked, the [Monitor] window is being displayed.

Selecting items of the [Monitor] window you want to hide from the monitor setting list displays no [Monitor]
window and removes the check mark at the left of thelist.

To display the [Monitor] window again, select the hidden the [Monitor] window.

I . oo ceting. ShifteCulE

[ v monitar2 - HOOFFEODE
monitor] - H'OOFFEFS0

windows Select...

Figure5.16 Monitor Setting List
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55.7 Managing the [Monitor] Window

Selecting [Display -> CPU -> Monitor -> Windows Select...] displays the [Windows Select] diaog box. In this

window, the current monitoring condition is checked and the new monitoring condition is added, edited, and

deleted in succession.

Selecting multiple monitoring conditions enables a temporary stop of update, hiding, and deletion.

Name | Address
monitor2 H'00FFBODS
monitor] H'00FFEF80

Edit... |
Lock Refresh? |
Hide? |
Bemove |

Close |

Figure5.17 Selection in the[Monitor] Window

[Add]: Adds a new monitoring condition.

[Edit]: Changes the settings of the selected [Monitor] window (disabled when selecting multiple
items).

[Lock Refresn/Unlock Refresh]:

Automatically updates or stops updating the display of the selected [Monitor] window.

[Hide/UnHide]: Displays or hides the selected [Monitor] window.
[Remove]: Removes the selected monitoring conditions.

[Close]: Closes this dialog box.

RENESAS
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5.6 Viewing the Variables

This section describes how you can look at variables in the source program.

5.6.1 [Watch] Window

Y ou can view any value in the [Watch] window.

= H'0000794k { FFEFAO0 }
R [1] H'000059e2 { FFEF84 }
R [2] H'0000446k { FFEFAS }
R [3] H'000041c6 { FFEFAC }
B [4] H'00003£54 { FFEFOO }
® [5] H'00002781 { FFEF94 }
B 6] H'00001efh { FFEFOS }
R [7] H'0000167e { FFEFSC }
R [3] H'000015fk { FFEFAO }
R [o] H'00000f£6 { FFEFad }
------ 3 H'O0ffef80 { ERS }
------ i H'O0O0a { R4 }

Ay watcha A watchz f watchs J, Watchd [

Figure5.18 [Watch] Window
The [R] mark shows that the value of the variable can be updated during user program execution.

For updating of the content of the variable that has been registered in the [Watch] window, there are the
following three methods:

1. Use the Monitor function without halting the user program
The read/write signal of the MCU is set as atrigger and holds the address bus and data bus values to update the
value of the variable.

Note:  Although the realtime operation is retained, the size and number points to be monitored are limited. For
the Monitor function, refer to section 5.5, Displaying Memory Contents in Realtime.
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2. Read the memory content directly from the High-performance Embedded Workshop to update the values
without halting the user program since the bus mastership is owned by the emulator

Note:  While the emulator reserves the bus mastership, the realtime operation is disabled because the CPU stops
operation. This method is only available for accessing the internal ROM, internal RAM, and emulation
memory.

The area used here or this method may not be available depending on the emulator in use. For details,
refer to section 8, Software Specifications Specific to This Product, or [Enable read and write on the fly]
on the [General] page of the [Configuration Properties] dialog box in the online help.

3. Temporarily stops the user program and reads the memory contents

Note:  The realtime operation is disabled because the user program is stopped temporarily. This method is only
available for accessing the areas (internal 1/0, DTCRAM, and user memory) other than those in item 2
mentioned above.

It is possible to recognize the method for updating the value during user program execution according to the
color of the [R] mark.

Blue-outline[R]:  The variable's address is within the range that has been set for the monitoring function and
the data is readable by using the monitoring function.

Blue[R]: An updated value of the data at this location has been read by the monitoring function.

Black-outline[R]:  The variable's address is outside the range that has been set for the monitoring function and
the datais not readable by using the monitoring function.

Black [R]: A value has been updated by reading the normal data.

Notes: 1. Thisfunction can be set per variable or per element or body for structures of data.
2. Thecolor of an[R] in the [Name] column changes according to the trace and monitoring settings.
3. A variablethat isallocated to aregister cannot be selected for monitoring.
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5.7  Usingthe Event Points

The emulator has the event point function that performs breaking, tracing, and execution time measurement by
specifying higher-level conditions aong with the software breakpoints standard for the High-performance
Embedded Workshop.

57.1 Softwar e Breakpoints
When the instruction of the specified addressis fetched, the user program is stopped. Up to 256 points can be set.

Note that, however, only one software breakpoint can be set in the ROM area of the user system. This particular
breakpoint is called the on-chip breakpoint, which stops the user program after executing the instruction of the
specified address.

When it is necessary to set two or more software breakpoints to the external ROM area of the user system,
alocate this area to the emulation memory, copy the code, and then set the software breakpoints.

57.2 Event Points

Event points can be used for higher-level conditions such as the data condition as well as specification of the
single address. Up to 12 event points can be set by using event channels and range channels in the event
detection system.

When the condition is satisfied, event points are also used as the start/end conditions for execution time
measurement or trace acquisition in addition to halting the user program. Several event points can be used to set
more complex conditions.

Note:  Event points acquire the data, test conditions, and execute an action (such as halting the user program)
by the hardware circuit of the emulator. Therefore, adelay of several cycleswill occur from the
satisfaction of the condition to the execution of an action.

57.3 Event Detection System

In addition to the 4 range channels, the emulator also has 8 event channels. The event channels have more
functions (such as sequencing or counting) than the range channels.

Event Channels (Ch1to Ch8):

The emulator has 8 event channels. The event channel can be defined as a combination of one or more of the
followings:

e Anaddressor an address range

e Outside of an address range

e A read, awrite, or either

e Datawith amask specification

e Busdtae

e Area

e Thevalue of four external probe signals

e The number of times the event has occurred

e Thenumber of delay cycles after the event has occurred
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A maximum of eight points can be used as a combination in a sequence. The program is activated or halted by an
occurrence of the previous event in each sequence.

Range Channels (Ch9 to Ch12):
The emulator has 4 range channels. The range channel can be defined as a combination of one or more of the
followings:

e Anaddress or an address range

e Outside of an address range

e A read, awrite, or either

e Datawith amask specification

e Busdate

e Area

e Thevalue of four externa probe signals

e Thenumber of delay cycles after the event has occurred

574 Signalsto Indicate Bus States and Areas

In the event detection system, signalsindicating the MCU'’ s bus states and the accessed areas can be specified as
the event detection condition.

These signals are output from the MCU on the emulator; the signals to be acquired will vary according to the
emulator in use.

The signals to indicate bus states and areas are used to set the [Bus/Area] condition of the event point. They can
also be acquired as the trace information.

The bus state signals are al so used to set the condition not to acquire the trace ([Suppress] option) and in the
Access Count Of Specified Range M easurement mode for measuring the hardware performance ([Access Type]
option).

For the trace function, refer to section 5.8, Viewing the Trace Information. For the hardware performance
function, refer to section 5.9, Analyzing Performance.

The following tables show examples of signals to indicate the bus states and areas that can be acquired by the
emulator.

Table5.1 BusState Signals Acquired by the Emulator

Bus State Trace Display (Status) Description

CPU Prefetch PROG CPU prefetch cycles
CPU Data DATA CPU data access cycles
Refresh REFRESH Refresh cycles

DMAC DMAC DMAC cycles

DTC DTC DTC cycles

Other OTHER Others
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Table5.2 AreaSignalsAcquired by the Emulator

Area Trace Display (Status) Description
On-chip ROM ROM ROM

On-chip RAM RAM RAM

On-chip 1/0 16bit 1/0-16 16-bit I/O

On-chip 1/0 8bit 1/0-8 8-bit I/0

External /O 16bit EXT-16 16-bit EXT (external)
External I/0O 8bit EXT-8 8-bit EXT (external)
DTC RAM RAM/DTC DTCRAM

Note: The signalsto indicate the bus states and areas vary according to the emulator in use. For details, refer to
section 8, Software Specifications Specific to This Product, or the online help.

575 Opening the [Event] Window
Select [View -> Code -> Eventpoints] or click the [Eventpoints] toolbar button () to open the [Event] window.

The [Event] window has the following three sheets:

[Breakpoint] sheet: Displays the settings made for software breakpoints. It is also possible to set, modify,
and cancel software breakpoints.

[Event] sheet: Displays or sets event points.

[Trigger] sheet: Displays or sets trigger points.

57.6 Setting Softwar e Breakpoints

It is possible to display, modify, and add software breakpoints on the [Breakpoint] sheet.

=l xi

[ |EI
Type | State | Condition |Act:i_0n I
Program Enable PC=001082 (tutorial.cpp/47) Break

IIII\Breakpoinl {-'\E\rent }\ Trigger f‘

Figure5.19 [Event] Window ([Breakpoint] Sheet)
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Select [Add...] or the software breakpoint displayed in this window and then select [Edit...] from the popup menu
to display the [Breakpoint/Event Properties] dialog box.

il B3
Addre:
£ Donlt Care % Address € Fange
Address Lo [H'00001 052
" Event Address Hi - [H00000000
I™ Gutside Fange
—Data Compare Direction—
[~ Compare ™ Lse ask ) Bead
alue [
a IH L ) Wite
& Byte € Word
Mask IH'D % Either
akK I Cancel |

Figure5.20 [Breakpoint/Event Properties] Dialog Box (Setting a Softwar e Break)
In this dialog box, select the address condition to set software breakpoints.

[Type]: Select the type of a breakpoint. Note that the [Breakpoint/Event Properties] dialog box is used
for setting software breakpoints and event points. Selecting a particular type of breakpoint
enables or disables other pages and parts of the dialog according to the options available to that
type of breakpoint.

[Software Break]:Only a single address with a program fetch can be selected. Other options are invalid.

[Event]: Set conditions in detail with other options on this page, or on the [Bus/Area],
[Signals], or [Action] page.

[Address]: Set address conditions.

[AdderessLo]: Select asingle address where a software breakpoint will be set.
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5.7.7 Setting Event Points

On the [Event] sheet, the settings for event points are displayed, modified, and added.

-ini x|

B s K |EI
Type | Statel Condition Action |

Chl (E} Enable Address=00105¢C (tutorial.cpp/42) address count D'S Ereak
Chd (E} Empty
Ch3 (E} Empty
Ch4 (E} Empty
chi (E) Empty
Cche (E) Empty
ch7 (E) Empty
Ch8 [(E} Empty
Ch9 (R} Empty
Chl0(R} Empty
Chll(R} Empty
ChlZ (R}  Empty

AP T Ereskpoint ) Event A Trigger [

Figure5.21 [Event] Window ([Event] Sheet)

Select [Add...] or the event point displayed in this window and then select [Edit...] from the popup menu to
display the [Breakpoint/Event Properties] dialog box.

The conditions for the event point are set on the [General], [Bus/Area), [Signals], and [Action] pages. The search
condition for the event point is set by multiple conditions set on these pages.

Notes: 1. Channel 8 has the trigger output function. When the condition on channel 8 is satisfied, the low-level
signal will be output from the external probe 1 (EXT1) for abus cycle.

2. When the event point is used as the condition for acquiring the trace information, select [Trace
Acquisition...] from the popup menu. For the trace function, refer to section 5.8, Viewing Trace
Information.

3. If acondition that is unavailable for arange channel is set in editing of the range channels (Ch9 to
Ch12), the selected channel is automatically replaced by an unused event channel (Chl to Ch8).

Table53 Conditions Unavailable for a Range Channel

Condition Related Options

Selecting outside the [Outside Range] on the [General] page

specified address range

Selecting the start or [Start Timer] and [Stop Timer] on the [Action] page

end of the execution
time measurement

Specifying the count [Required number of event occurrences] on the [Action] page
when an event occurs
(twice or more)

Specifying sequencing [Enable Sequencing] on the [Action] page
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(1) [General] page

The address and data conditions are set.

21|
General | Bus .-’Areal Signalsl Actionl
— Tupe Addre
- Siaffare " Don't Care ™ Address  Rangs
Break Address Lo [H0000105C
Address Bi 00000000
™ Gutside Fange
— D ata Compare Direction——
[~ Compare ™ Lse bask " Read
falue [
n IHD £ White
= Byte. € Wlord
Mask IH'D &+ Either
akK I Cancel |

[Typel:

Figure5.22 [Breakpoint/Event Properties] Dialog Box ([General] Page)

Select the type of a breakpoint. Note that the [Breakpoint/Event Properties] dialog box is used
for setting software breakpoints and event points. Selecting a particular type of breakpoint
enables or disables other pages and parts of the dialog according to the options available to that
type of breakpoint.

[Software Break]:Only a single address with a program fetch can be selected. Other options are invalid.

[Event]: Set conditions in detail with other options on this page, or on the [Bus/Area],
[Signals], or [Action] page.

[Address]: Sets the address condition.

[Don't care]: Sets no address condition.
[Address]: Allows a single address to be selected.
[Range]: Allows an address range to be selected.

[AdderessLo]: Set asingle address or the start of an address range (available when [Address] or
[Range] has been selected).

[AdderessHi]:  Set the end of an address range (available when [Range] has been selected).

[Outside Range]: Used to negate the range (i.e., the event will occur when the address is outside the
range). Thisis available when [Address] or [Range] has been selected.
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[Data Compare]: Sets the data condition.
[Compare]: Checking this box compares data.
[Use Mask]: Sets a mask condition (available when [Compare] has been selected).

[Value]: Specifies the data bus value as numerics. The size of data for access can also be
selected (available when [Compare] has been selected).

[Byte]: Sets access in bytes as the condition (available when [Compare] has been selected).
[Word]: Sets access in words as the condition (available when [Compare] has been selected).
[Mask]: Sets avalue to be masked. Thisvalue will be ANDed with the value of the data bus

and data condition. The result will be used to compare data (available when [Use
Mask] has been selected).

[Direction]: Selects a condition with read or write cycles.

[Read]: Sets read cycles as the condition.

[Write]: Setswrite cycles as the condition.

[Either]: Sets either read or write cycles as the condition.
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(2) [Bus/Area] page

Use this page to set the bus status and the memory area being accessed.

General  Bus /Area I Signalsl Actionl

—Bus State —Area
I= | CPL Prefetch ™| Or-chip BOM
[~ P D ata ™| Or-chin Rt
[~ Refresh ™ Or-chip (40 16 kit
[~ DMAC [T Onechip (/08 bit
= DIC I™ | Extemal 16 kit
™ @ther, I™ Extemal 2 hit
I~ DTC Rk

¥ Dont Care

akK I Cancel |

Figure5.23 [Breakpoint/Event Properties] Dialog Box ([Bus/Area] Page)

[Bus State]: Sets the bus status as the condition. When the [Don't care] check box is checked, the event will
be satisfied with any bus status.

[Area): Specifies the area for searching. When the [Don't care] check box is checked, the event will be
satisfied in any area.

Note: Items set for the bus state and memory access area vary according to the emulator in use. For details,
refer to section 5.7.4, Signals to Indicate Bus States and Areas.
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(3) [Signals] page

Use this page to set external signals.

General I Bus / Area  Signals IActionI

—Probe 4 — Probe 3
o il
 Low
& Dot Care

— Prabe 1
" High
 Low
& Don't Care & Don't Care

akK I Cancel |

Figure5.24 [Breakpoint/Event Properties] Dialog Box ([Signals] Page)

[Probed]: Detects the status of the input probe signal 4
[High]: Detects the high level of the input probe signal
[Low]: Detects the low level of the input probe signal

[Don't care]: The status of the input probe signal is not detected

[Probe3]: Detects the status of the input probe signal 3
[High]: Detects the high level of the input probe signal
[Low]: Detects the low level of the input probe signal

[Don't care]: The status of the input probe signal is not detected

[Probe2]: Detects the status of the input probe signal 2
[High]: Detects the high level of the input probe signal
[Low]: Detects the low level of the input probe signal

[Don't care]: The status of the input probe signal is not detected
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[Probel]: Detects the status of the input probe signal 1

[High]:
[Low]:

[Don't care]:

(4) [Action] page

Detects the high level of the input probe signal
Detects the low level of the input probe signal

The status of the input probe signal is not detected

Use this page to decide what action the emulator takes when the defined event occurs.

General I Bus / Area | Signals  Action
Actj
v
r Start Tirner
[~ Stop Timer

Dielay after detection before break occurs
| ]

busz cycles

Reguired number of event occunences
|0

B el Semueing Configure Sequence... |

QK I Cancel |

Figure5.25 [Breakpoint/Event Properties] Dialog Box ([Action] Page)

[Action]:

[Break]:

[Start Timer]:

[Stop Timer]:

Selects an action that occurs when the event is satisfied. This cannot be used for an
event point being used as the trace acquisition condition.

Causes a break (stop) in the user program when the event occurs. Thisisthe
default action.

Starts the run timer (the run timer value is displayed in the [Status] window).

Stops the run timer (the run timer value is displayed in the [ Status] window).

[Delay after detection before break occurs]:

Sets a 16-bit delay (in bus cycles) after the event has occurred before the action is
taken. The delay is only applicable to break events and there is only one delay counter
in hardware, therefore only one breakpoint can have anon-zero delay. The range of
valuesis D’ 0 to D’ 65,535 (only available when [Break] has been selected). This
cannot be used for an event point being used as the trace acquisition condition.
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[Required number of event occurrences]:

[Enable Sequencing]:

[Configure Sequence...]:

Allows a 16-bit pass count to be set. The event must occur the specified number of
times before the action is taken. The range of valuesis D’ 0 to D’ 65,535.

Allows the event to take part in a sequence of events (setting this requires the event to
use an event detector).

Displays the [Event Sequencing] dialog box to allow the event sequencing to be
configured (only available when [Enable Sequencing] has been selected).

(5) [Event Sequencing] dialog box

This dialog box allows the user to define which events are triggered by other events. If thisdialog box is
accessed (directly or indirectly) from [Trace Acquisition...], only those events assigned to the trace subsystem
are displayed. If accessed from the [Eventpoint] window, only the breakpoint or timer events are shown.

% |5 Amed By [ Mo oscunence of

" |sBesst By The following events: Cahcel |

I~ 1 [EJ HI1038 address

[~ 2[EJHY05C address count D10
[~ 2[E)H10FE address count D'2
[ 4 [E)H'10FC address

I~ | undefined ar unavailable

[ undefined or unavailable

= undefined or unayailatls

= undefined or unayailatls

R
3

e

[Event]:
[Is Armed By]:
[Is Reset By]:

[No occurrence of]:

Figure5.26 [Event Sequencing] Dialog Box

Selects an event point to be set.
Arms the selected event.
Resets the selected event.

Arms an event when the set of events being selected does not occur (only available
when [Is Armed By] has been selected).

The test of conditions on event pointsis started with the execution of the user program. The conditions on event
points have not been satisfied immediately after the execution of the user program is started.

Satisfaction of the condition on an event point allows a transition of the state to that where the condition is

satisfied.
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The state where the condition is satisfied is retained until the user program is stopped or the event point is reset.

When the condition on the event point is satisfied, no action will be taken even if the condition is satisfied again.
If you want the action to be taken again, reset the event point so that the state transits to that where no condition
is satisfied.

When the user program is stopped, the states of all the event points transit to that where no condition is satisfied.

When an event point must be in the state where its condition is satisfied or not (when [No occurrence of] is
selected) as the satisfaction condition of another event point, this event point is called the arm event.

An event point can reset the tested states of conditions of other event points or itself by satisfying the condition.
This event point is called areset event.

A reset event resets event points regardless of their states where the condition is satisfied or not (e.g., resetting
the pass count).

Select an event point from the [Event] combo box. To set an arm event on the selected event point, select [Is
Armed By] and check the box corresponding to each event. The [No occurrence of] check box is used to set a
condition that the arm event is in the state where its condition is not satisfied.

To set areset event on the selected event point, select [Is Reset By] and check the box corresponding to each
event.

At the bottom of the screen is a diagram showing the current sequencing of the events (figure 5.26). The Sinput
sets (arms) an event and the R input resets it. The legend ~S indicates the event is set (armed) by the non-
occurrence of the input events.

Figure 5.26 is an example that Ch1 isthe arm event for Ch2, Ch3, and Ch4. Ch3 is the arm event for Ch4. Ch2
and Ch4 are the reset events for Chl and Ch2, respectively.

To satisfy the condition of the event point having an arm event, the arm event must be in the state where the
condition is satisfied or not (when [No occurrence of] is selected). When multiple arm events exist on one event
point, one of the arm events must be in the state where the condition is satisfied or not (when [No occurrence of]
selected) to satisfy the condition of the event point.

As the condition of the arm event on one event point, either of the states where the condition is satisfied or not
should be set.

To reset an event point with areset event, the condition of the reset event must be satisfied. While the condition
of thereset point is satisfied, no event point isreset even if the condition of the reset event is satisfied again.

When multiple reset events exist on one event point, the event point is reset when the condition of one of reset
eventsis satisfied.
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578 Setting Trigger Points

The trigger point is an event to output atrigger when the specified address has been accessed. Up to four trigger
points can be set by using the trigger outputs (four channels) on the bus monitoring circuit of the emulator.

The settings of the trigger point are displayed and modified on the [Trigger] sheet.

1o
[ |EI

Type | State | Condition |Act:i_0n I
EXT.Z-1 Enable address=001082 (tutorial.cpp/47) Trigger output
EXT.2Z-2Z Enable Address=001096 (tutorial.cpp/49) Trigger output
EXT.2-3 Enable Address=002Z072 (sort.cpp/30) Trigger oubput
EXT.Z-4 Enable address=00Z07Z (sort.cpp/30) Trigger oubput

1' }I\ Ereakpaint }\ Ewerit }\Trigger fr

Figure5.27 [Event] Window ([Trigger] Sheet)

Selecting [Add...] or the event point and [Edit...] from the popup menu in this window displays the [Set Address
For Trigger] dialog box.

Set Address For Trigger

Address

¥ Triggerl: IH'DDFFDEED Cancel |

¥ Trigger2: IH'DDFFD 404

¥ Trigger2: IH'DDDD‘I‘IAD

V' Triggerd: [FrooFFeFaC

Figure5.28 [Set AddressFor Trigger] Dialog Box

This dialog box allows the user to specify the address to be accessed as the trigger output condition during the
user program execution. Enable or disable the trigger output point by checking the check box on the left in the
screen.

[Triggerl]: Enables the output of trigger channel 1.
[Trigger2]: Enables the output of trigger channel 2.
[Trigger3]: Enables the output of trigger channel 3.
[Triggerd]: Enables the output of trigger channel 4.
[Address]: Sets the address condition of the channel.
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Notes: 1. When the condition set for the trigger output (1 to 4) is satisfied, the high-level signa will be output
from the corresponding pin (1 to 4) of the external probe 2 (EXT2) during reading or writing.
2. Some emulators may not support the trigger point. For details, refer to section 8, Software
Specifications Specific to This Product, or the online help.

57.9 Editing Event Points

Handlings for settings other than software breakpoints, event points, and trigger points are common. The
following describes examples of such handling.

57.10 Modifying Event Points

Select an event point to be modified, and choose [Edit...] from the popup menu to open the dialog box that
corresponds the event, which allows the user to modify the event conditions. The [Edit...] menu isonly available
when one event point is selected.

5711 Enabling an Event Point

Select an event point and choose [Enable] from the popup menu to enable the selected event point.

57.12 Disabling an Event Point
Select an event point and choose [Disable] from the popup menu to disable the selected event point. When an

event point is disabled, the event point will remain in the list, but an event will not occur when the specified
conditions have been satisfied.

57.13 Deleting an Event Point

Select an event point and choose [Delete] from the popup menu to remove the selected event point. To retain the
event point but not have it cause an event when its conditions are met, use the [Disable] option (see section
5.7.12, Disabling an Event Point).

Note: No trigger point can be deleted. Use the [Disable] option to clear the settings.

57.14 Deleting All Event Points
Choose [Delete All] from the popup menu to remove all event points.

Note:  No trigger point can be deleted. If [Delete All] is selected, the settings of all channels become disabled.

57.15 Viewingthe SourceLinefor an Event Point

Select an event point and choose [Go to Source] from the popup menu to open the [Editor] or [Disassembly]
window at address of event point. The [Go to Source] menu is only available when one event point that has the
corresponding source fileis selected.
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58 Viewing the Trace Information

The emulator acquires the results of each instruction execution into the trace buffer as trace information and
displaysitin the [Trace] window. The conditions for the trace information acquisition can be specified in the
[Trace Acquisition] dialog box.

Since trace information in bus-cyclesis acquired by the hardware circuit and stored in the trace buffer, the
realtime operation is retained. The [Trace] window displays the content of the trace buffer, which records up to
32,768 bus cycles from the last program run and is always updated.

581 Opening the [Trace] Window

To open the [Trace] window, choose [View -> Code -> Trace] or click the [Trace] toolbar button ).

5.8.2 Acquiring Trace Information

When the emulator does not set the acquisition condition of the trace information, all bus cycles are acquired by
default without any condition (free trace mode).

In the free trace mode, trace acquisition is started with the execution of the user program and stopped by halting
the user program. The acquired trace information is displayed in the [ Trace] window.

N =loix
LT
Tnatruct ion Data | B/M | Aren | Status | Clock  Probes | W1 | TRQS-0 | Timestwep | Timestamp-Diftecence | Source | Label | 2]
e 111111 |
OED RD  RoM m o1 1an
L B... Of82 Bb Row Hl 1 1an
0000 WE  RAM 1111 1 11111
0000 WR  RAM 111 i 1111
[ #... 460e RP ROM 1111 i 11111
S, % E... 1aB0 Bb  BoM 11 1 1
§0 00201c 1a91 RD ROM 111 1 11111
002010  MWV.B #... #8328 RD POM 1111 1 11111
o1z 7em ©... %00 F0 RoM 1 1
2014 1188 RD oM w1 an
o01168  sTMLL {+os D120 BB MOM u 1 n P
tietin onon wR o mAM un i =l

Figure5.29 [Trace] Window
This window displays the following trace information items:

[PTR]: Cycle number in the trace buffer. When the most recent record is record O, earlier
record numbers go backwards (-1, -2, ...). If adelay count has been set, the cycle
number where the trace stop condition has been satisfied is record 0. For the cycle
(during delay) executed until the trace has stopped, earlier record numbers go forward
(+1, +2, ...) the most recent record.

[Address): Address (6-digit hexadecimal)

[Instruction]: Disassembled code of the executed instruction

[Data): Data bus value, displayed as 2-digit or 4-digit hexadecimal

[RIW]: Whether access was read (RD) or write (WR)

[Area): Memory area being accessed; ROM, RAM, 8- or 16-hit 1/0O, 8- or 16-bit EXT

(external), or DTC RAM (not available when atime stamp is acquired)
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[Status]:

[Clock]:

[Probes]:

[INMI]:
[IRQ7-0]:

[Timestamp]:

[Source]:
[Label]:

[Timestamp-Difference]:

Bus status during this cycle; DTC operation, PROG (prefetch), Data (CPU data access
cycle), Refresh (refresh cycle), or DMAC (DMAC cycle) (not available when atime
stamp is acquired)

Number of clock cyclesin bus cycle as 1 to 8. To indicate more clock cycles, “OVR”
isdisplayed (not available when atime stamp is acquired).

A 4-bit binary number showing the four probe pinsin the order of Probe 4, Probe 3,
Probe 2, and Probe 1 from the |eft (not available when atime stamp is acquired).

Status of the NMI input (not available when atime stamp is acquired)
Status of eight IRQ inputs (not available when atime stamp is acquired)

Time stamp of therecord. Time stamps start from zero each time the user programis
executed. The timer resolution depends on the time stamp clock rate selected in the
trace acquisition (only available when atime stamp is acquired).

Source program
Label information that corresponds to the address (if defined)

Displays the difference from the timestamp value shown on the previous line (only
available when atime stamp is acquired).

Note:  Items other than [PTR], [Address], [Instruction], [Data], [R/W], [Ared], [Status], [Probes], [Timestamp],
[Source], [Label], and [ Timestamp-Difference] vary according to the emulator in use. For details, refer to
section 8, Software Specifications Specific to This Product, or the online help.

It is possible to hide any column not necessary in the [Trace] window. Selecting a column you want to hide from
the popup menu displayed by clicking the right-hand mouse button on the header column hides that column. To
display the hidden column, select the column from the said popup menu again.
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583 Specifying Trace Acquisition Conditions

The capacity of the trace buffer islimited. When the buffer becomes full, the oldest trace information is
overwritten. Setting the trace acquisition condition allows acquisition of useful trace information and effective
use of the trace buffer. The condition is enabled by the event point to control starting, stopping, and ending the
trace acquisition. For event points, refer to section 5.7, Using the Event Points.

The trace acquisition condition is set in the [Trace Acquisition] dialog box that is displayed by selecting
[Acquisition...] from the popup menu.

The [Trace Acquisition] dialog box has the following pages:

Table54 [TraceAcquisition] Dialog Box Pages

Page Item

[General] Sets trace acquisition conditions.

[Stop] Sets trace stop conditions (without a delay).

[Delayed Stop] Sets trace stop conditions (with a delay).

[1] to [4] Sets the range trace (only available when the free trace mode is
disabled).

(1) [General] page

Sets trace acquisition conditions.

il B3|
Gereral |Stop | DelayedStop|1 |2 |3 |4 |
—Supprezs Time Stamp
[™ FEree Trace
LClock:
" DIC Cycles [Disabled -]
I Refresh Cycles
— Trace Event
Event:
|10 (RIH1092 address =
add.. | Edi. [E— Delete | Delal |
Ok I Cancel |

Figure5.30 [TraceAcquisition] Dialog Box ([General] Page)
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[Suppress]:

[Time Stamp]:

[Free Trace]:

[Trace Events):

[Clock]:

Acquires no trace information of the specified types of bus cycle.

Sets a condition for time stamping.

Select either from Disabled, 125 ns, 250 ns, 500 ns, 1 us, 2 us, 4 us, 8 us, 16 us, or
100 us as the resolution for time stamping. A time stamp has a 32-bit counter. At 125
ns the maximum time that can be measured is about 9 minutes, and at 100 ps the
maximum time is about 5 days.

When the counter overflows, its content will be cleared to continue counting. No time
stamp information will be acquired when Disabled is selected.

Checking this box enables the free trace mode.

When the free trace mode is enabled: Starts acquiring the dataimmediately after program
execution has been started. Only the trace halt condition is available. Therange traceis
unavailable and four range-trace pages (1 to 4) become disabled.

When the free trace mode is disabled: Setsthe start and halt conditions of trace acquisition.

[Event]:
[Add...]:
[Edit...]:

[Sequence...]:

[Delete]:

[Del All]:

Sets event points to be used as trace acquisition conditions.

Lists the event points to be used as trace acquisition conditions.
Adds a new event point.
Changes the setting for the selected event point.

Configures an event sequence for the event point being used as atrace acquisition
condition. To set up the sequence, an event must have been set.

Deletes the selected event point.

Deletes all event points.

Notes: 1. Thebus cycles that can be specified by the [ Suppress] option vary according to the emulator in use.
For details, refer to section 5.7.4, Signals to Indicate Bus States and Areas.

2.

The trace buffer is used for the time stamp information and some of the trace information. Therefore,

when the time stamp is acquired, it is impossible to acquire the trace information other than PTR,
Address, Instruction, Data, R/W, Source, Label, Timestamp, and Timestamp-Difference.

disabled.

If an event that is used for the range trace or trace stop function is deleted, that function becomes
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(2) [Stop] page

Sets trace stop conditions. It is possible to set trace stop conditions with and without delay, with both allowed
simultaneously.

Trace Acquisition 2%

General  Stop | Delayed Stopl 1 | 2 | 3 I 4 I

— Stop Without Delay

— Ewent
I undefined or unavailsble

I undefined or unavailable
I™ | undefined or unavailable
I™ | undefined or unayailable
I™ | undefined or unayailable
I™ | undefined or unavailable
™ 7 [EJH107E address
[T BIEIH"08 address
I undefined or unavailable
¥ 10[R] H1092 address
I™ | undefined or unayailable
I™ | undefined or unayailable

oK I Cancel |

Figure5.31 [TraceAcquisition] Dialog Box ([Stop] Page)

[Stop Without Delay]: Defines a trace stop condition.
[Enable]: Checking this box enables a trace stop.

[Events]: Lists the event points where trace acquisition conditions have been set. If the
box that corresponds to an event point is checked, trace acquisition will be
stopped when that event is satisfied (only available when [Enable] has been
selected).
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(3) [Delayed Stop] page

Sets trace stop conditions. It is possible to set trace stop conditions with and without delay, with both allowed
simultaneously.

Trace Acquisition 2%

General | Stop  Delaped Stop |'I | 2 | 3 I 4 I

— Stop with Delay

Delay Count ID"I

— Ewent
™ 1 [EJH'D address

[~ Z[EIHD address

= 3(EJHT address

= 4(EJHO address

= 5(EIHO address

= B(EJHO address

I™ 7 [E] H107E address
[~ B[EIHMO8S address
I undefined or unavailable
I™ | undefined or unavailable
I™ | undefined or unayailable
I™ undefined or unavailable

oK I Cancel |

Figure5.32 [Trace Acquisition] Dialog Box ([Delayed Stop] Page)

[Stop With Delay]: Defines a trace stop condition.

[Enable]: Checking this box enables a trace stop.

[Delay Count]: Sets the delay count (in bus cycles, range 1 to 65535). This function allows
you to acquire anumber of trace records after any of the specified events
occur.

[Events]: Lists the event points where trace acquisition conditions have been set. If the

box that corresponds to an event point is checked, trace acquisition will be
stopped when that event is satisfied (only available when [Enable] has been
selected).
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(4) [1] to [4] pages

Sets arange trace. Thisis only available when the free trace mode is disabled. Select either of the following four
modes: [Disabled], [Point to Point], [Range], and [Event].

e Disabled

Disables arange trace.

Trace Acquisition 2%
General | Stop | Delayed Stop 1 |2 | 3 I 4 I
— Conditions

' Dizabled " Paint to Point " Range ' Event

Cancel

Figure5.33 Range Trace Setting (Disabled)
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e Point to Point

Acquires trace information in the specified range.

2]

General | Stop | Delayed Stop 1 |2 | 3 I 4 I

r Conditions

" Dizabled % Paint ko Paint " Range  Event

Start Address

HO00I07E

Stop Address

|Hoomnza

¥ Cyclic

Cancel

Figure5.34 Range Trace Setting (Point to Point)

[Start Address]:  Address where trace acquisition starts
[Stop Address]:  Address where trace acquisition stops

[Cyclic]: When this box is checked, the event sequencing is configured so that the events reset
themselves which causes tracing to be restarted when the start event occurs after the stop event.

Sets the event points that are required to start or stop trace acquisition when the start or end address is accessed,
respectively.

Point to Point mode is an easy method to set up the event mode. The event to start or sop trace acquisition isan
access to asingle address.

Select [Cyclic] to continue acquisition of the trace information only in the specified address range.

Note: This function automatically configures a sequence of event points. Note, however, that an unexpected
result may arise. In such cases, modify the setting of the sequence in the [Event Sequencing] dialog box.
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e Range

Only acquires the trace information that satisfies the specified condition.

21x]
General | Stop | Delayed Stop 1 |2 | 3 I 4 I
r Conditions
" Dizabled " Paint ko Paint % Range  Event
Fiange Ewent Edi. .. |
|7 [ETHT07E address =
Cancel

Figure5.35 Range Trace Setting (Range)

[Range Event]:  Selects an event point for which a trace acquisition condition has been set.
[Edit...]: Changes the setting for the selected event point.

Only acquires trace information from all bus cycles that matches the condition set in the selected event. This
mode uses one event channel or range channel.
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e Event

Acquires trace information, controlling the start and end of trace acquisition with the specified condition.

il B3|
General | Stop | Delayed Stop 1 |2 | 3 I 4 I
r Conditions
" Dizabled " Paint ko Paint " Range % Event
Start Event Edi... |
|7 [ETHT07E address =
Stop Event Edi... |
|8 [E)H108A address =]
¥ Cyelic
Cancel

Figure5.36 Range Trace Setting (Event)

[Start Event]: Selects the event point for which the condition to start trace acquisition has been set.
[Stop Event]: Selects the event point for which the condition to stop trace acquisition has been set.
[Edit...]: Changes the setting for the selected event point.

[Cyclic]: When this box is checked, the event sequencing is configured so that the events reset
themselves which causes tracing to be restarted when the start event occurs after the stop event.

Starts and stops trace acquisition when the conditions for starting and ending are satisfied, respectively. Selecting
[Cyclic] alows a continuous acquisition of trace information that can be acquired with the specified condition.
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584 Searching for a Trace Record

Usethe[Trace Find] dialog box to search for atrace record. To open this dialog box, choose [Find...] from the
popup menu.

The [Trace Find] dialog box has the following options:

Table55 [TraceFind] Dialog Box Pages

Page Description

[General] Sets the range for searching.

[Address] Sets an address condition.

[Data] Sets a data condition.

[R/W] Selects the type of access cycles.

[Area] Selects the area being accessed (not available when a time stamp is
acquired).

[Status] Selects the status of a bus (not available when a time stamp is acquired).

[Probes] Selects the status of four probe signals (not available when a time stamp
is acquired).

[IRQ7-0] Selects the status of eight probe input signals (not available when a time

stamp is acquired).

[Timestamp] Specify the time stamp value for bus cycles (only available when a time
stamp is acquired).
Note: Items other than [General], [Address], [Data], [R/W], [Area], [Status], [Probes], and [Timestamp] vary
according to the emulator in use. For details, refer to section 8, Software Specifications Specific to This
Product or the online help.

Clicking the [OK] button after setting conditions in those pages stores the settings and starts searching. Clicking
the [Cancel] button closes this dialog box without setting of conditions.

When atrace record that matches the search conditionsis found, the line for the trace record will be highlighted.
When no matching trace record is found, a message dialog box will appear.

Only the trace information that satisfies all the conditions set in above pages will be searched.

If afind operation is successful, selecting [Find Next] from the popup menu will move to the next found item.
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(1) [General] page
Set the range for searching.

x
Status | Probes | IRG7-0
General | Addess | Data | Raw | Area
Trace search range
r i [ Upward search

Start PTR : |'32?5?
EndPTR : ID—

ak I Cancel | Apply |

Figure5.37 [Trace Find] Dialog Box ([General] Page)
[Trace search range]: Sets the range for searching.

[Not designation]: Searches for information that does not match the conditions set in other
pages when this box is checked.

[Upward search]: Searches upwards when this box is checked.
[Start PTRY: Enters a PTR value to start a search.
[End PTR]: Enters a PTR value to end a search.

Note:  Along with setting the range for searching, PTR valuesto start and end searching can be set in the [Start
PTR] and [End PTR] options, respectively.
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(2) [Address] page
Set an address condition.

e
Status | Frobes | IRQ7-0
General Address | Data | R | Area

Setting
’7Ealue : IH 'FFEF20

ak I Cancel | Apply |

Figure5.38 [Trace Find] Dialog Box ([Address] Page)
[Don't care]: Detects no address when this box is checked.
[Setting]: Detects the specified address.

[Value]: Enter the address value (not available when [Don’t care] has been checked).

86
RENESAS




(3) [Data] page

Set adata condition.
x
Status | Probes | IRG7-0
General I Address Data I R | Area

Setting
’7Ealue : |H'0000

ak I Cancel | Apply |

Figure5.39 [Trace Find] Dialog Box ([Data] Page)
[Don't care]: Detects no data when this box is checked.
[Setting]: Detects the specified data.

[Value]: Enter the data value (not available when [Don’t care] has been checked).
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(4) [RIW] page
Select the type of access cycles.

x
Status | Frobes | IRQ7-0
General I Address | Data R I Area
Setting
String : I RD j

ak I Cancel | Apply |

Figure5.40 [Trace Find] Dialog Box ([R/W] Page)

[Don't care]: Detects no read/write condition when this box is checked.

[Setting]: Detects the specified read/write condition.
[String]: Select aread/write condition (not available when [Don’t care] has been checked).
RD: Read cycle
WR: Write cycle
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(5) [Area] page
Select the area being accessed. The selection is not available when atime stamp is acquired.

x

Status | Frobes | IRQ7-0 |
General I Address | Data | R Area
Setting
String : I RO j

ak I Cancel | Apply |

Figure5.41 [Trace Find] Dialog Box ([Area] Page)

[Don't care]: Detects no area condition when this box is checked.
[Setting]: Detects the specified area condition.
[String]: Select an area condition (not available when [Don't care] has been checked).

Note:  Available areas vary according to the emulator in use. For details, refer to section 5.7.4, Signals to
Indicate Bus States and Areas.
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(6) [Status] page
Select the status of abus. The selection is not available when atime stamp is acquired.

x

General | Address | Data | R | Area
Statuz I Probes | IRG7-0

Setting

Sting: |PROG |

ak I Cancel | Apply |

Figure5.42 [Trace Find] Dialog Box ([Status] Page)
[Don't care]: Detects no bus condition when this box is checked.
[Setting]: Detects the specified bus condition.
[String]: Select a bus condition (not available when [Don’t care] has been checked).

Note:  Available bus conditions vary according to the emulator in use. For details, refer to section 5.7.4, Signals
to Indicate Bus States and Areas.
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(7) [Probes| page
Select the status of four probe signals. The selection is not available when atime stamp is acquired.

x
General I Address | Data | R | Area
Sitatus Frobes I IRA7-0

—Selting

Probed IDon't care'l Probe3 IDon't careYI
Probe? IDon't carevl Probel IDon't care'I

ak I Cancel | Apply |

Figure5.43 [Trace Find] Dialog Box ([Probes] Page)
[Don't care]: Detects no probe signal condition when this box is checked.
[Setting]: Detects the specified probe signal condition.
[Probed] to [Probel]: Select probe conditions (not available when [Don't care] has been checked).
Don't care: Detects no selected probe condition.
High: The status of the probe signal is high.

Low: The status of the probe signal islow.
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(8) [1RQ7-0] page

Select the status of IRQ signals. The selection is not available when atime stamp is acquired.

Trace Filter x|
General I Address | Data Fi M | Area |
Status | Probes IRG7-0

Setting

IRG7 W IRIE Im
1RG5 W IRQ4 Im
IRE3  [Dortcaex]  AG2  [Dontcaex]
1RO lm, RGO lm,

ak I Cancel | Apply |

Figure5.44 [Trace Find] Dialog Box ([|RQ7-0] Page)

[Don't care]: Detects no IRQ input condition when this box is checked.

[Setting]: Detects the specifi

[IRQ7] to [IRQQ]:

92

ied IRQ input condition.

Select IRQ input conditions (not available when [Don't care] has been
checked).

Don't care: Detects no selected IRQ input condition.
High: The status of the IRQ input is high.

Low: The status of the IRQ input islow.
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(9) [Timestamp] page
Specify the time stamp value for bus cycles. The specification is not available when atime stamp is acquired.

Trace Find |

General' Addless' Data I Ray  Timestamp |

Setting

vaue [ 0 [ [ e [ s [ [

,TI Cancel | Apply |

Figure5.45 [Trace Find] Dialog Box ([Timestamp] Page)

[Don't care]: Detects no time stamp value when this box is checked.
[Setting]: Detects the specified time stamp value. (Every field must befilled in.)
[Value]: Enter the time stamp value.

Theformat is asfollows:
hour: h, minute: min, second: s, millisecond: ms, microsecond: us, nanosecond: ns

(Not available when [Don't care] has been checked.)

585 Clearing the Trace Information

Select [Clear] from the popup menu to empty the trace buffer that stores the trace information. If several [Trace]
windows are open, all [Trace] windows will be cleared asthey all access the same buffer.

5.8.6 Saving the Trace Information in a File

Select [Save...] from the popup menu to open the [Save Ag] file dialog box, which allows the user to save the
information displayed in the [Trace] window as atext file. A range can be specified based on the [PTR] number
(saving the complete buffer may take several minutes). Note that this file cannot be reloaded into the [Trace]
window.

Note: Infiltering of trace information, the range to be saved cannot be selected. All the trace information
displayed in the [Trace] window after filtering will be saved. Select afiltering range on the [General]
page in the [Trace Filter] dialog box if you want to save the selected range. For details on the filtering
function, refer to section 5.8.12, Extracting Records from the Acquired Information.
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5.8.7 Viewing the [Editor] Window
The [Editor] window corresponding to the selected trace record can be displayed in the following two ways:

e Select atrace record and choose [View Source] from the popup menu.
e Double-click atrace record

The [Editor] or [Disassembly] window opens and the selected line is marked with a cursor.

588 Trimming the Source

Choose [Trim Source] from the popup menu to remove the white space from the | eft side of the source.

When the white space is removed, a check mark is shown to the left of the [Trim Source] menu. To restore the
white space, choose [Trim Source] while the check mark is shown.

5.8.9 Acquiring a Snapshot of the Trace Information

A snapshot can be acquired when you need to check the trace information during execution of the user program.
Thisis useful for checking time stamping or probe input signals. To acquire a snapshot of trace information,
select [ Snapshot] from the popup menu. Trace acquisition istemporarily stopped to display arecord of the latest
trace information, and then restarted. A snapshot of trace information is only acquired during execution of the
user program.

5810 Temporarily Stopping Trace Acquisition

To temporarily stop trace acquisition during execution of the user program, select [Halt] from the popup menu.
This stops trace acquisition and updates the trace display. Use this method to check the trace information without
stopping execution of the user program.

5811 Restarting Trace Acquisition

To restart trace acquisition being stopped during execution of the user program, select [Restart] from the popup
menu.
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5.8.12 Extracting Recordsfrom the Acquired Information

Use thefiltering function to extract the records you need from the acquired trace information. The filtering
function allows the trace information acquired by hardware to be filtered by software. Unlike the settings made
in the [Trace Acquisition] dialog box for acquiring trace information by conditions, changing the settings for
filtering several timesto filter the acquired trace information allows easy extraction of necessary information,
which isuseful for analysis of data. The content of the trace buffer will not be changed even when the filtering
function is used. Acquiring useful information as much as possible by the [Trace Acquisition] settings improves
the efficiency in analysis of data because the capacity of the trace buffer is limited.

Use thefiltering function in the [ Trace Filter] dialog box. To open the [Trace Filter] dialog box, select [Filter...]
from the popup menu.

The [Trace Filter] dialog box has the following pages:

Table5.6 [TraceFilter] Dialog Box Pages

Page Description

[General] Selects the range for filtering.

[Address] Sets address conditions.

[Data] Sets data conditions.

[R/W] Selects the type of access cycles.

[Area] Selects the area being accessed (not available when a time stamp is
acquired).

[Status] Sets the status of a bus (not available when a time stamp is acquired).

[Probes] Selects the states of four probe signals (not available when a time stamp
is acquired).

[IRQ7-0] Selects the states of eight IRQ input signals (not available when a time

stamp is acquired).

[Timestamp] Specifies the time stamp value for bus cycles (only available when a time
stamp is acquired).
Note: Items other than [General], [Address], [Data], [R/W], [Area], [Status], [Probes], and [Timestamp] vary
according to the emulator in use. For details, refer to section 8, Software Specifications Specific to This
Product or the online help.

Set filtering conditions and then press the [OK] button. This starts filtering according to the conditions. Clicking
the [Cancel] button closes the [ Trace Filter] dialog box, which holds the settings at the time when the dialog box
was opened.

In filtering, only the trace information that satisfies one or more filtering conditions set in the above pages will
be displayed in the [Trace] window.

Filtering conditions can be changed several times to analyze data because the content of the trace buffer is not
changed by filtering.
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(1) [General] page
Set the range for filtering.

Trace Filker

IRG7-0
| Area

Status | Probes |
General | Addess | Data | R

" Enable Filter

Wk
I Mot designation

Trace display range

Start PTR: I
End FTR : I

ak I Cancel | Apply |

[Don't care other pages):

[Enable Filter]:

[No]:

[Trace display range]:
[Start PTRY]:

[End PTR]:

Figure5.46 [TraceFilter] Dialog Box ([General] Page)

Only selects the cycle number when this box is checked. Other options become
invalid.

Enables the filter when this box is checked.

Filtersinformation that does not match the conditions set in those pages when this
box is checked.

Sets the range for filtering.
Enters a PTR value to start filtering.

Enters a PTR value to end filtering.

Note:  Along with setting the range for filtering, PTR values to start and end filtering can be set in the [Start
PTR] and [End PTR] options, respectively.
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(2) [Address] page
Set address conditions.

Trace Filter x|
Status | Frobes | IRO70
General Address | Data | R | Area
[~ Con't cae
Setting

& Point ¢ Range
Fram : IH'
To: I

ak I Cancel | Apply

Figure5.47 [TraceFilter] Dialog Box ([Address] Page)

[Don't care]: Detects no address when this box is checked.
[Setting]: Detects the specified address.
[Point]: Specifies asingle address (not available when [Don’t care] has been checked).
[Range]: Specifies an address range (not available when [Don’t care] has been checked).
[From]: Enter asingle address or the start of the address range (not available when [Don’t
care] has been checked).
[To]: Enter asingle address or the end of the address range (only available when [Range]

has been selected).

Note:  Along with setting the address range, the start and end of the address range can be set in the [From] and

[To] options, respectively.
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(3) [Data] page
Set a data condition.

Trace Filter x|
Status | Piobes | IRG7-0
General | Addiess Data I Rw | Area

g
& Point ¢ Range

Fram : IH'
To: I

ak I Cancel | Apply |

Figure5.48 [TraceFilter] Dialog Box ([Data] Page)

[Don't care]: Detects no data when this box is checked.

[Setting]: Detects the specified data.
[Point]: Specifies single data (not available when [Don't care] has been checked).
[Range]: Specifies adata range (not available when [Don’t care] has been checked).
[From]: Enter single data or the minimum value of the data range (not available when [Don’t

care] has been checked).

[To]: Enter the maximum value of the data range (only available when [Range] has been
selected).

Note:  Along with setting the data range, the minimum and maximum values can be set in the [From] and [To]
options, respectively.
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(4) [RIW] page
Select the type of access cycles.

Trace Filter x|

Status | Frobes | IRO70
General I Address | Data R I Area
I Dortt,
Setting
[]RD
[ wH

ak I Cancel | Apply |

Figure5.49 [TraceFilter] Dialog Box ([R/W] Page)
[Don't care]: Detects no read/write condition when this box is checked.
[Setting]: Detects the specified read/write condition.

RD: Detects read cycles when this box is checked (not available when [Don't care] has
been checked).

WR:  Detects write cycles when this box is checked (not available when [Don't care] has
been checked).
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(5) [Area] page
Select the area being accessed. The selection is not available when atime stamp is acquired.

Trace Filter x|

Status | Piobes | IRG7-0 |
Gereral | Addess | Dala | RAw Area

Setting

CJROM =
CIRaM

1/0-16

/o8

CJEXT-16

CEXT6

IRA&M/DTC |

ak I Cancel | Apply |

Figure5.50 [TraceFilter] Dialog Box ([Area] Page)
[Don't care]: Detects no area condition when this box is checked.
[Setting]: Detects the specified area condition (not available when [Don't care] has been checked).

Note:  Available area conditions vary according to the emulator in use. For details, refer to section 5.7.4,
Signals to Indicate Bus States and Areas.
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(6) [Status] page
Select the status of abus. The selection is not available when atime stamp is acquired.

Trace Filter x|

General I Address | Data | Fi M | Area
Status I Frobes | IRG7-0

Setting

[PROG
CIDATA
[CIREFRESH
CIDMAC
oTC
[CJOTHER

ak I Cancel | Apply

Figure5.51 [TraceFilter] Dialog Box ([Status] Page)

[Don't care]: Detects no bus condition when this box is checked.

[Setting]: Detects the specified bus condition (not available when [Don’t care] has been checked).

Note:  Available bus conditions vary according to the emulator in use. For details, refer to section 5.7.4, Signals

to Indicate Bus States and Areas.
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(7) [Probes] page

Select the status of four probe signals. The selection is not available when atime stamp is acquired.

Trace Filker
General I Address | Data | Fi M | Area
Statug Fraobes IRE7-0

Setting

Probed IDon't care'l
Probe2 IDon't care'l

Probe3 IDon't care'l
Probel IDon't care YI

X

o 1

Cancel | Apply

Figure5.52 [TraceFilter] Dialog Box ([Probes] Page)
[Don't care]: Detects no probe signal condition when this box is checked.
[Setting]: Detects the specified probe signal condition.
[Probed] to [Probel]:
Don't care: Detects no selected probe condition.

High: The status of the probe signal is high.

Low: The status of the probe signal islow.
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(8) [1RQ7-0] page

Select the status of IRQ signals. The selection is not available when atime stamp is acquired.

Trace Filter x|
General I Address | Data Fi M | Area |
Status | Probes IRG7-0

Setting

IRG7 W IRIE Im
1RG5 W IRQ4 Im
IRE3  [Dortcaex]  AG2  [Dontcaex]
1RO lm, RGO lm,

ak I Cancel | Apply |

Figure5.53 [TraceFilter] Dialog Box ([IRQ7-0] Page)

[Don't care]: Detects no IRQ input condition when this box is checked.

[Setting]: Detects the specifi

[IRQ7] to [IRQQ]:

ied IRQ input condition.

Select IRQ input conditions (not available when [Don't care] has been
checked).

Don't care: Detects no selected IRQ input condition.
High: The status of the IRQ input is high.

Low: The status of the IRQ input islow.
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(9) [Timestamp] page

Specify the time stamp value for bus cycles. The specification is not available when atime stamp is acquired.

Trace Filker x|

Genelal' Addressl Data I Ry Timestamp
-

Setting
" Paoint " Range

o]

Cancel | Apply |

[Don't care]:
[Setting]:
[Point]:
[Range]:

[From]:

[To]:

Figure5.54 [Trace Filter] Dialog Box ([Timestamp] Page)

Detects no time stamp value when this box is checked.

Detects the specified time stamp value.

Specifies a single time stamp (not available when [Don’t care] has been checked).
Specifies atime stamp range (not available when [Don’t care] has been checked).

Enter asingle time stamp value or the minimum value of the time stamp range.
Theformat is asfollows:

hour: h, minute: min, second: s, millisecond: ms, microsecond: us, nanosecond: ns
(Not available when [Don't care] has been checked.)

Enter the maximum value of the time stamp range.

Theformat is asfollows:

hour: h, minute: min, second: s, millisecond: ms, microsecond: us, nanosecond: ns
(Only available when [Range] has been selected.)

Note:  Along with setting the time stamp range, the minimum and maximum time stamp values can be set in the
[From] and [To] options, respectively.
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5.8.13 Calculating the Differencein Time Stamping

Select [Timestamp Difference...] from the popup menu to calculate the time difference between the two points
selected by the result of tracing in acquisition of time stamp information.

np Difference 2lx]
 Select 2 line

FistPTR: [3276¢  SecondPTR: [0

|T imestamp difference information :

Jérggﬁtgggm?:?égzcﬂeMms 897uz 875ns
Clear |

4] | ] o |

Figure5.55 [Timestamp Difference] Dialog Box
[Select 2 ling]: Select trace records to calculate the time stamp difference.

[First PTR]: Specifies the first pointer to measure the difference. The pointer of the line
selected on the Trace window is displayed by defaullt.

[Second PTR]: Specifies the second pointer to measure the difference.

[Timestamp Difference]: Displays the results of calculation.

[Get Difference]: Calculates the difference between the specified two points and display itsresult in the
[Timestamp Difference] list.

[Clear]: Clearsall theresultsin the [Timestamp Difference] list.

[OK]: Closes the dialog box. All the resultsin the [ Timestamp Difference] list are cleared.
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5.8.14

Analyzing Statistical Information

Choose [Statistic] from the popup menu to open the [Statistic] dialog box and analyze statistical information
under the specified conditions.

tic 21x]
— Statistic Analysi:
Sef |
lem © [<Nores 4
Hew
Start I
Eesult |
End :I
Clear |
Result :
Condition | Amount | FTR
KN I
LCloze |

[Statistic Analysis]:

106

[Default]:
[Range]:
[Item]:

[Start]:

[End]:

[Set]:
[New]:
[Result]:
[Clear]:

[Close]:

Figure5.56 [Statistic] Dialog Box
Setting required for analysis of statistical information.
Setsasingle input value or character string.
Sets the input value or character string as arange.
Setstheitem for analysis.

Sets the input value or character string. To set arange, the start value must be
specified here.

Specify the end value if arange has been set (only available when [Range] has been
selected).

Adds anew condition to the current one.

Creates anew condition.

Obtains the result of statistical information analysis.

Clearsall conditions and results of statistical information analysis.

Closes thisdialog box. All the results displayed in the [Result] list will be cleared.

RENESAS




This dialog box allows the user to analyze statistical information concerning the trace information. Set the target
of analysisin [Item] and the input value or character string by [Start] and [End]. Click the [Result] button after
setting a condition by pressing the [New] or [Add] button to analyze the statistical information and display its
result in the [Result] list.

Note: Inthisemulator, only [PTR] can be set as arange. Each of other items must be specified as a character
string. In analysis of statistical information, character strings are compared with those displayed in the
[Trace] window. Only those that completely match are counted. Note, however, that this test is not case
sensitive. The number of blankswill not be cared either.

5.8.15 Extracting Function Callsfrom the Acquired Trace Information

To extract function calls from the acquired trace information, select [Function Call...] from the popup menu.
The [Function Call Display] dialog box will be displayed.

Funiction C: 2x

Setting

Enable ta dizplay trace information with function
call only ?

ok | LCancel |

Figure5.57 [Function Call Display] Dialog Box

[Setting]: Selects whether or not to extract function calls.
[Enable]: Extracts function calls.
[Disable]: Does not extract function calls.

When [Enable] is selected, only the cycles that include function calls are extracted for display from the acquired
trace information. The content of the trace buffer is not changed by extraction of function calls. Using this
function for the result of the free trace or the trace information that includes function calls allows the user to
know the order of function calls.
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59

Use the performance analysis function to measure the rate of execution time. The performance analysis function
does not affect the realtime operation because it measures the rate of execution time in the specified range by

Analyzing Performance

using the circuit for measurement of hardware performance included in the emulator.

Select either of the following five modes according to the purpose of measurement.

Table5.7

Mode

Available M easurement M odes

Description

Purpose

Time Of Specified Range
Measurement

Start Point To End Point
Measurement

Measures the execution time and
execution count in the specified
range.

Measures the execution time and
execution count between the
specified addresses.

Measurement of time taken for
processing of functions except for
that required for child functions
called from the functions.

Measurement of time taken for
processing of functions.

Start Range To End
Range Measurement

Measures the execution time
from a specified range to another
specified range.

Measurement of execution time
spent from calling of any of
sequential subroutines to calling of
any of another sequential
subroutines in a program that
includes subroutines in sequence,
such as an assembly program.

Access Count Of
Specified Range
Measurement

Measures the number of times a
specified range is accessed from
another specified range.

Measurement of the number of
times a global variable is accessed
from a specific function.

Called Count Of
Specified Range
Measurement

Measures the number of times a
specified range has called
another specified range.

Measurement of the number of
times a function is called from a
specific function.

Use eight performance channels installed on the circuit for measurement of hardware performance in the

emulator for setting of conditions for measurement. Up to eight points can be set.

Note, however, that up to four points can be set in Start Range To End Range M easurement, Access Count Of
Specified Range Measurement, or Called Count Of Specified Range Measurement because two sequential points

are used for setting a condition in these modes.

108

RENESAS



Table5.8 Mode Settingsfor Measurement

Point

Page

Time Of Specified Range o) 0 0 0 [¢) [e] [e] (6]
Measurement

Start Point To End Point o) 0 0 0 [¢) [e] (0] (6]
Measurement

Start Range To End fo) — fo) — fo) — fo) —
Range Measurement

Access Count Of fo) — fo) — fo) — fo) —
Specified Range
Measurement

Called Count Of fo) — fo) — fo) — fo) —
Specified Range
Measurement
Note: O: Available
—: Not available

Note:  Only one point isused in Time Of Specified Range Measurement and Start Point To End Point
Measurement, while two sequential points are used in Start Range To End Range Measurement, Access
Count Of Specified Range Measurement, and Called Count Of Specified Range Measurement. The
conditions that have been set will be canceled when switching these modes of different types.
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59.1 Opening the [Performance Analysis] Window

Choose [View -> Performance -> Performance Analysis] or click the [PA] toolbar button ) to open the
[Select Performance Analysis Type] dialog box.

Performance Analysis: EB000 Performance Analysis

Cancel

Figure5.58 [Select Performance Analysis Type] Window

Select [E6000 Performance Analysis] and then click the [OK] button to open the [Performance Analysis]|
window.

I [T

'""‘E

MAX-MIN-TIME Count 0---10---20---30

Wo Wewe | Condition | Rate | FUT-TINE

1 pal Range H'0000Z068 H'O000Z0D4 19% 00h OO0win O0s OO0Oms 35Zus 480ns 3 HERAHAEER

z

3

4

s

6

;

8

4 | _’I

Figure5.59 [Performance Analysis| Window

Thiswindow displays the rate of execution time in the area selected by the user during the last program run in
percentages, histogram, or numerical values.

It is possible to hide any column not necessary in the [Performance Analysis] window. Selecting a column you
want to hide from the popup menu displayed by clicking the right-hand mouse button on the header column
hides that column. To display the hidden column, select the column from the said popup menu again.
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59.2 Setting Conditionsfor M easurement

Conditions for measurement can be displayed and changed in the [Performance Analysis] window. Select a point
where a condition isto be set, and then select [Set...] from the popup menu to display the [Performance Analysis
Properties] dialog box.

Select either from the following five modes as the condition by the [Measurement Method] option:

Table59 Conditionsfor Measurement (Measurement Method)

[Measurement Method] Option

Time Of Specified Range Measurement
Start Point To End Point Measurement
Start Range To End Range Measurement

Access Count Of Specified Range Measurement
Called Count Of Specified Range Measurement

Set a condition for measurement according to the mode being selected. The parameters to be set depend on the
modes.

The [Performance Analysis] window has a support function to enter the address range of a function
automatically if the name of the function is entered to set an address range. Entering a function namein the
[Input Function Range] dialog box displayed by clicking the[...] button on the [Performance Analysis
Properties] dialog box automatically enters the address range of the function.

Input Function R ﬂ il

Function
|Sample:: Cancel |

Figure5.60 [Input Function Range] Window

Notes: 1. Entering the name of an overload function or aclass opens the [Select Function] dialog box. Select a
function in this dialog box.

2. The addresses figured out are just for reference. In some cases, the end address of a function may be
different. Check the last instruction of the function in the [ Disassembly] window to correct the value
set in [End Address] so that it will be the address of the last instruction (in general, the last instruction
of afunctionisaRTS instruction). A label name or an expression can be entered instead of an
address value in boxes where an address should be entered.
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(1) Time Of Specified Range M easurement

Range Mame |PA1
Range

Start Address IH'DDDDDDDD _I
End Address : IH'UUDDUDDD

— Common Settings of Performance(PA1-8]

Address Control Made: PC Settings... |
Time Measurement Unit: 160ns
Cancel |

Figure5.61 Time Of Specified Range Settings

[Range Name]: The name of the range to be measured

[Range]: Therange for the Time Of Specified Range M easurement
[Start Address]: Address to start measurement
[End Address]: Address to end measurement

Measures the execution time and the execution count in the range between the start address and end address.
Starts measurement with a detected program prefetch in the range specified between the start and end addresses,
and then stops with a detected program prefetch out of the specified range. Measurement can be restarted with a
detected program prefetch in the specified range. The execution count isincremented every time the program is
prefetched at the end address of the specified range. The execution time measured does not include the time
spent while being called from the specified range.
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(2) Start Point To End Point Measurement

Measurement Method PAT:

Start Paint To End Poinl

Foint

Count ;

Range Mame |PA1

Start Address IH'DDDDDDDD _I
End Address : IH'UUDDUDDD

Time Out : IDDh 00min 00z 000ms 000us O00ns

Jo1

— Common Settings of Performance(PA1-8]

Address Control Mode: FC Setlings... |

Time Measurement Unit: 160ns

Cancel |

Figure5.62 Start Point To End Point Measurement Settings

[Range Name]:

[Point]:
[Start Address]:
[End Address]:

[Time Out]:

[Count]:

The name of the range to be measured

Therange for the Start Point To End Point Measurement
Address to start measurement
Address to end measurement

The timeout val ue to finish measurement. When the minimum time for measurement
is160 ns, 40 ns, or 20 ns, enter the value as follows.
Example: 1h 2min 3s 123ms 456us 789ns

If the CPU operating mode is target, enter a hexadecimal number in 10 digits.
Example: 123456789A

A break occurs every time a value measured in the specified range exceeds the
timeout value (not the total time). Thisis only available for channel 1.

The count-up value used in measurement of the execution count. A break occurs
every time the execution count exceeds the count-up value. Thisisonly available for
channel 1.

Measures the execution time and the execution count in the range between start address and end address. Starts
measurement with a detected program prefetch at the start address, and then stops with a detected program
prefetch at the end address. The execution count isincremented every time the program is prefetched at the end
address of the specified range. The execution time measured includes the time spent while being called from the
specified range. When either from one to four pointsis selected, the maximum and minimum time in the
specified range can be measured.
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Notes: 1. When [Time Out] is selected in the Start Point To End Point Measurement mode, the execution time
will not be measured correctly.

2. When [Time Out] and [Count] are selected, satisfaction of either of these options stops execution of
the user program (performance break).

3. Only channel 1 can be used for [Time Out] and [Count]. Use other channels if you do not want to
select [Time Out] or [Count] in the Start Point To End Point Measurement mode.
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(3) Start Range To End Range Measurement

Measurement Method PAT: Ctart Bange To End Range

Range Mame |PA1
Start Range End Range

Start Address IH'DDDDDDDD _I Start Address IH'DDDDDDDD _I
End Address : IH'UUDDUDDD End Address : IH'UDDDUDDU

— Common Settings of Performance(PA1-8]

Time Measurement Unit: 160ns

Address Control Mode: FC Setlings... |

Cancel |

Figure5.63 Start Range To End Range M easurement Settings

[Range Name]: The name of the range to be measured

[Start Range]: The start range for the Start Range To End Range M easurement
[Start Address]: Start address
[End Address]: End address

[End Range]: The end range for the Start Range To End Range Measurement
[Start Address)]: Start address
[End Address]: End address

Starts measurement with a detected prefetch cycle in the specified start address range, and then stops with a

detected prefetch cycle in the specified end address range. The execution count isincremented every time the

program passes the end address range.
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(4) Access Count Of Specified Range M easurement

Measurement Method PAT:

Range Mame |PA1

Range Access Aea Range

Start Address IH'DDDDDDDD _I Start Address IH'DDDDDDDD _I
End Address : IH'UUDDUDDD End Address : IH'UDDDUDDU

Access Tupe
¥ Don't Care
I” DHMAC [T Befresh [T CRU Erefetch T CRU Data [ DI

— Common Settings of Performance(PA1-8]

Address Control Mode: Prefetch Settings... |
Time Measurement Unit: 160ns
Cancel |

Figure5.64 Access Count Of Specified Range M easurement Settings

[Range Name]: The name of the range to be measured
[Range]: The range for the Access Count Of Specified Range Measurement
[Start Address]: Start address
[End Address]: End address
[Access Area Range]: The access range for the Access Count Of Specified Range Measurement
[Start Address]: Start address
[End Address]: End address
[Access Type]: The bus cycle on the access range to be measured

Measures the number of times the range specified as the access range is accessed from the range specified by the

start and end addresses. The execution count in the range is measured with Time Of Specified Range
Measurement mode.

Note: Available bus cycle conditions vary according to the emulator in use. For details, refer to section 5.7.4,

Signalsto Indicate Bus States and Aresas.
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(5) Called Count Of Specified Range Measurement

Measurement Method PAT:

Range

Range Mame |PA1

Start Address IH'DDDDDDDD _I Start Address IH'DDDDDDDD _I
End Address : IH'UUDDUDDD End Address : IH'UDDDUDDU

Call Range

— Common Settings of Performance(PA1-8]

Address Control Mode: FC Setlings... |

Time Measurement Unit: 160ns

Cancel |

Figure5.65 Called Count Of Specified Range M easurement Settings

[Range Name]:

[Range]:
[Start Address]:
[End Address]:

[Call Rangel:

[Start Address]:

[End Address]:

The name of the range to be measured

The range for the Called Count Of Specified Range Measurement
Start address
End address

The range for the Called Count Of Specified Range Measurement. Asthe call range,
specify the start and end addresses of the selected subroutine.

Start address

End address

Measures the number of times the range specified as the call range is called from the range specified by the start
and end addresses. The execution time in the specified range can be measured with Time Of Specified Range
Measurement mode. As the call range, specify the start and end addresses of the selected subroutine.
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5.9.3 Selecting the Address Detection M ode and Resolution

In measurement of hardware performance, there are two types of address detection modes: prefetch address
detection mode and PC address detection mode. Select the appropriate address detection mode according to the
measurement mode in use. The resolution can also be selected here.

To select an address detection mode and resolution, click the [Settings...] button on the [Performance Analysis
Properties] dialog box. The [Common Settings of Performance(PA1-8)] dialog box will be displayed.

Zommao

Address Control Mode

Time Meazurement Unit 160Nz j Cancel |

Figure5.66 [Common Settings of Performance(PA1-8)] Dialog Box
[Address Control Mode]: Select the method to detect addresses for the rate of execution time.

PC: PC address detection mode
Prefetch: Prefetch address detection mode

[Time Measurement Unit]: Select the timer resolution to be used for measurement from 160ns, 40ns,
20ns, or Target. The timer for execution time measurement has a 40-bit
counter. At 20 ns the maximum time that can be measured is about six hours,
and at 160 ps the maximum time is about two days. When the counter
overflows, “Timer Overflow” isdisplayed as the result of measurement.
When Target is selected, the counter isincremented by an input clock. The
result of measurement is displayed as 10 digitsin hexadecimal.

Select the prefetch address detection mode in Access Count Of Specified Range Measurement, and PC address
detection mode in other measurement modes. Otherwise, the result of the measurement will be incorrect.

594 Starting Perfor mance Data Acquisition
Executing the user program clears the result of previous measurement and automatically starts measuring the rate

of execution time according to the conditions that have been set. Stopping the user program displays the result of
measurement in the [Performance Analysis] window.

595 Deleting a M easurement Condition

Select [Reset] from the popup menu with a measurement condition selected to del ete the condition.

5.9.6 Deleting All M easurement Conditions

Choose [Reset All] from the popup menu to delete all the conditions that have been set.
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Section 6 Tutorial

6.1 Introduction
The following describes the main functions of the emulator by using atutoria program.

The tutorial program is based on the C++ program that sorts ten random data items in ascending or descending
order. Thetutorial program performs the following actions:

e Themain function repeatedly callsthe tutorial function to repeat sorting.

e Thetutorial function generates random datato be sorted and callsthe sort and tutorial functions
in order.

e The sort function enters the array where the random data generated by the tutorial function are stored,
and sorts them in ascending order.

e The change function then sorts the array, which was sorted in ascending order by the sort function, in
descending order.

Thefiletutorial.cpp contains source code for the tutorial program. Thefile Tutorial .abs isa
compiled load module in the Dwarf2 format.

Notes: 1. After recompilation, the addresses may differ from those given in this section.

2. Thissection describes genera usage examples for the emulator. For the specifications of particular
products, refer to section 8, Software Specifications Specific to This Product, or the online help.

3. Theoperation addressof Tutorial .abs attached to each product differs according to products.
Replace the address used in this section with the relevant address in each product after checking that
itis placed on the corresponding line of the source program.

4. Inthistutorial, the H8S/2646 E6000 emulator is taken as an example. File paths or the appearance of
figures differs according to products.
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6.2 Running the High-performance Embedded Workshop
Open aworkspace by following the procedure listed in section 4.1.3, Selecting an Existing Workspace.

Select the following directory:
OS ingtallation drive \Workspace\Tutorial\E6000\2646

Note: Thefile path differs depending on the product. Refer to section 8.2.1, Environment for Execution of the
Tutorial Program.

Then select the file indicated below.

2]

Look in: I@ZBdB j - I‘j‘ =

] Debug_HE5_2282_FE6000_Emulator_CP

1 50urce
@ Tutarial, bws

File name: | Qpen I
Files of type: I HEW workspaces [F hws) j Cancel |
A

Figure6.1 [Open Workspace] Dialog Box

Opening this workspace automatically connects the emulator.
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6.3 Downloading the Tutorial Program

6.3.1 Downloading the Tutorial Program
Download the object program to be debugged.

o Select [Download module] from the popupmenu opened by clicking the right-hand mouse button on
[Tutorial.abs] of [Download modules].

EI@ Tutorial
= @ Tutarial
E| @ C zource file
2] dbsetc
i shrk.c
E| 23 T+ source file
H resetprg.cpp
sort.cpp
e | X butarial.cpp
E| @ Download madules
b

E| a Dependencie: 0 =
shikh Download maduls (debug data only)

sorkh Wnlzad module

stacksct b

Configure Wiew. .,

,T Allow Docking
Hide
il

Figure6.2 Downloading the Tutorial Program
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6.3.2 Displaying the Source Program

The High-performance Embedded Workshop allows the user to debug a user program at the source level.

e Double-click [Tutorial.cpp] under [C++ sourcefile].

E@ Tutarial
=-[F Tutorial

B3 C source file

29 G+ zoumce file

Q rezetprg.cpp
Q sort.cpp

------ [jtumﬁdcpp
=9 Download modules
NN T uitoiial abs
9 Dependencies

] @Pr.._l @Te... “1ha... |

Za
23
24
25
Z6
27
26
g=]
30
3l
3a
Gk
34
35
3G
3T
38
39
40
41
42
43
44
45
46
47
45
49
50
51
52
=3
54
55
=1
57
5a

]

< tutonial cpp I

00103 6
001034

001038
oo1044

O01046
O0104e
01050
001055
a0105a

001050

aoio7o
a0107a

00105z
o01l0Ga
001096
0010az
O010&ae
0010kba
00i0ce
ool10dz
o010de
O010ea
O010£s
O010£e

wold mainiwvoid)
i
while (111
tutoriall) :

wvold tutoriasl (void)
{
long a[10] ;
long 3:
int 1i;
class Sample *p_sam?

p_sam= Sample;
for|{ i=0; i<10; i++ )4

j = rand(}:

if(3 < o) ¢

J o= -3:

i

ali]l = 3;
i
p_sSam->sortia);
p_sam->change (a) ;

p_saw-»>s0=al[0] ;
p_sam->z1=a[l]:
p_sam-rsi=alz]:
p_sam-rs3=al3]:
p_sam-rsd=al4] ;
p_saw-»s5=a[5] :
p_sam-rst=al6] ;
p_sam->sT=al[7]
p_saw-»s5=a[8] ;
p_sam->39=a[9]:
p_sam;

Figure 6.3 [Editor] Window (Displaying the Sour ce Program)

e Select afont and size that are legible if necessary. For details, refer to the High-performance Embedded

Workshop user’s manual.

Initially the [Editor] window shows the start of the user program, but the user can use the scroll bar to scroll

through the user program and look at the other statements.
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6.4 Setting a Software Breakpoint
A software breakpoint is a smple debugging function.

The [Editor] window provides avery simple way of setting a software breakpoint at any point in aprogram. For
example, to set a software breakpoint at the sort function cal:

e Select by double-clicking the [S'W Breakpoints] column on the line containing the sort function call.

e J{
=G Tuterial ||
EIl@ Tutorial - - -

B a [ source file 29 001035 voild tutorial (void)

T T Q dhsct o 30 | 001044 {

Q sbilc 31 long a[10]

-3 Co+ source file 98 long 3:

B 1esetpra.cpp I8 Sl

E sait.cpp 34 class Sample *p_sam;
] tutorial.cpp 95
E3 Download modules 38 TDi0E p_sam= SRR
f Tulen 37 00l04e fori i=0; i<10; i4++ )4

{23 Dependencies 38 | 001050 j = randi():
3% | 001058 if (3 < 0){
40 | 00105a = -3:
41 H
4z | 00105 ali]l = 3
43 i
44 | 001070 ] p_sam->sort{a);
45 00107a p_sam->change (a) ;
45
47 ooilosz p_sam->=0=g[0] :
48 00108a p_Sam->31l=a[1]:
49 001096 p_sam->s2=al[2];
50 a010a2 p_sam->33=al[3]:
51 0010se p_Sam->s4=a[4]
5z 0010kba p_Sam->35=a[5]:
53 0010ceE p_sam->s6=al[6] ;
54 o010d:2 p_sam->37=al[7]:
55 0010de p_Sam->s8=a[8]
56 0o0l0ea p_Sam->39=g[9] ;
57 | 0010fe b_Sam?
58 | 0010fc H

K1l
e I Elte. |l | <% tutorial cpp I

Figure 6.4 [Editor] Window (Setting a Softwar e Breakpoint)

The symbol e will appear on the line containing the sort function. This shows that a software breakpoint
has been set.
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6.5 Setting Registers
Set avalue of the program counter before executing the program.

e Select [Registers] from the [CPU] submenu of the [View] menu. The [Register] window is displayed.

=10l
Name | ¥alue | Radix |
ERO Qo00Z71F Hex
ER1 OOFFEFAL Hex
ERZ oooooooo Hex
ER3 OOFFEFE0 Hex
ER4 0000000A Hex
ERS OOFFEFE0 Hex
ERfG OOFFEODS Hex
ER7 ooooooio Hex
BEC ooo400 Hex
CCR 10000000 I0——---- Bin
EXR o1111111 ————- 111 Bin

Figure6.5 [Register] Window

e To change the value of the program counter (PC), double-click the value area in the [Register] window with
themouse. The following dialog box is then displayed, and the value can be changed. Set the program
counter to H’ 00000400 in this tutorial program, and click the [OK] button.

21|
Valug: [000400
Radix: |Hex [
2etAst [yhole Register [
[k | cacel |

Figure6.6 [Register] Dialog Box (PC)
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6.6 Executing the Program
Execute the program as described in the following:

e To execute the program, select [Go] from the [Debug] menu, or click the [Go] button on the toolbar.

=l

Figure 6.7 [Go] Button

While the program is executing, the current address bus value and the operating state of the MCU are displayed
on the status bar.

The program will be executed up to the breakpoint that has been inserted, and an arrow will appear on the [S/W
Breakpoints] column in the [Editor] window to show the position that the program has halted, with the message
[ Br eak = Software Br eak] in the status bar.

Note: When the source file is displayed after a break, a path of the source file may be inquired. The location of
the source fileis as follows:

OSinstallation drive \Workspace\T utorial \E6000\2646\Source

The directory mentioned above cannot be specified depending on the version of the software. In such
cases, specify the following directory instead.

High-performance Embedded Workshop installation destination directory
\T ool s\Renesas\DebugComp\Pl atf orm\E6000\2646\Source

Thefile path differs depending on the product. If necessary, replace \2646 with another name.
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29 oo1038 wvoild tutorial (void)
30 001044 {
31 long a[10]
32 long 1:
33 int 1i:
34 class Fample Tp_sam;
35
36 001046 p_Sam= Sample;
37 00104e for( i=0; i<10; i++ )4
358 001050 J = rand();
3E 001058 if (3 « 0)4
40 00105& j = -3:
41 i
4z 00105c ali] = 3:
43 }
44 | 001070 2 p_sam->20rt(a):
45 00i07a p_sam->change (a) ;
45
477 oo108z2 p_saw->s0=a[0]
45 o0108a p_sam->s1=all];
49 001096 p_sam->s2=al[Z]:
50 0010a2 b_sawm->33=al3]:
Si 0010ae p_sSam->s4=al4] ;
5z a010kha p_sam->s5=a[5]:
53 0010ca p_sam->s6=al6];
5q 0010dz2 p_sam->s7=al7]:
55 0010de p_sam->s5=a[8];
=13 0010e& p_sam->s59=a[9]:
57 0o010fe b_sam;
55 ool0fe +

KN

<L tutorial cpp |

Figure6.8 [Editor] Window (Break Status)
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The user can see the cause of the break that occurred last time in the [Status] window.

e Select [Status] from the [CPU] submenu of the [View] menu. After the [Status] window is displayed, open
the [Platform] sheet, and check the St at us of Cause of | ast break.

=
Item | Status |
Connected To: HSS/2Z82 EGO00 Emulator CPU 2000 (EEO00 USE Driwver)
CEU HES/ 2282
Mode 7
Clock source Main: 10MHz, Sub:3iZkHz
Run status EBreak
Cause of last break  Software Break
Event Time Count 00k OOwin 00s 000ms 000us 000ns
Fun Time Counkt 00k OOwin 00s 000ms 924us 375ns

4 I :IR Memary }\Plalform A Events f

Figure6.9 [Status] Window

Note: Theitemsthat can be displayed in thiswindow differ depending on the product. For the itemsthat can
be displayed, refer to section 8, Software Specifications Specific to This Product, or the online help.
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6.7 Reviewing Breakpoints
The user can see al the breakpoints set in the program in the [Event] window.

e Select [Eventpoints] from the [Code] submenu of the [View] menu. The [Event] window is displayed. Select
the [Breakpoint] sheet.

- Event O] x
CEE————— =101 x|

[ ||§|
Type | State | Condition |Act:i_0n I
Prograw Enable PC=001070 (tutorial.cpp/44) Break

IIII\Breakpoinl {-'\E\rent }\ Trigger f‘

Figure6.10 [Event] Window

The popup menu, opened by clicking the [Event] window with the right-hand mouse button, allows the user
to set or change breakpoints, define new breakpoints, and delete, enable, or disable breakpoints.
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6.8 Referringto Symbols

The [Label] window can be used to display the information on symbols in modules.

Select [Label] from the [Symbol] submenu of the [View] menu. The [Label] window is displayed so that the user
can refer to the addresses of symbolsin modules.

ol
oo X R E
EF | Address I Name IL
aoo400 PowerON Reset ()
oo1o0o _shrk
oo1loz4 _main
aolo3s tutoriall)
0o110a _short
ooiioc _ INIT3CT
oo1iza loopl
Oo1l1zZc loop2
O011ZE next loopZ o
001132 next loopl
001144 loop3
oo1152 loopd
001158 next_ loopd
oo115c next_ loop3
001168 operator new{unsigned long)
DO011BE _ CALL INIT
DO11ED __ CALL_END
O011E4 operator delete(woid *)
OD11EE _rand
0Dliie _srand
oo1zza §DIVLE3
oolz3c not_negx
0o01z44 not_neg¥ LI

Figure6.11 [Label] Window
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6.9 Viewing Memory

When the label name is specified, the user can view the memory contents that the label has been registered in the
[Memory] window. For example, to view the memory contents corresponding to_main in byte size:

e Select [Memory ...] from the [CPU] submenu of the [View] menu or click the [View Memory] toolbar
button (@) to open the [Display Address] dialog box. Enter _mainin the[Display Address] edit box.

Jd

Dizplay Address: I_main 'l |
Scroll Start &ddress: IUUUUUUU 'l |
Scroll End Address: IFFFFFFF 'l |

QK. I Cancel |

Figure6.12 [Display Address] Dialog Box

e Click the [OK] button. The [Memory] window showing the selected area of memory is displayed.

=10l
[t mmzz|[6 D408 2 |[meisddode|saase @
Address | Tmhel | Register [ +0 +1 +2 +3 +4 +5 +6 +7 +8 +3 +A +B +C +D +E +F | ASCII \ﬂ
001034 | wain 55 02 40 FC Ol 00 e6p F3 Ol 20 6D F4 79 37 00 28 U.G...m.. m.y¥7.0
001044 OF F3 1a 80 SE 00 20 OO OF 86 10 44 5B 00 11 EE ....*-. Pacs
001054 17 PO OF 85 4¢ 02 17 ES 17 F4 OF c0 10 70 O& BO
001064 01 00 63 85 0B 54 79 24 00 0OA 4p EO0 OF BS OF ©l
001074 OF EO SE 00 Z0 €8 OF Dl OF EO 5E OO 20 pe 01 OO
001084 69 50 01 00 63 EO 01 OO0 6F SO0 00 04 01 0O 6F EO
001094 00 D4 01 OO0 6F S0 00 08 Ol 00O 6F BO OO0 08 01 OO
001024 GF 50 00 0c 01 00 6F EO OO Oc 01 OO0 eF 50 00 10
001084 0L 00 ¢F EO OO 10 Ol 00 eF 50 00 14 01 00 6&F EO
0010c4 00 14 01 OO0 6F S0 00 18 01 00 6F EO 00 18 01 OO
001004 6F S50 00 1c 01 00 6F E0 00 1¢ 0l OO0 6F S50 00 20 .
001084 01 00 6F EO OO 20 O1 00 eF 55 00 24 01 00 6&F ES . -
0010r4 00 24 OF EO SE 00 11 E4 79 17 00 28 01 20 6D 76 .§..°...¥..[. wv
001104 01 00 ep 73 54 70 5S4 70 e FZ 01 20 ep F4 TA 00 .. wsTpTpw.. m.zZ.
001114 00 00 15 D2 7A 01 00 OO 15 DA Fa 00 40 10 01 OO0 .
001124 6D 04 01 00 6p 05 40 02 eCc DA 1F D4 45 Fa 1F 90
001134 45 EC 7FA 00 00 00 15 c¢6& 7a 01 00 OO0 15 pz 40 18
001144 Loop2 01 00 ep 04 01 00 e6p 05 01 00 &0 O6 40 D& 6&C 42
001154 68 EA OB 06 1F D4 45 FE& 1F 00 45 E4 01 20 6D 76
001164 6D 72 54 70 01 20 6p F4 OF B85 46 3E 1a ©p5 Fp 01
001174 40 38 01 00 6B 26 00 FF E4 14 47 04 OF EO 40 O0O¢
001184 74 00 00 00 14 90 OF 84 01 00 6B 26 00 FF E4 OC
001194 47 D4 OF E1 40 02z OF €1 OF 96 5b 10 7& 00 00 OO0 =

Figure6.13 [Memory] Window
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6.10 Watching Variables

Asthe user steps through a program, it is possible to watch that the values of variables used in the user program
are changed. For example, set awatch on the long-type array a declared at the beginning of the program, by
using the following procedure:

o Click theleft of displayed array a in the [Editor] window to position the cursor.

e Select [Instant Watch...] with the right-hand mouse button.

The following dialog box will be displayed.

[#-a {FFEFB0} [lang[10])

Figure6.14 [Instant Watch] Dialog Box

o Click the [Add] button to add a variable to the [Watch] window.

=131 x|

RE|M/ X | &

AP\ watchy 4 watchz J wiatcha b Wwatcha [

Figure6.15 [Watch] Window (Displaying the Array)
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The user can also add a variable to the [Watch] window by specifying its name.

e Click the [Watch] window with the right-hand mouse button and select [Add Watch...] from the popup menu.

The following dialog box will be displayed.

i Cancel

21 x
Wariable or expression:

Figure6.16 [Add Watch] Dialog Box

e Input variable 1 to [Variable or expression] edit box and click the [OK] button.

The [Watch] window will now also show the int-type variable i.

oW akch

R E |0/ X |

=101

H'OOO= { R4 }

AP\ watcht /4 watchz J watchs }, Watche [/

Figure6.17 [Watch] Window (Displaying the Variable)
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The user can click mark ‘+ at the left side of array a in the [Watch] window to watch all the elements.

L2 ch

R E [0/ X |B

=101 x|

..... B [0]1
----- R [1]
..... =] [21
..... B [31
----- B [4]
..... =] [5]
..... = [6]
----- B [7]
..... =] [a21
..... E [9]1

H'000041ce { FFEFAO
H'00001e7e { FFEFS4
H'0O000Z781 { FFEFAS
H'0000446k { FFEFAC
H'0000724k { FFEFO0
H'0000153fk { FFEF94
H'000059=2 { FFEF98
H'00001cfh { FFEFOC
H'00003f54 { FFEFAO
H'00000ffe { FFEFA4

H'O00a { R4 }

Cm B G on Ep oon B Bew e e

[long)
[long)
{long)
[long)
(long)
{long)
[long)
{Llong)
{Llong)
[long)
[int)

A watchy A wiatehz J, watchs A wiatcha

Figure6.18 [Watch] Window (Displaying Array Elements)
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6.11 Displaying Local Variables

The user can display local variablesin afunction using the [Locals] window. For example, we will examine the
local variablesinthe tutorial function, which declares four local variables: a, 5, i, and p_sam.

e Select [Locals] from the [Symbol] submenu of the [View] menu. The[Locals] window is displayed.
The [Locals| window shows the local variablesin the function currently pointed to by the program counter,

aong with their values. Note, however, that the [Locals] window isinitially empty because local variables are
yet to be declared.

=10l

| H'OOOOOffe { ERI } [ Long)
i H'OOO=a { R4 } [int)
Ox00ffe0d8 { ERG } [elass Sample*)

Figure6.19 [Locals] Window

e Click mark ‘+ at theleft side of array a in the[Locals] window to display the elements.

o Refer to the elements of array a before and after the execution of the sort function, and confirm that
random data s sorted in descending order.

134
RENESAS




6.12 Stepping Through a Program

The High-performance Embedded Workshop provides arange of step menu commands that allow efficient
program debugging.

Table6.1 Step Option

Menu

Command Description

Step In Executes each statement, including statements within functions.

Step Over Executes a function call in a single step.

Step Out Steps out of a function, and stops at the statement following the statement in the
program that called the function.

Step... Steps the specified times repeatedly at a specified rate.

6.12.1 Executing the [Step In] Command

The [Step In] command steps into the called function and stops at the first statement of the called function.

e To step through the sort function, select [Step In] from the [Debug] menu, or click the [Step In] button in

the toolbar.

™

Figure6.20 [Step In] Button
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11
1z
13
13
15
16
17
15
13
20
21
ZZ
23
24
25
26
a7
28
z8
30
31
3z
33
34
&5
36
37
38
ElE]
40
41
4z
43
44
45
45
47

[« |

QozZooo0
00z006
00Z201c
Q0zZ0zZe
O0Z0Zc
00z032
002038
00zZ03e
00zZ044
00zZ04&
Q0zZ050
O0zZ056
00zZ060

aO0z0a65
anzowo

nozova
QozZ0ve
00Z078
00207
002080
00zZ054

00z20a4
Q0Z0as

a0z oco

00z0co

< tutorialcpp < sortopp I

Sarwple::Samplel)

{
s0=0;
=1=0;
=2=0;
s3=0;
z4=0;
=25=0;
s6=0;
s7=0:
=5=0;
=9=0;

void Sample::sort(long *a)
{
long )
int i, 3j, kK, gap:

gap = &5;
while( gap = 0 1{
for (| k=0; k<gap: k++){
for( i=k+gap; i<10; i=i4gap )1
for (j=i-gap: Ij>=k: j=j-gap){
if(aljl=ali+gap] ]
t = alil:
alil = alji+gap]:
alj+gap] = t;
H
else
break;

¥
gap = gap/I:

Figure6.21 [Editor] Window (Step In)

e Thehighlighted line movesto the first statement of the sort function in the [Editor] window.
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6.12.2 Executing the [Step Out] Command

The [Step Out] command steps out of the called function and stops at the next statement of the calling statement
inthemain function.

e Tostepout of the sort function, select [Step Out] from the [Debug] menu, or click the [Step Out] button in
the toolbar.

Figure 6.22 [Step Out] Button

oy ] 9

29 001038 woid tutorial (void) j

30 001044 1

31 long a[10]:

3z long 3:

33 int 1i;

34 elags Sample *p_Sam; ;IQIEI

35

36 | 001046 p_sem— Sample; R & ‘U‘ 7 X |@

37 00104e for( i=0:; i<10; i++ 14

38 | 001050 3 = randi:

39 001053 if(3 < 0){

40 | oo0105a q o ap R [0] H'00000££6 { FFEFGO }  (long)

41 ' R [1] H'000015fk { FFEFG4 }  (long)

4z | 00105c ali] = 3: R [Z] H'0000167e { FFEFGG }  (long)

43 H ® I

a2 | maemm * 7 PP )G [31] H‘DDDchfb { FFEFBC }  ([long)

45 | oo0107a o p_san->change (a) ; R [4] H'0000Z761 { FFEFS0 }  (long)

46 R [5] H'00003£54 { FFEF94 }  (long)

47 | 001032 p_sam->s0=a[0] ; R [6] H'000041cé { FFEF9G }  (long)

48 | 001082 B EET=EEEEY ) B B [7] H'0000446k { FFEF3C }  [long)

49 001096 P Sam->3z=alz]: ,

50 | ooipaz 1 san->s3=a[3]; R [8] H'000059el { FFEFAQ }  (long)

51 | 0O010ae p_sam->s4=al4] z R [9] H'0000794k { FFEFA4 }  (long)

5z 0010ba p sam->s5=a[5] : i H'0O00a { R4 ! {int)

53 | 0O010cE p_sam->s6=a[f]

g4 0104z P Sam->37=al7]:

55 0010de p_sam->s8=a[8] ; b

56 | 0010ea p_sam->s9=a[S] ;

57 0010£6 p_Sam: h h h h

o | oo1nme h A FT watcha {wiatchz J, istcha J, uiatcha -
1] oW

Figure 6.23 [High-performance Embedded Workshop] Window (Step Out)

The data of variable a displayed in the [Watch] window is sorted in ascending order.
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6.12.3 Executing the [Step Over] Command

The [Step Over] executes afunction call as a single step and stops at the next statement of the main program.

e To step through al statementsin the change function at asingle step, select [Step Over] from the [Debug]
menu, or click the [Step Over] button in the toolbar.

Figure6.24 [Step Over] Button

b oy ] 9
[z &@la

29 | 001038 void tutorial (void) ZI

30 001044 4

31 long a[10];

3z long 3:

33 int i;

34 class Sample *p_sem: I [=

35

36 | 001046 p_sam= Sample; RE v/ X |

37 00104e for| 1i=0; i<107 i++ )4

38 001050 J = randf():

39 001055 if(3 < 0){

40 | 001052 ' Jj = -3: R [0] H'0000734k { FFEFB0 } {long)

41 B R [1] H'000058eZ { FFEFE4 } {long)

4z | 00105 ali] = 3; R [z1 H'0000446k { FFEFBE } {Llong)

43 } = !

44 | 001070 * p_sam->sort (a) (21 H‘DDDMIEG { FrErc ) (long)

45 | 00107a p_san->change (a) R [4] H'00003f54 { FFEFS0 }  (long)

46 R [5] H'00002781 { FFEFS4 } {long)

47 | 001082 2 p_sam->s0=a[0] ; R [6] H'0000icfk { FPFEFOG }  (long)

48 | 00108a p_sam—>sl=a[1]: R [7] H'D000167e { FFEF3c }  (long)

49 | 001096 p sem->si=alz]:

0 | Eeneee o san->s3=a[3] - ~R® [8] H'000015fk { FFEFAD }  (long)

51 0010ae p_sam->s4=a[4] ; ~R 9] H'O0000ff6 { FFEFA4 } {Long)

52 | D010ba p_sam->s5=a[5] ; i H'000a { R4 } {int)

53 oo01loce b sam->s6=a[6] ;

54 | 0010dz p_sam->s7=a[7] ;

55 | D010de p_sam->s3=a[8] fn

56 0010ea p_sam->s9=a[9] ;

:; Egigis h D AT watcha { wratchz p wiatcha b wiatcha f -
el 0

Figure 6.25 [High-performance Embedded Workshop] Window (Step Over)
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6.13 Forced Breaking of Program Executions
The High-performance Embedded Workshop can force a break in the execution of a program.
e Cancel dl the breaks.

e To execute the remaining sections of thet ut or i al function, select [Go] from the [Debug] menu or the
[Go] button on the toolbar.

ElL

Figure6.26 [Go] Button

e The program goesinto an endlessloop. To force abreak in execution, select [Halt] from the [Debug] menu
or the [Stop] button on the toolbar.

Figure 6.27 [Stop] Button

6.14 Resettingthe M CU

Resetting the MCU initializes the internal 1/0 registers and makes the program counter jump to the address set in
the reset vector.

To reset the MCU, select [Reset CPU] from the [Debug] menu or the [Reset CPU] button on the toolbar.

Ejj

Figure6.28 [Reset CPU] Button

To execute the program from the reset vector, select [Reset Go] from the [Debug] menu or the [Reset Go] button
on the toolbar.

Figure6.29 [Reset Go] Button

Note: Thistutorial program is executable from the reset vector.
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6.15 Break Function

The emulator’s break functions are of two types: software breaks and breaks at event points. software
breakpoints and event points are set in the High-performance Embedded Workshop’s [Event] window.

An overview and setting of the break function are described below.

6.15.1 Software Break Function
The emulator can set up to 256 software breakpoints.

e Select [Eventpoints] from the [Code] submenu of the [View] menu. The [Event] window is displayed.

e Select the [Breakpoint] sheet.

=10l x|

& SR |EI
Type I State I Condition |Act:i_0n |

E\Breakpoint AE\rent }\ Trigger !“

Figure 6.30 [Event] Window (Before Setting a Software Breakpoint)

e Click the [Event] window with the right-hand mouse button and select [Add...] from the popup menu.
e The [Breakpoint/Event Properties] dialog box is displayed.
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21

Addre
) Donlt Care O Addess € Fange

Address Lo [H'00001082
 [Erit Address Hi |H'DDDDDDDD

I™ Gutside Fange

— Data Compare [irection——
[~ Compare I~ Use b ask £ Bead
alue [

- IH L ) Write:

& Bpte. € Wiord
bask IH'D % Either

QK I Cancel

Figure 6.31 [Breakpoint/Event Properties] Dialog Box
e Check the [Software Break] radio button in the [Type] group box.

e Usethe [Editor] window to refer to the address on the line that has ' p_sam->s0=g[0];’ withinthe tutorial
function and enter this addressin the [Address Lo] edit box of the [Address] group box. In this example,
enter H/00001082.

Note: Thisdiaog box differs according to the product. For the items of each product, refer to section 8,
Software Specifications Specific to This Product, or the online help.

e Click the[OK] button.
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The software breakpoint that has been set is displayed in the [Event] window.

~iolx
A=

Type | State | Condition |Act:i.0n I
Program Enable PC=001082 (tutorial.cpp/47) Ereak

MBreakpoinl ,){\E\rent ,}\ Trigger f

Figure 6.32 [Event] Window (Softwar e Breakpoint Setting)

Note: Theitemsthat can be displayed in this window differ depending on the product. For the items that can
be displayed, refer to section 8, Software Specifications Specific to This Product, or the online help.
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o Close the [Event] window.

e To stop the tutorial program at the breakpoint, select [Reset Go] from the [Debug] menu.

The program runs until it stops at the breakpoint that has been set.

29 001038
30 001044
31
32
33
e
35
3e 0ol04e
37 00104e
3B oo10s0
39 001058
40 0o105a
41
42 00105
43
44 ooi070
45 00107a
46

47 001082
45 00108a
49 001096
50 00108z
51 0010ae
52 0010ba
53 0ol0ce
54 ooi0dz
55 0010de
56 0010ea
57 ooi10fa
58 O0i0fe

<1 |

wvolid tutorial (void)
{
long a[10] :
lang 3:
int i:
class Sample ¥p sam;

T_Sam= Sample:
for | i=0; i<10; i++ ¢

J = randl):

if(3 <« 014

j=-1:

¥

ali]l = 3:
i
p_sam->sSortia);
p_sSam-rchange (a) ;

=3 p_sam->s0=a[0] ;
p_sam-rs1=al[l]:
b sam-»32=alz]:
p_sam->33=al[3]:
p_sam-rs4=al[4]
p_sam-»35=a[5] ;
p_sam-rs6=al[6];
p_sam->s7=a[7];
p_sam-»s8=a[8]
b_Sam-»39=a[9] ;
p_sam;

twmmmDpI

Figure 6.33 [Editor] Window at Execution Stop (Softwar e Break)
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The [Status] window displays the following contents:

=
Item | Status |
Connected To: H83/2282 EAODD Ewulator CPU Z000 (EADOD USE Driver)
CPRU HB3/2282
Mode 7
Clock source Main: 10MHz, Sub:3ZkHz
Fun status Ereak
Cause of last break  Software Break
Event Time Count 00h OOmin 00s 000ms 000us 000ns
Fun Time Counk 00h OOmin 00s 001ms 098us 6Z25ns

4 I :I;‘ Mernory }\Plalform f{ Ewents [

Figure 6.34 Displayed Contents of the [Status] Window (Softwar e Break)

Note: Theitemsthat can be displayed in this window differ depending on the product. For the items that can
be displayed, refer to section 8, Software Specifications Specific to This Product, or the online help.
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6.15.2 Breaking Execution at Event Points

Setting up of an event point on event channel 1 (Ch1) such that a break is triggered when the event point’s
conditions have been satisfied five times is explained as an example of the use of event points.

Select [Eventpoints] from the [Code] submenu of the [View] menu. The[Event] window is displayed.

The breakpoint that has been previously set must be deleted. Click the [Breakpoints] window with the right-
hand mouse button and select [Delete All] from the popup menu to delete al the breakpoints that have been
et

Click the [Event] tab.

Up to 12 event points (eight event channels and four range channels) can be set up as independent conditions. In
this example, we are setting the condition for event channel 1.

-0 x|
iaqlx||§|
Type IStateICDndition Action |
Chl (E} Empty
Chd [(E} Emwpty
Zh3 (E} Empty
zhd [(E} Empty
ch5 (E} Empty
Ché (E} Empty
ch7 (E} Empty
Zh8 (E} Empty
Zh9 (R} Empty
Chl0O(R) Empty
Chll(R}) Empty
ChlZ (R} Empty

4 I )I'\ Ereakpaint }\Event f{ Trigger [‘

Figure6.35 [Event] Window (Event Channel 1 [Ch1])

Select the line for Chl in the [Event] window. Double-click on thisline that is highlighted.

The [Breakpoint/Event Properties] dialog box is displayed.

Make the following settings in the boxes on the [General] page:

Select the [Event] radio button in the [Type] group box.

Select the [Address] radio button in the [Address] group box. Then use the [Editor] window to refer to the
address on theline that has ‘[i]=j;” withinthe tutorial function and enter this address in the [Address
Lo] edit box. In this example, enter H'0000105c.

Enter D 5 as the number of times the event condition is to be satisfied in the [Required number of event
occurrences] edit box on the [Action] page.
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General | Bus / Avea | Signak | Action |

21

Address Lo [H0000105C

— Type Addre
~ Sottware " Daon't Care ™ Addresz € Range
Ereak.

Address Hi' 00000000

I™ Gutside Fange

— Data Compare Direction——
[ Compare I~ Use b ask " Read
alue [
- IH L  Wite
& Bpte. € Wiord
bask IH'D & Either
’TI Cancel |

Figure6.36 [General] Page ([Breakpoint/Event Properties| Dialog Box)

e Click the [OK] button. The [Event] window is displayed, as shown below.

~18lx|
=

Type | Statel Condition Action |
Chl (E} Enable Address=00105C (tutorial.epp/d2) address count D'S Ereak

Chi (E} Empty

Ch3 (E} Empty

Ch4 (E} Empty

Ch5 (E} Empty

Cche (E) Empty

ch7 (E) Empty

Chi8 (E) Empty

Ch9 (R} Empty

Chl0(R} Empty

Chll(R} Empty

ChlZ (R} Empty

AP T Ereskpoint ) Event A Trigger [

Figure 6.37 [Event] Window (Setting Completed)

Note: Theitemsthat can be displayed in this window differ depending on the product. For the items that can be
displayed, refer to section 8, Software Specifications Specific to This Product, or the online help.
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Select [Reset Go] from the [Debug] menu to stop the tutorial program at breakpoints.

The program runs then stops at the condition specified under Chl.

29 001038
30 0010434
31
32
33
34
35
3o 001046
37 0ol04e
38 oo10s0

ElE] 001058
40 o0105a
41

42 00105
43

443 oolovo
45 oo107a
46

47 oo10sz2
48 oolosa
49 001096

50 0010&2
51 0010&e
52 0010ba
55 0010ca
54 oo10dz
55 0ol0de
56 O001i0ea
57 oo10fa
58 0010fc

kIR

void tutorial (wvoid)
{
long a[10]
long j»
int i:
class Sample *p_sam?

p_Sam= Sample:
for( i=0; i<10; i++ )1
j = randi);
if(3 < 01§
i = -1
H
& al[i] = 3
i
p_Sam->S0rt (&)}
p_sesm->change (a) ;

p_sSam->s0=a[0] ;
p_sam->s1=a[l]:
p_sam-»sZ=a[Z]:
p_sam->s3=a[3];
p_sam->s4=a[4]:
p_Sem-»35=a[3];
p_sam-rs6=al[6] :
p_sam->37=al[7]:
p_sam->s5=a[8]:
p_sam-»>s9=a[9] ;
p_San;

tutorial.cpp l

Figure 6.38 [Editor] Window at Execution Stop
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The [Status] window displays the following contents.

=lol x|
Item Status |
Connected To: HB3/2282 E6OO0 Ewulator CPU 2000 (ES000 UIE Driwver)
CPU HAS/2282
Mode 7
Clock source Main:10MHz, Sub:3ZkH=
Fun status Ereak
Cause of last break Complex Event System
Event Time Count 00k OOwin 00z 000ws 000us 000ns
Fun Time Count 00k OOwin 00s 000mws 8926us 875ns

4 I :I;‘ Memary }\Plalform f{ Ewents f

Figure 6.39 Displayed Contents of the [Status] Window

Refer to the [Watch] window for the value of variable i. The value is 4, indicating that the break occurred after
the condition had been satisfied five times.

Note: Theitemsthat can be displayed in this window differ depending on the product. For the items that can be
displayed, refer to section 8, Software Specifications Specific to This Product, or the online help.

Remove the event point. Clicking the right-hand mouse button on the [Event] window displays a popup menu.
Select [Remove All] from this menu to remove al event points.
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6.16 Trace Functions

The trace functions of the emulator use the realtime trace buffer, which is able to store the information on up to
32,768 bus cycles. The content of this buffer, which is constantly updated during execution, is displayed in the
[Trace] window.

Select [Trace] from the [Code] submenu of the [View] menu to display the [Trace] window.

T =I0i=
BB @ | & |f
PTR Address | Instruction Data R/W Acrea  Status Clock  Probes | WMI | TRQS5-0 | Timestamp  Timestamp-Diffecence Source Lebel

Figure6.40 [Trace] Window

When trace information is displayed in the [Trace] window, clicking the right-hand mouse button on the [Trace]
window displays a popup menu. Select [Clear] from this menu to clear the trace information.

The following sections give an overview of the trace functions and methods for setting them.
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6.16.1 Displaying a Trace (when Time Stamping is not Available)

The method used to specify an address as an event condition for the tracing of read/write cycles and display the
trace is described below.

(1) Clicking the right-hand mouse button on the [Trace] window displays a popup menu. Select [Acquisition...]
from this menu to display the [Trace Acquisition] dialog box.

Trace Acquisitio ﬂll

General |St0p | Delayed Stop

—Suppress—————— Time Stamp
V' Free Trace
LClock:

I” DIC Cycles [Disabled -

" Refresh Cycles

— Trace Event

Exwent:
add.. | Edi Sequence.. Defe || pean |

()8 I Cancel

Figure6.41 [TraceAcquisition] Dialog Box
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(2) Register an address as an event condition for trace acquisition. Click the [Add...] buttonin the [Trace
Events] group box on the [General] page to display the [Breakpoint/Event Properties] dialog box.

21 %]
General | Bus / Avea | Signak | Action |
— Type Addre
- groét;;are " Daon't Care ™ Addresz € Range
Address Lo [H'00000000
Address Hi' 00000000
I™ Gutside Fange
— Data Compare Direction——
[ Compare I~ Use b ask " Read
Lz IHID  wiite
& Bpte. € Wiord
bask IH'D & Either
’TI Canicel

Figure 6.42 [Breakpoint/Event Properties] Dialog Box

(3) Use the [Editor] window to refer to the address on the line that has ‘a[i]=j;’ withinthe tutorial function
and enter this addressin the [Address L o] edit box of the [Address| group box on the [General] page of the
[Breakpoint/Event Properties] dialog box. In this example, enter H' 00001 05c¢. This address has thus been
set. Click the [OK] button to close the [Breakpoint/Event Properties] dialog box.

General | Bus .-’Areal Signalsl Actionl

— Type Addre
- groét;ﬁare " Don't Care ™ Address  Rangs

Address Lo [H00001 05C
& Event Address Hi - [H'00000000

I™ Gutside Fange

—Data Compare Direction——
[~ Compare ™ Use hask " Read
Lae IHID © wite
& Bute € Wod
Mask |H'D &+ Either

(1]4 I Cancel |

Figure 6.43 [Breakpoint/Event Properties] Dialog Box (after Setting an Event)
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(4) The event that has been set is now displayed in the [Event] combo box of the [Trace Events] group box on
the [General] page of the [Trace Acquisition] dialog box.

Trace Acquisition 2x|

General IStop | Delayed Stopl

—Suppress—————— Time Stamp

¥ Free Trace
[~ DMAC Cycles Clock:

[~ DIC Cycles IDisabIed 'I

[" Befresh Cycles

— Trace Ewvent:
Ewent:
|3 (R) H'105C address =]
Edit... Sequence... Delete | Dl Al |
oK | Cancel |

Figure6.44 [TraceAcquisition] Dialog Box (Adding an Event)
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(5) To enable the event condition that has been set, uncheck the [Free Trace] check box on the [General] page.
Thiswill add pages[1] to [4] to the [Trace Acquisition] dialog box.

Acquisition ﬂﬂ
Gereral |Stop | DelyedStop| 1 |2 |2 |4 |
—Suppress——————— Time Stamp

[~ DMAC Cypcles Clock:

[~ DIC Cycles I Dizabled i l

[ Befresh Cycles

— Trace Event:
Ewent:
|3 [R) H'105C address =l
add. | Edi. Sequence... Dete | Delal |

Ok I Cancel |

Figure6.45 [Trace Acquisition] Dialog Box (Pages Added)
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(6) Select page[1] and click the [Range] radio button in the [Conditions] group box. Thiswill display the [Range
Event] combo box and the [Edit...] button.

el
General I Stop I Delayed Stop 1 |2 I 3 I 4 I

r— Condition

€ Dizabled ¢ Paint to Point

Fange Event

Ok I Cancel |

Figure6.46 [Trace Acquisition] Dialog Box (Displaying Page [1])
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(7) Select the event you have registered from the [Range Event] combo box. The event is now enabled. Click the
[OK] button to complete the trace setting.

2=
General | Stop | Delayed Stop 1 |2 | 3 I 4 I

r Conditions

" Dizabled " Paint to Paint % Range " Event

Rangs Event Edit.. |

oK I Cancel |

Figure 6.47 [Trace Acquisition] Dialog Box (Setting Completed)

(8) Make the setting such that the break occurs after the instruction at the address on the line that has ‘ &[i]=j;’
withinthe tutorial function (H20000105c in thisexample) has been executed five times (for details on
this, refer to section 6.15.2, Breaking Execution at Event Points).

(9) Select [Reset Go] from the [Debug] menu. Processing stops when the break condition is satisfied, and the
[Trace] window then displays the following content.

- Gener

¢ Trace =1ol x|
2|7 BDE|E | |0
PTR | Address | Instruction | Daba | R/W | Area | Stabus | Glock | Frobes | NMI | IRg5-0 | Source [ zabel |
-00004 001055  EXTS.h  ER4  17F4 RD  ROM  FROG 1 i1 1 111111 alt] = 35
-00003 001050  EXTS.L  ER4  17£4 RO ROM  PROG 1 11 1 111111 ali] = 1;
-00002 001055  EXTS.L  ER4  17f4 RD  ROM  FRGG 1 i1 1111t ali] = 3;
00001 001050  EXTS.L  ER4  17f4 RD ROM  FROG 1 1111111 ali] = 97
D000 001056 T, F 1 T 111111 ;

Figure6.48 [Trace] Window (Displaying the Result)

If you have trouble viewing a column, drag the header (vertical) bars below the title bar to adjust the width
of the column.
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(10) Remove the event points that have been set and clear the trace information. Click the right-hand mouse
button on the [Event] window to display a popup menu. Select [Delete All] from this menu to remove all of
the event points that have been set. Click the right-hand mouse button on the [ Trace] window to display a
further popup menu. Select [Clear] from this menu to clear the trace information.

6.16.2 Displaying a Trace (when Time Stamping is Available)

The following procedure is for obtaining and displaying, with time stamps, trace information on cycles of
writing to memory locations in the specified address range.

(1) Clicking the right-hand mouse button on the [ Trace] window displays a popup menu. Select [Acquisition...]
from this menu to display the [Trace Acquisition] dialog box (see figure 6.41, [ Trace Acquisition] dialog
box).

(2) Register the address range for trace acquisition as an event condition. Click the [Add...] button in the [Trace
Events] group box on the [General] page to display the [Breakpoint/Event Properties] dialog box (see figure
6.42, [Breakpoint/Event Properties] dialog box).

(3) Click the [Range] radio button in the [Address] group box on the [General] page of the [Breakpoint/Event
Properties] dialog box. Use the [Locals] window to refer to the address on the line where variable a, which is
defined within the tutorial function, isallocated (H”00FFEF80 in this example) and enter this address
in the [Address L o] edit box. Then enter an address, which is H’ 27 added to that entered in the [Address Lo]
edit box (H” 00FFEFA7 in this example), in the [Address Hi] edit box. This procedure sets the memory
range for variable a of the tutorial function.

(4) Click the [Write] radio button in the [ Direction] group box to set awrite cycle for the specified range. This

completes the setting of a memory range. Click the [OK] button to close the [Breakpoint/Event Properties]
dialog box.

21|
General | Bus .-’Areal Signalsl Actionl
— Type Addre
- R " Don't Care  Address * Range
Breat: Address Lo [HOOFFEFS0
% Event Address Hi- [ I0FFEFA7
[ Cutside Range
—Data Compare Direction——
[~ Compare ™ Use hask " Read
UET IH'D
& Bute € Wod
Mask |H'D = Either
(1]4 I Cancel |

Figure 6.49 [Breakpoint/Event Properties] Dialog Box (after Setting an Event)
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(5) The event that has been set in the [Event] combo box of the [Trace Events] group box on the [General] page

of the [Trace Acquisition] dialog box is displayed.

2] x|
General |St0p I Delayed Stop
— Suppress Time Stamp
V' Free Trace
I~ DMAC Cycles Clock:
I” DIC Cycles [Disabled ~|
" Refresh Cycles
— Trace Event
Exwent:
|3 [R) HFFEFB0 range to HFFEFAT wiite =l
Edit... Sequence... Delete | Drel All |
oK | Cancel |

Figure6.50 [TraceAcquisition] Dialog Box (Adding an Event)

(6) To enable time stamping, select 125ns from the [Clock] combo box of the [Time Stamp] group box.

Trace Acg 2=l
General |St0p I Delayed Stop
— Suppress Time Stamp
V' Free Trace
I~ DMAC Cycles Clock:
I DIC Cycles
" Refresh Cycles
— Trace Event
Exwent:
|3 [R) HFFEFB0 range to HFFEFAT wiite =l
sdd. | Edt. Sequernce.. Delste | Delal |
’TI Cancel |

Figure6.51 [TraceAcquisition] Dialog Box (Time Stamping is Available)
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(7) To enable the event condition that has been set, uncheck the [Free Trace] check box on the [General] page.
Thiswill add pages[1] to [4] (seefigure 6.45, [Trace Acquisition] dialog box).

(8) Select page[1] and click the [Range] radio button in the [Conditions] group box. Thiswill display the [Range
Event] combo box and the [Edit...] button (see figure 6.46, [ Trace Acquisition] dialog box).

(9) Click the [Range Event] combo box to select the event you have registered. The event is now enabled. Click
the [OK] button to complete the trace setting.

Trace Acquisition llll
General | Stop | Delayed Stop 1 |2 | 3 I 4 I

r Conditions

" Dizabled " Paint ko Paint ¥ Range " Event

Range Ewvent Edit... |

3 [R] H'FFEFB0

Ok I Cancel |

Figure6.52 [Trace Acquisition] Dialog Box (Setting Completed)

(10) Make the setting such that the break occurs after the instruction at the address on the line that has ‘p_sam-
>s0=g[0];" withinthe tutorial function (H-00001082 in this example) (for details on this, refer to
section 6.15.1, Software Break Function).
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(11) Select [Reset Go] from the [Debug] menu. Processing stops when the break condition is satisfied, and the
[Trace] window then displays the following content.

=10y
5| & |E®E|E ||
PTR ‘ AddIESSTI. | Data ‘ B/ ‘ A‘ Sl CI Pl 1\1 I| Timestamp TJJ!IEStEmp—DJLffEIEnDE | Sﬂu[;l

-00012 ffefie 41lch WR
-00011 ffefdd 0000 WR
-00010 ffef9sz 3fid4 WR
-00009 ffefdd 0000 WR
-00008 ffef96 2781 WR
-00007 ffefd8 0000 WR
-00006 ffef9a lefh WR
-00005 ffeflc 0000 WR
-00004 ffefSe 1672 WR
-00003 ffefal 0000 WR
-00002 ffefaZ 15fkh WR
-00001 ffefad 0000  WR

0 ffefab

0000h000rmin000=001ms08 1us875ns
0000h000min000s001m=084us125ns
0000h000rmin000=00 1ms08 4us2 50ns
0000h000min000s00 1m=03 6us3?5ns
0000h000rmin000=00 1ms08 busS00ns
0000h000min000s00 1m=088 us750ns
0000h000min000=001ms088 us875ns
0000h000min000s00 1ms03 1us000ns
0000kh000min000=001m=081us125n0s
0000h000min000s001ms093 us375ns
0000kh000min000s001ms093us375n0s
0000h000min000s00 1ms095us 62 5n:

ns

0000h000min000s000ms000us000ns
0000h000min000s000ms002us2 S0ns
0000h00Dmin000s000ms000us12 Sns
0000h000mind00s000ms002us12 Sns
0000h00Dmin000s000ms000us12 Sns
0000h000min000s000ms002us2 S0ns
0000h00Dmin000s000ms000us12 Sns
0000h000min000s000ms002us12 5ns
0000h000win000s000ms000us12 Sns
0000h000min000s000ms002us2 50ns
0000h000win000s000ms000us000ns
0000h000min000s000ms002usz 50ns

Figure 6.53 [Trace] Window (Displaying the Result)

If you have trouble viewing a column, drag the header (vertical) bars below the title bar to adjust the width

of the column.

(12) Remove the event points that have been set and clear the trace information. Clicking the right-hand mouse
button on the [Breakpoints] window displays a popup menu. Select [Delete All] from this menu to remove
al the event points that have been set. Clicking the right-hand mouse button on the [Trace] window
displays a further popup menu. Select [Clear] from this menu to clear the trace information. To disable time
stamping, select Disabled in the [Clock] combo box of the [Time Stamp] group box on the [General] page

of the [Trace Acquisition] dialog box.
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6.16.3

Statistics

The number of times the internal RAM has been written to can be included in the acquired trace information.

(1) Makethe setting such that a break occurs at the address on the line that has ‘ p_sam->s0=g[0];’ within the
tutorial function (H200001082 inthisexample) (for details on this, refer to section 6.15.1, Software

e
(©)

Break Function).

Select [Reset Go] from the [Debug] menu. Processing stops when the break condition is satisfied, and the

[Trace] window then displays trace information.

Select [Statigtic...] from the popup menu that is displayed when you click the right-hand mouse button on
the[Trace] window. A message box appears, indicating that the trace data is being loaded, and the

[Statistic] dialog box will be displayed.

160

Statistic 2l
— Statistic Analysi
Seb
Item |<N0ne> j
Start : I
Hesult |
End I
[Clear, |
Fesult :
Condition | Amount | FTR
I I I
LCloze |
Figure6.54 [Statistic] Dialog Box
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(4) Select R/W in the [Item] combo box and enter WR in the [Start] edit box. After that, click the [New] button.
“R/IW=WR” is now displayed in the [Condition] column of the [Result] list box.

Statistic 21
— Statistic Analysi
& Default ©© Fange et
Item - IH,’W’ j
Start : IWH
Eesult |
End :I
Clear |
Result :
Condition | Amount | FTR
K [ i
LCloze |

Figure6.55 [Statistic] Dialog Box (New Condition)
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(5) Then, select Areafrom the [Item] combo box and enter RAM in the [Start] edit box. After that, click the
[Add] button; the new condition is now added to the “R/W=WR"” display in the [Condition] column of the
[Result] list box, so that it now shows“R/W=WR & Area=RAM". This completes setting of the condition.

Statistic 2]

— Statistic Analysi
& Default ©© Fange

Itern IArea j

Start - IHAM

End :I

Fesult :

Condition | Amount | FTR
RAW=wWH & Area=RaM

I I I
LCloze |

Figure6.56 [Statistic] Dialog Box (Condition Added)
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(6) To start statistical analysis of the specified condition, press the [Result] button. The number of write
operations that satisfy the condition and the PTR values will be displayed.

Statistic 21x]
— Statistic Analysi
& Default ©© Fange et
Item IAlea |
Start : IHAM
End I -
Clear |
Result :
Condition | Amount | FTR
RAW=wWR & Area=RAb 1525 09101 -09100,-0909:
K [ i
LCloze |

Figure6.57 [Statistic] Dialog Box (Result of Analysis)

(7) Click the [Close] button to close the [Statistic] dialog box.

(8) Remove the event points that have been set and clear the trace information. Clicking the right-hand mouse
button on the [Event] window displays a popup menu. Select [Delete All] from this menu to remove all the
event points that have been set. Clicking the right-hand mouse button on the [Trace] window displaysa
further popup menu. Select [Clear] from this menu to clear the trace information.
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6.16.4  Function Calls
This mechanism is used to only collect trace information on the function calls.

(1) Makethe setting such that a break occurs at the address on the line that has ‘' p_sam->s0=g[0];’ within the
tutorial function (H”00001082 inthisexample) (for details on this, refer to section 6.15.1, Software
Break Function).

(2) Select [Reset Go] from the [Debug] menu. Processing stops when the break condition is satisfied, and the

[Trace] window then displays trace information.
(3) Select [Function Call...] from the popup menu displayed by clicking the right-hand mouse button on the
[Trace] window. The [Function Call Display] dialog box will be displayed.

ed B3

Setting

Enable to dizplay trace information with function
call only ¢

" Enable

ok | Lancel |

Figure 6.58 [Function Call Display] Dialog Box

(4) Click the [Enable] radio button and then the [OK] button. Only the information on function callsis now
displayed in the [Trace] window (the [Label] column’s right-side boundary has been moved to theleft in the
[Trace] window to show the function calls).

=lolx|
B | E@E|E ||
Tabel [Pt | Address | Tnstrustion | pata | R/W | Area| status | ¢lock| Probes| mu1 | 1RQS
PowerOl_Reset () -09108 000400 MOV.T. #H'DOFFEFCO,ER7 7207 RD  ROM  PROG 1 1111 1 1111
_mmin -03562 001034  BSR @cutorial{}:8 5502 RD  ROM PROG 1 11 1 11l
tutorisl() 03578 001038 MOV.T. ER3,@-ERT 0100 RD  ROM  PROG 1 1 1 111
Sample: :Sample [} -0355% 002000 MOV.L ERZ, @-ERT 0100 RD ROM PROG 1 111 1 1
_sbrk 03368 001000 STM.T. (ERZ-ER3),@-5P D110 RD ROM PROG 1 1 1 111
Seample::sort(long *)  -01667 D0Z068  STM.L (ERI-ER3},6-5P 0110 RD ROM PROG 1 11111 1111
Sample: :changs [long *] |-D0469 00Z0d6 MOV, ER3, @ BET 0100 1 T
< | |

Figure6.59 [Trace] Window (Function Calls)

(5) Toreturnthe display in the [Trace] window to its previous state, follow the procedurein (3) to display the
[Function Call Display] dialog box. Click the [Disable] button and then the [OK] button.

(6) Remove the event points that have been set and clear the trace information. Clicking the right-hand mouse
button on the [Breakpoints] window displays a popup menu. Select [Delete All] from this menu to remove
all the event points that have been set. Clicking the right-hand mouse button on the [Trace] window displays
afurther popup menu. Select [Clear] from this menu to clear the trace information.
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6.17 Stack Trace Function

The emulator uses the information on the stack to display the function call history.

Notes: 1. Thisfunction can be used only when the load module that has the Dwarf2-type debugging
information isloaded. Such load module is supported in H8S, H8/300 C/C++ compiler V4.0 or later.
2. For details on the stack trace function, refer to the online help.

e Double-click the[Editor] columnin the sort function and set a software breakpoint.

25 00zZ068
26 oozovo
27
28
29
30 00z072
31 00z07a
32 oozovs
33 00zZ07e
a4 0o0z0s0
35 00zZ054
36

37 00Z0a4
3B 00Z0a8
39
40
41
42
43
44
45 00z0cO
46
47 O0Z0ce

<1 |

volid Sample::sortilong *a)
{

long tr

int i, 3, k, gap:

gap = 5;
whilef gap > 0 )4
for( k=0; k<gap; k++){
for | i=k+gap; i<10; i=i+gap )4
for (j=i-gap; Jjr=k: j=j-gap){
if (al3l=ali+gap]l ) {
t = alil:
alj]l = al[j+gap]:
a[j+tgap] = t:
}
elze
hreak:

gap = gapf2:

= gotopp l

Figure6.60 [Editor] Window (Software Breakpoint Setting)

o Select [Reset Go] from the [Debug] menu.
o After the break in program execution, select [Stack Trace] from the [Code] submenu of the [View] menu to

open the [Stack Trace] window.
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=101 x|

| Value |
F Sample: :sort{long *) { 002084 }
F tutorial () { 001072 }
F main i} { 001036 }
F PowerON Reset () { DOO41E }

Figure6.61 [Stack Trace] Window

Figure 6.61 shows that the position of the program counter is currently at the selected line of the sort ()
function, and that the sort () functioniscalled fromthe tutorial () function.

To remove the software breakpoint, double-click the [Editor] column in the sort function again.
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6.18 Performance M easurement Function
Performance measurement by the emulator isin the following modes:

e  Time Of Specified Range Measurement

e  Start Point To End Point Measurement

e  Start Range To End Range Measurement

e Access Count Of Specified Range Measurement
e  Called Count Of Specified Range Measurement

In thistutorial, we describe the Time Of Specified Range Measurement.

6.18.1 Time Of Specified Range M easurement

(1) Select [Performance Analysis] from the [Performance] submenu of the [View] menu to display the [Select
Performance Analysis Type] dialog box.

Perfarmance Analysis: EGO00 Perfarmance &ns

Cancel

Figure 6.62 [Select Performance Analysis Type] Dialog Box

(2) Select “E6000 Performance Analysis’ from the [Performance Analysis] combo box in the [Select
Performance Analysis Type] dialog box and click the [OK] button. The [Performance Analysis] window will
be displayed.

(ol x|
* % |
Ho I\Tsmel Condition ‘ RatEl RUN-TIME MAX-MIN-TIME Count 0---10---20---30
1
2
3
4
3
3
5
8
4 | |
Figure 6.63 [Performance Analysis| Window
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(3) Select the line of the [Performance Analysis] window that has 1 in its [No] column and click the right-hand
mouse button to display a popup menu. Select [Set...] from this popup menu to display the [Performance
Analysis Properties] dialog box.

Performance Anal ‘rapetties

Meazurement Method PAT:

Range Name : IPM
Range

Start Address : IH'DDDDDDDD _I
End Address H'00000000

— Common Settings of Performance(PA1-8]

Address Control Mode: Prefetch Settings... |
Time Measurement Unit: 160ns
Cancel |

Figure 6.64 [Performance Analysis Properties] Dialog Box

(4) Select Time Of Specified Range Measurement from the [Measurement Method PA 1] combo box.
(5) The parameter settings are as follows.

Enter “sort” in the [Range Name] edit box.

Click the[...] button to the right of the [Start Address] edit box to display the [Input Function Range]
dialog box. Enter the function name “ Sample::sort (long *)” in the [Function] edit box of this dialog box
and then click the [OK] button. The corresponding addresses for the function “ Sample::sort (long *)”
will now be set in the [Start Address] and [End Address] edit boxes.

Input Function Range il il

Function
|Samplezzartilong *) Cancel |

Note:
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Figure6.65 [Input Function Range] Dialog Box

The addresses figured out in the [Input Function Range] dialog box are just for reference. In some cases,
the end address of a function may be different. Check the last instruction of the function in the
[Disassembly] window to correct the value set in [End Address] so that it will be the address of the last
instruction (in general, the last instruction of afunction isaRTSinstruction). A label name or an
expression can be entered instead of an address value in boxes where an address should be entered.
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(6) Click the [Settings...] button in the [Common Settings of Performance(PA1-8)] group box to display the
[Common Settings of Performance(PA1-8)] dialog box. Select [PC] from the [Address Control Mode] combo
box and then click the [OK] button. PC is now displayed in the [Address Control Mode] text field of the
[Common Setting of Performance(PA1-8)] dialog box.

Carmmao ok a il il
Address Control Mode b
Time Measurement Unit I 160ns j Cancel |

Figure6.66 [Common Setting of Performance(PA1-8)] Dialog Box

(7) Click the [OK] button to display the content that has been set for line 1 of the [No] column in the
[Performance Analysis] window. This completes the settings for a Time Of Specified Range Measurement.

=10l x|
No Neme | Condition ‘ RatEl RUN-TIME MAX-MIN-TIME Count 0---10---20---30
1 pal Range H'00002062 H'0O0020D4 0% 00h 00min 00s 000ms 000Ous 000ns [ul
2
3
4
a5
[3
-
g
4 I |

Figure 6.67 [Performance Analysis] Dialog Box (Setting Completed)

(8) Set an event point at the address on the line that has ‘ p_sam->change(a);” withinthe tutorial function
(H70000107 inthisexample) so that a break occurs when the specified sort function has been executed
three times (refer to section 6.15.2, Breaking Execution at Event Points).

(9) Select [Reset Go] from the [Debug] menu. Processing stops when the break condition is satisfied, and the
[Performance Analysis] window then displays the information shown below. The value shown in the [Count]
column is 3, which indicates that the sort function has been executed three times and the execution time.

-0l x|
* = *H ‘ o
To Name‘ Condition ‘ Ratel RUN-TIME MAX-MIN-TIME | Count | O---10---20---30
1 pal Range H'00002Z0&8 H'0000Z0D4 19% 00h O0win 00s 000ms 35Zus 480ns 3 HesRAHEEE
2
3
4
5|
[3
-
a
4 | 0|

Figure 6.68 [Performance Analysis| Dialog Box (Displaying the Result)

(10) Delete the setting for performance analysis and remove the event point. Click the right-hand mouse button
on the [Performance Analysis| window to display a popup menu. Select [Reset All] from this popup menu to
delete all of the settings. Clicking the right-hand mouse button on the [Event] window also displays a popup
menu. Select [Delete All] from this popup menu to remove al the event points that have been set.
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6.19 Monitor Function

The emulator allows monitoring of the content of specified addresses in memory during execution of the user
program. In this example, we monitor the content of the address range where variable a of the tutorial
function is stored.

(1) Select the [CPU] submenu from the [View] menu. Then selecting [Monitor Setting...] from the [Monitor]
submenu displays the [Monitor Setting] dialog box.

21 %]
tdonitar Setting |
Marne : |monitor‘|
r Optiary
Address
Size [byte]: [Hronz0 4|
Accesz Format) : IBYTE [ASCI) ﬂ

v Zuto-Refresh at rate (ms) ; ID'DDEDD

¥ Reading the Initial % alue

r— Color
Chanae Indicatar ; IChange j
Foreground : _I'I Background I:II'I
|l Ei
r Detail
|DETAIL MOT SUPPORTED! Dietail... |
— Histom

| =
QK I Cancel |

Figure6.69 [Monitor Setting] Dialog Box
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(2) Set theitemsin the [Monitor Setting] dialog box as follows:

Note:

Enter monitorl in the [Name] edit box.
Set the parametersin the [Options] group box as follows:
(a) Usethe[Locals] window to refer to the address on the line where variable a, which is defined within

thetutorial function, isalocated and enter this addressin the [Address] edit box. In this example,
enter H” 00FFEF80.

(b) Enter H”50 in the [Size] edit box.
(c) Select BYTE (HEX) from the [Access| combo box.
(d) Check the [Auto-refresh at rate] check box and enter b/ 00500.
(e) Check the[Reading the Initial Value] check box.
Set the parameters in the [Color] group box as follows:
(a) Select Change from the [Change Indicator] combo box.
(b) Select red and white in the [Foreground] and [Background] combo boxes, respectively.
(c) Check the [Mayfly] check box.

=

Depending on the operating system in use, the foreground and background colors may not be selectable.

21 %]
tdonitar Setting |
Mame : |monitor‘|
— Option
fddress [HFFEFED [
Size [byte]: [0 4|
Access [Format) : IBYTE [HEX) ﬂ

v Zuto-Refresh at rate (ms) ; ID'DDEUD

v Reading the Initial % alue

r Calar
Chanae Indicatar ; IChange j
Fareground : _I'I Background I:II'I
v bayfly
r Detail
IDETAIL MOT SUPPORTED! Detail... |
— History

| [
ok, I Cancel |

Figure6.70 [Monitor Setting] Dialog Box (Setting Completed)
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(3) Click the [OK] button to open the [Monitor] window.

~#-rnonitor: ronitorl - FFEFE0 _|- _|E| 5'
# 2 |[1e =]|[eveHen =]

Address | +0 | +1| +2| 3| +a| +5| +6| +7| +a| vo] w2 t8| +c| 40| +E| 47|
FFEFE0 00 00 13 72 00 00 28 47 00 00 2Zc 67 00 00 33 59
FFEFO0 00 00 42 87 00 00 4p aa 00 00 50 OF 00 00 64 88
FFEFA0 00 00 69 S6 00 00 75 66 00 02 12 24 00 00 3a &

FFEFED 5y 70 00 00 OO O1 B0 74 00 OO0 10 36 00O 00 04 1E
FFEFCO 6 18 6A 18 6A 18 eBA 18 6A 18 cA 18 ecA 18 BA 18

Figure6.71 [Monitor] Window

(4) Select [Reset Go] from the [Debug] menu. When the content of the address range changes with execution,
the updated values are red (i.e. the color that was selected in the [Foreground] and [Background] combo
boxes). Values will be displayed in black if they have not been updated or a certain period of time has
elapsed since the last update.

wi-rnonikbor: moniborl - FFEFS0 i ] 4|

B 2[5 =]|[sueten =]

00515ms | 40| +1| +2| +3 | +a| +5) +6| +7| 48| 49| +a| 8| +c| 40| +E| +F |
FFEFS0 00 00 60 57 00 00 67 ES OO0 OO0 4C¢ 7F 00 00 3B EE
FFEFO0 00 00 30 c¢E 00 00 2F 95 00 OO0 2& &0 00 OO0 09 40
FFEFA0 00 00 02 E# 00 00 01 &l 00 0z 12 24 00 OO0 &Aa AR
FFEFED 57 O OO 0O 00 01 &0 74 0D OO 10 36 00 00 04 1E
FFEFCO  6a 18 6a 18 6a 18 6a 18 63 18 6a 18 6a 18 6 18

Figure6.72 [Monitor] Window (during Execution)

(5) After you have finished checking the states in the [Monitor] window, select [Halt Program] from the [Debug]
menu to halt the program’ s execution.

6.20 What Next?

Thistutorial has described the major features of the emulator and the use of the High-performance Embedded
Workshop.

Sophisticated debugging can be carried out by using the emulation functions that the emulator offers. This
provides for effective investigation of hardware and software problems by accurately isolating and identifying
the conditions under which such problems arise.
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Section 7 Hardware Specifications Specific to This Product

This section describes the hardware specifications on the H8S/2633 E6000 emulator.

7.1 H85/2633 E6000 Emulator Specifications

The H8S/2633 E6000 emulator supports the system development using the following microcomputers:

e H8S/2643 group

e H8S/2633 group, H8S/2633R, and H8S/2695
e HB8S/2626 group and H85/2623 group

e H8S/2238 group

e H8S/2237 group and H8S/2227 group

e H8S/2258 group
7.11 Supported MCUs and User System Interface Cables

If emulation is performed for the H8S/2626 group and H8S/2623 group, an option board (HS2623EI1061H) is
required.

If emulation is performed for the IEBus™* in the H8S/2258 group, an option board (HS2258E1061H) is
required.

Note: IEBus™ (Inter Equipment Bus™) is atrademark of NEC Corporation.
For notes on option boards, refer to the user’s manual provided for them.

See the devel opment support tool catalog for the MCU type names and packages supported by the E6000
emulator and for the combination of the E6000 user system interface cables and optional boards.

7.12 Operating Voltage and Frequency Specifications

Table 7.1 shows the MCU operating voltage and frequency specifications supported by the E6000 emulator. If
the emulator is used in an environment that exceeds the operating voltage range and operating frequency range
guaranteed for the MCU operation, normal emulator operation is not guaranteed.
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Table7.1 Operating Voltage and Frequency Specifications

Operating Voltage (V) Maximum Operating
No. MCU Types Voo PVee Frequency () (MHz)
1 H8S/2643 group 3.0-3.6 4.5-55 25
2 H8S/2633 group 3.0-3.6 3.0-4.5 20
3.0-3.6 45-55 25
3 H8S/2633R — 4.5-55 28*
H8S/2695
4 H8S/2626 group 3.0-3.6 4.5-55 20
H8S/2623 group
5 H8S/2238 group 2.7-3.6 — 135
6 H8S/2237 group 2.7-3.6 — 6.25
H8S/2227 group 2.7-3.6 — 13.5
7 H8S/2258 group 4.0-5.5 — 135

Note: Only the HS2633REPI61H can support the frequency up to 28 MHz. The maximum frequency supported
by the HS2633EPI61H is 25 MHz. group

NOTE

For details on the operating voltage and frequency specifications,
refer to the MCU hardware manual.

7.2 User System Interface

All user system interface signals are directly connected to the MCU in the emulator with no buffering except for
those listed below which are connected to the MCU through control circuits:

e NMI

e RESET

e MD2, MD1, MDO
o XTAL

e EXTAL

o WAIT

721 Signal Protection

All user system interface signals are protected from over- or under-voltage by use of diode arrays except for the
AVcc and Vref.

Pull-up resistors are connected to the port signal's except for the analog port signals.

The PVcc signals (except for AVcc signals) at the head of the user system interface cable are connected together,
which is monitored by the emulator to detect whether the user system hardware is connected.
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722 User System Interface Circuits

The interface circuit between the MCU in the emulator and the user system has a signa delay of about 8 ns due
to the user system interface cable and it includes pull-up resistors. Therefore, high-impedance signals will be
pulled up to the high level. When connecting the emulator to auser system, adjust the user system hardware to
compensate for propagation delays.

The following diagrams show the equivalent circuit examples of the interface signals.

Default:

OPVce

47 kQ
47 Q)
MCU MN O User system
é interface cable

Figure7.1 Default User System Interface Circuit

Mode Pins (M D2, MD1, and MDO): The mode pins are only monitored. The CPU mode depends on the High-
performance Embedded Workshop settings.

PVcc
47 kQ
Emulator 47Q
control mn—————-~0 User system
circuit é interface cabled

Figure7.2 User System Interface Circuit for Mode Pins

RESET and NMI: The RESET and NMI signals are input to the MCU through the emulator control circuit. The
rising/falling time of these signals must be 8 ns/V or less.

Emulator 74HC14
control
circuit

O User system
interface cable]

Figure7.3 User System Interface Circuit for RESET and NMI Signals
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ANOto AN15, DAOto DAL, AVcc, AVss, and Vref:

AVce
MCU ANO-AN15, User system
DAO-DA1 interface cablel]
T O AVce
N User system
MCU 1 OVIel i terface cable

Figure7.4 User System Interface Circuit for ANO to AN15, DAOto DAL, AVcc, AVss, and Vref Signals

IRQO-RQ7 and WAIT: The IRQO to IRQ7 and WAIT signals are input to the MCU and also to the trace
acquiring circuit. Therefore, the rising and falling time of these signals must be within 8 ns/v or shorter.

PVcce

47 kQ
47 Q
MCU é A User system

interface cable]0)

oO-— - — —

47 kQ User system
Trace Emulator 47 Q interface cable
buffer control YWV connected by
circuit é cable head

Figure7.5 User System Interface Circuit for IRQ0O-RQ7 and WAIT Signals
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7.3 Differ ences between MCU and Emulator

When the emulator is turned on or initialized, or the system isreset, there are some differencesin the initial

vauesin some of the general registers between the MCU and the emulator as shown in table 7.2.

Table7.2 Initial Value Differences between MCU and Emulator

Status Register E6000 Emulator MCU
Power-on/ PC Reset vector value Reset vector value
initialized EROto ER6  Undefined Undefined
ER7 (SP) H'10 Undefined
CCR The | mask is set to 1 and the The | mask is set to 1 and the

other bits are undefined

other bits are undefined

Reset command PC Reset vector value Reset vector value
EROto ER6  Undefined Undefined
ER7 (SP) H'10 Undefined

CCR The | mask is set to 1 and the
other bits are undefined

The | mask is set to 1 and the
other bits are undefined

731 A/D Converter and D/A Converter

Due to the use of a user system interface cable, thereis a slight degradation in the A/D and D/A conversion than

that quoted in the Hardware Manual for the MCU being emulated.
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Section 8 Software Specifications Specific to This Product

This section describes the software specifications of the H8S/2633 E6000 emul ator.

8.1 Softwar e Specifications of the H8S/2633 E6000 Emulator

Information specific to this emulator is given below.

811 Target Hardware

This emulator software conforms to the H8S/2633R E6000 (HS2633REPI61H) and H8S/2633 E6000
(HS2633EPI61H) emulators.

8.1.2 Selectable Platform

The debugging platforms selectable in this emulator are listed below. The MCUs that can be emulated vary
according to the debugging platform selected.

Table8.1 Selectable Target Platforms

Debugging Platform Remark

E6000 H8S/2237 Emulator CPU 2000  For emulation of the MCUs that have the H8S/2000 CPU as the
core.

E6000 H8S/2633 Emulator CPU 2600  For emulation of the MCUs that have the H8S/2600 CPU as the
core.
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8.13 [Configuration Properties] Dialog Box ([General] Page)

Items that can be set in this dialog box are listed below.

nfiguration Properties e |
General |
B Uzer Signals
L= ¥ User Beset enable
Mode: I? [advanced made, single chip) j [¥' User Nl enable
B ™ WUser Standby enable
ng i V¥ User Bus Feguest enable
Clock:  [Mair10MHz, Sub:32kHz =l
Timer R esolution: I‘I25ns j

Flazh temary Contral; I vl

v Enable read and write on the fly
¥ Break on access emor
[" Enable intemal ROM area wite

User VCC Theshold = 4.00v 4 | Il o

Driver: |EEDDD USE Driver
ml Change driver in start up

ak I Cancel |
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Figure8.1 [Configuration Properties| Dialog Box ([General] Page)
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[General] page

[Device] Selects the MCU to be emulated. To use an MCU not included in the list,
select [Custom] to specify the functions required for this MCU. See the
hardware manual for details.

[Mode] Selects the MCU's operating mode.

[Clock] Selects the speed of the MCU'’s clock and sub-clock.

[Timer Resolution]

Selects the resolution of the timer for use in execution time measurement.
The value 20 ns, 125 ns, 250 ns, 500 ns, 1 us, 2 us, 4 us, 8 us, or 16 us
can be selected.

The timer for execution time measurement has a 40-bit counter.

At 20 ns the maximum time that can be measured is about six hours, and
at 16 ps the maximum time is about 200 days.

When the counter overflows, the maximum time possible for
measurement will be displayed with prompt “>" that indicates that the
counter has overflowed.

[Enable read and write on the
fly]

When this box is checked, it is possible to access the target system
memory while the user program is running. Do not check this box if you
require realtime emulation.

- When accessing the internal ROM, internal RAM, or emulation memory

High-performance Embedded Workshop accesses the memory directly
as the bus mastership is released to the emulator without breaking the
user program. The MCU waits for approximately 80 us while operating at
25 MHz.

- When accessing the internal I/O, DTCRAM, or user memory

Memory is accessed with breaking the user program. This pause is
approximately 2 ms while operating at 25 MHz.

When the internal RAM is disabled, an access to this area is not available
during the user program execution.

Note:

When the content of the memory is modified during the user program
execution (e.g. modification in the [Memory] window or by the
MEMORY_EDIT command), High-performance Embedded Workshop
reads the content to update the value.

High-performance Embedded Workshop also reads the memory content
when the content has been updated by operations such as selecting
[Memory -> Refresh]. In this case, the content of memory is read and
then updated in each of the windows.

To prevent unnecessary reading of the memory content, close the
window displaying the memory content (such as the [Memory] or
[Disassembly] window) or make the settings so that the content will not
be updated.

The [Monitor] window, or the [Watch] window that satisfies the conditions
listed below displays the memory content. Note that, however, opening
these windows does not prevent realtime operation because the method
of updating the memory content in these windows is different.

Conditions:
1. Registered symbols are only allocated to general-purpose registers.

2. Registered symbols are only allocated to the monitor range set by the
[Monitor] function (the mark R is colored in blue).

3. Registered symbols are comprised of those with the conditions 1 and 2
listed above.
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[General] page (cont)

[Break on access error] When this box is checked, a break (the user program stops) occurs if
your program accesses an access-prohibited area or writes to a write-
protected area.

[Enable internal ROM area write]  When this box is checked, writing to the internal ROM area is enabled.
For the result of writing, see the [Extended Monitor] window.

[User VCC Threshold] Sets the voltage level for the user system. [Down] will be displayed in
[User System Voltage] of the [Extended Monitor] window when the actual
user VCC (PVCC when the E6000 H8S/2633 Emulator CPU debugging
platform is selected) of the target system is lower than the specified
value.

[User Signals] When this box is checked, the reset, NMI, standby, and bus request
signals from the user system are enabled. Note that the standby signal is
always invalid because the hardware standby function is not supported.
However, the status of the signal can be checked in the [Extended
Monitor] window.

[Driver] Displays the E6000 driver that is currently installed.

[Change driver in start up] When this box is checked, selection of a driver will be available next time
the emulator is connected.

The MCUs selectable by the [Device] option and options that depend on the MCUs are listed below. To emulate
an MCU with a description in the Expansion Hardware column, connect the correct expansion hardware.

Table8.2 Environment for the E6000 H8S5/2237 Emulator CPU 2000 Debugging Platform

[Device] Option  [Mode] Option [Clock] Option Expansion Hardware
Custom The MCU previously selected
H8S/2238 4 (advanced mode, 16bit Bus) Main: 10MHz, Sub: 32kHz
H8S/2237 5 (advanced mode, 8bit Bus) Main: 20MHz, Sub: 32kHz
H8S/2236 6 (advanced mode, on-chip ROM) Main: 10MHz, Sub: Target
H8S/2235 7 (advanced mode, single chip) Main: 20MHz, Sub: Target
H8S/2233 Target Main: Target, Sub: Target
H8S/2227 Main: Target/2, Sub: Target
H8S/2225
H8S/2223
H8S/2224
H8S/2258 HS2258EI1061H
H8S/2256 (IEBus™ board)
Notes: 1. Target in [Mode] is only available when the target system is connected.
2. Target and Target/2 in [Clock] are only available when the target system is connected.
3. In the H8S/2258, H8S/2238, H8S/2237, and H8S/2227 group, the maximum operating
frequency of the actual MCU is 13.5 MHz.
4. IEBus™ (Inter Equipment Bus™) is a trademark of NEC Corporation.
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Table8.3

[Device] Option

[Mode] Option

[Clock] Option

Environment for the E6000 H8S/2633 Emulator CPU 2600 Debugging Platform

Expansion Hardware

Custom The MCU previously selected
H8S/2633 4 (advanced mode, 16bit Bus) Main: 10MHz, Sub: 32kHz
H8S/2632 5 (advanced mode, 8bit Bus) Main: 20MHz, Sub: 32kHz
H8S/2631 6 (advanced mode, on-chip ROM) Main: 25MHz, Sub: 32kHz
H8S/2643 7 (advanced mode, single chip) Main: 10MHz, Sub: Target
H8S/2642 Target Main: 20MHz, Sub: Target
H8S/2641 Main: 25MHz, Sub: Target
Main: Target, Sub: Target
Main: Target/2, Sub: Target
H8S/2623 Main: 10MHz HS2623EI061H
H8S/2622 Main: 20MHz (HCAN board)
H8S/2621 Main: Target
Main: Target/2
H8S/2626 Main: 10MHz, Sub: 32kHz
H8S/2625 Main: 20MHz, Sub: 32kHz
H8S/2624 Main: 10MHz, Sub: Target
Main: 20MHz, Sub: Target
Main: Target, Sub: Target
Main: Target/2, Sub: Target
H8S/2633R Main: 10MHz, Sub: 32kHz
Main: 20MHz, Sub: 32kHz
Main: 25MHz, Sub: 32kHz
Main: 10MHz, Sub: Target
Main: 20MHz, Sub: Target
Main: 25MHz, Sub: Target
Main: Target, Sub: Target
Main: Target/2, Sub: Target
H8S/2695 Main: 10MHz
Main: 20MHz
Main: 25MHz
Main: Target
Main: Target/2
Notes: 1. Target in [Mode] is only available when the target system is connected.
2. Target and Target/2 in [Clock] are only available when the target system is connected.
3. In the H8S/2633R and H8S/2695 group, the maximum operating frequency of the actual MCU

is 28 MHz. If clock signals are supplied from the user system, up to 28- and 25-MHz operating
frequencies can be supported in the HS2633REPI61H and HS2633EPI61H, respectively.
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8.14 [Configuration Properties] Dialog Box ([Custom] Page)

Items that can be set in this dialog box are listed below.

iguration Pr 2| x|
General  Custom Device
ROk: [ Enable Flash memary
RaM:  [16kB |
Pt [120/129FiE |
— b odule
¥ Enable DTC ¥ Enable [1D& — &0 Converter—
&
¥ Enable D44 Corveter ™ Enable |IC0 P ;’eg
reg
¥ Enable Refresh Contraller M Enable 1IC1
¥ Enable DMAC W' Enable WDT1 ~ SO Select
¥ Enable TPU35 ¥ Enable TMR2-3 ' 50
 5CI0-2
|7 Enable Pw/hi14 50103
¥ Enable MuliProcesserComurication [SC11-4) & SCI0-4
Ok, I Cancel |

Figure8.2 [Configuration Properties] Dialog Box ([Custom Device] Page)
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[Custom Device] page

[ROM]

Specify the internal ROM area size.
None: -

64kB: Sets the internal ROM area to be 64 kbytes (H’'000000 to
H'00FFFF).

96kB: Sets the internal ROM area to be 96 kbytes (H'000000 to
H'017FFF).

128kB: Sets the internal ROM area to be 128 kbytes (H'000000 to
H'O1FFFF).

192kB: Sets the internal ROM area to be 192 kbytes (H’000000 to
H'02FFFF).

256kB: Sets the internal ROM area to be 256 kbytes (H'000000 to
H'03FFFF).

384kB: Sets the internal ROM area to be 384 kbytes (H'000000 to
H'O5FFFF).

512kB: Sets the internal ROM area to be 512 kbytes (H’000000 to
H'07FFFF).

[RAM]

Specify the internal RAM area size.

2kB: Sets the internal RAM area to be 2 kbytes (H'FFE800 to H'FFEFBF
and H'FFFFCO to H'FFFFFF).

4kB: Sets the internal RAM area to be 4 kbytes (H'FFE000 to H'FFEFBF
and H'FFFFCO to H'FFFFFF).

6kB: Sets the internal RAM area to be 6 kbytes (H'FFD800 to H'FFEFBF
and H'FFFFCO to H'FFFFFF).
8kB: Sets the internal RAM area to be 8 kbytes (H'FFD000 to H'FFEFBF
and H'FFFFCO to H'FFFFFF).

12kB: Sets the internal RAM area to be 12 kbytes (H'FFCO000 to
H'FFEFBF and H'FFFFCO to H'FFFFFF).

16kB: Sets the internal RAM area to be 16 kbytes (H'FFB00O to
H'FFEFBF and H'FFFFCO to H'FFFFFF).
24kB: Sets the internal RAM area to be 24 kbytes (H’FF9000 to
H'FFEFBF and H'FFFFCO to H'FFFFFF).

32kB: Sets the internal RAM area to be 32 kbytes (H'FF7000 to
H'FFEFBF and H'FFFFCO to H'FFFFFF).

[Pin]

Specify the product package.

80/84Pin: Enables ports 1, 4, 7, PAO to PA3, B to D, and PF3 to PF7.
100PinA: Enables ports 1, 4, P70 to P73, PAO to PA3, and B to G.
120/128PinA: Enables ports 1 to 4, 7, PAO to PA3, and B to G.
144PinA: Enables ports 1 to 8 and Ato G.

100PinB: Enables ports 1, 4, 9, and A to F.

120/128PinB: Enables ports 1, 3, 4, 7, 9, PAO to PA3, and B to G.
144PinB: Enables ports 1to 5 and 7 to G.
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[Custom Device] page (cont)

[Modules]

Check this box to validate on-chip peripherals.
Enable DTC: Uses a part of the internal RAM as DTCRAM.

Enable D/A Converter: Displays registers of the D/A converter in the [IO]
window. The D/A converter is always available.

Enable Refresh Controller: Enables the refresh controller.
Enable DMAC: Enables DMAC.

Enable TPU3-5: Enables TPU3 to TPU5. TPUO to TPU2 are always
available.

Enable PWM14: Enables the 14-bit PWM.

Enable MultiProcessorCommunication (SCI1-4):
Uses all SCI channels to support the multiprocessor
communication and the smart card interface. SCI2 is
always used for this support.

Enable IrDA: Enables IrDA.
Enable IICO: Enables 1ICO.
Enable IIC1: Enables IIC1.
Enable WDT1: Enables WDT1.
Enable TMR2-3: Enables TMR2 and TMR3. TMRO and TMR1 are always
available.
A/D Converter: Selects the specifications of the A/D converter.
4reg: 10-bit resolution, four data registers, and conversion time in 134-
state cycles
8reg: 10-bit resolution, eight data registers, and conversion time in 20-
state cycles
SCI Select: Selects the number of SCI channels.
SCI0-1: Enables SCI0 and SCI1.
SCI0-2: Enables SCIO to SCI2.

SCI0-3: Enables SCIO to SCI3.
SCI0-4: Enables SCIO to SCl4.
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8.15 Memory Mapping Function

This emulator supports four blocks of user memory. These can be 256 kbytes or 1 Mbyte each, depending on the
SIMM fitted. Each block can be placed in the address space on a 256-kbyte or 1-Mbyte boundary.

The memory mapping has a granularity of H'40 (D'64) bytes. Each 64-byte block can be set to the emulation
memory or external memory and can be access-prohibited, write-protected or read-write.

Note:  The minimum unit available for mapping is ablock (64 bytes).

8.1.6 [Status] Window

Selecting [View -> CPU -> Status] or clicking the [Status Display] toolbar button displays the [Status] window.
The [Status] window has three sheets. This emulator displays the following items.

(1) [Memory] Sheet
Selecting the [Memory] tab on the [Status] window displays this sheet.

Table83 [Memory] Sheet Items

[Item] Column [Status] Column

Target Device Configuration Displays memory mapping.

System Memory Resources Displays the memory resource of the emulator hardware.
Program Name Displays the program file name.
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(2) [Platform] Sheet

Selecting the [Platform] tab on the [Status] window displays this sheet.

Table8.4 [Platform] Sheet Items

[Item] Column

[Status] Column

Connected To:

Displays emulator name (driver used).

CPU

Displays the target MCU name.

Mode

Displays the selected mode.

Clock source

Displays the selected clock.

Run status

Displays the execution status.
Break: The user program breaks

Running: The user program is running

Cause of last break

Displays the cause of the emulator stopped at a break. If a program
breaks in the sub-active state, '(SubActive)' will be displayed after the
cause of the break.

Ready: User program not executed (immediately after starting the High-
performance Embedded Workshop)

User Break: Break by the user

Software Break: Break by software breakpoint

On Chip Break A: Break by On Chip Break

Complex Event System: Break by complex event system

Stepping Completed: Break by stepping completed

Stepping Aborted: Break by stepping aborted

ROM Write Access Break: Break by writing to ROM

Write-protect Access Break: Break by writing to a read-only memory
Unused Area Access Break: Break by accessing to a guarded memory
Performance Break: Break by Performance Analysis

Invalid breakpoint: Break by a break instruction without Software Break

Event Time Count

Displays the measured result of the timer between events.

Run Time Count

Displays the total execution time of the program.

(3) [Events] Sheet

Selecting the [Events] tab on the [Status] window displays this sheet.

Table85 [Events] Sheet Item

[Item] Column

[Status] Column

Resources

Displays the resource information and the information on events such as
the breakpoint.
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8.1.7 Extended Monitor Function

Selecting [View -> CPU -> Extended Monitor] or clicking the [Extended Monitor] toolbar button displays the
[Extended Monitor] window. This emulator displays the following items.

Table8.6 [Extended Monitor] Window Items

[Item] Column [Value] Column

User Standby Displays the status of the standby pin.

User NMI Displays the status of the NMI pin.

User Reset Displays the status of the reset pin.

User Wait Displays the status of the wait pin (“Inactive” is displayed if no corresponding
pins exist).

User System Voltage Displays whether or not the user VCC (PVCC when the E6000 H8S/2633

Emulator CPU 2600 debugging platform is selected) is equals to or exceeds
the value set by [User VCC Threshold] in [Configure Platform].

User System Voltage2 Displays whether or not the user VCC is supplied (this is only available when
the E6000 H8S/2633 Emulator CPU 2600 debugging platform is selected).

User Cable Displays whether or not the user cable is connected.

Running status Displays the address bus value in the MCU and the status of the CPU while
the user program is running, and the cause of a break while the user program
is halted.

Break = <Cause of break>: Displays the cause of a break.

Address = <Address bus value>:
Displays the address bus value during the user program execution. While in
subactive mode, ‘(SubActive)' is displayed after the address bus value.

Status = <Status of the CPU>: Displays the status of the CPU.

PREFETCH: CPU instruction prefetch cycles
DATA: CPU data access cycles

DMAC: Operation of DMAC

DTC: Operation of DTC

SLEEP: Sleep mode

STANDBY: Standby mode

WATCH: Watch mode

SUBSLEEP: Subsleep mode

REFRESH: Refresh cycles

ROM Write Displays whether or not the ROM has been written to during the user program
execution.

Once the ROM has been written to, the state is retained until the Configure
Platform is set again.

Target Mode Displays the mode to be input from the user system.
Target Clock Displays whether or not there is a clock signal to be input from the user
system.

Note: In this emulator, the update interval in the [Extended Monitor] window cannot be selected or changed.

189
RENESAS



8.18 Signalsto Indicate Bus States and Areas

The following tables show examples of signals to indicate the bus states and areas that can be acquired by the

emulator.

Table8.4 Bus State Signals Acquired by the Emulator

Bus State Trace Display (Status) Description
CPU Prefetch PROG CPU prefetch cycles
CPU Data DATA CPU data access cycles
Refresh REFRESH Refresh cycles
DMAC DMAC DMAC cycles
DTC DTC DTC cycles
Other OTHER Others

Table85 AreaSignalsAcquired by the Emulator
Area Trace Display (Status) Description
On-chip ROM ROM ROM
On-chip RAM RAM RAM
On-chip 1/0 16bit 1/10-16 16-bit I/0
On-chip 1/0 8bit 1/10-8 8-hit 1/0
External /O 16bit EXT-16 16-bit EXT (external)
External I/0O 8bit EXT-8 8-bit EXT (external)
DTC RAM RAM/DTC DTCRAM

Note: The signalsto indicate bus states and areas are used to set the [Bus/Area] condition of the event point.
They can also be acquired as the trace information. The bus state signals are also used to set the
condition not to acquire the trace ([Suppress] option) and in the Access Count Of Specified Range
Measurement mode for measuring the hardware performance ([Access Type] option).

8.1.9 Monitoring Function

This emulator incorporates the bus monitoring circuit as the standard, which thus allows a use of the monitoring
function to update the content of memory without affecting the realtime operation.

8.1.10 Trigger Points

This emulator incorporates the bus monitoring circuit as the standard, which thus allows a use of trigger points
that can be set on the [Trigger] sheet in the [Event] window.
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8.1.11 Tracelnformation

Selecting [View -> Code -> Trace] or clicking the [Trace] toolbar button displays the [Trace] window. Trace
information that can be acquired by the emulator and trace information items to be displayed are as listed below.

[PTR] Cycle number in the trace buffer. When the most recent record is record 0,
earlier record numbers go backwards (-1, -2, ...). If a delay count has been
set, the cycle number where the trace stop condition has been satisfied is
record 0. For the cycle (during delay) executed until the trace has stopped,
earlier record numbers go forward (+1, +2, ...) the most recent record.

[Address] Address (6-digit hexadecimal)

[Instruction] Disassembled code of the executed instruction

[Data] Data bus value, displayed as 2-digit or 4-digit hexadecimal

[R/W] Whether access was read (RD) or write (WR)

[Area] Memory area being accessed; ROM, RAM, 8- or 16-bit I/O, 8- or 16-bit EXT
(external), or DTC RAM (not available when a time stamp is acquired)

[Status] Bus status during this cycle; DTC operation, PROG (prefetch), Data (CPU
data access cycle), Refresh (refresh cycle), or DMAC (DMAC cycle) (not
available when a time stamp is acquired)

[Clock] Number of clock cycles in bus cycle as 1 to 8. To indicate more clock
cycles, “OVR” is displayed (not available when a time stamp is acquired).

[Probes] A 4-bit binary number showing the four probe pins in the order of Probe 4,
Probe 3, Probe 2, and Probe 1 from the left (not available when a time
stamp is acquired).

[NMI] Status of the NMI input (not available when a time stamp is acquired)

[IRQ7-0] Status of eight IRQ inputs (not available when a time stamp is acquired)

[Timestamp]

Time stamp of the record. Time stamps start from zero each time the user
program is executed. The timer resolution depends on the time stamp
clock rate selected in the trace acquisition (only available when a time
stamp is acquired).

[Source] Source program

[Label] Label information that corresponds to the address (if defined)
[Timestamp- Difference from the timestamp value shown on the previous line (only
Difference] available when a time stamp is acquired)
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8.1.12  Searchingfor a Trace Record

While using the emulator, the [Trace Find] dialog box has the following pages:

Table8.6 [TraceFind] Dialog Box Pages

Page Description

[General] Sets the range for searching.

[Address] Sets an address condition.

[Data] Sets a data condition.

[R/W] Selects the type of access cycles.

[Area] Selects the area being accessed (not available when a time stamp is
acquired).

[Status] Selects the status of a bus (not available when a time stamp is acquired).

[Probes] Selects the status of four probe signals (not available when a time stamp
is acquired).

[IRQ7-0] Selects the status of eight IRQ input signals (not available when a time

stamp is acquired).

[Timestamp]

Specify the time stamp value for bus cycles (only available when a time
stamp is acquired).

The [IRQ7-0] page is specific to this emulator. The description is given below.

e [IRQ7-0] page

Select the status of IRQ signals. The selection is not available when atime stamp is acquired.

ind il
General I Address | Data | Fi M | Area |
Status | Probes IRLT-0

—Selting

IRA7  [Dontcare v ] IRGE  [Dontcare v
IRG5  [Dontcare =] 1RG4 [Dontoare <]
IREZ  [Dont care =] 82 [Dontcae x|
IRA1  [Dontcare x| RGD Dot care 7]

ak I Cancel | Apply |

192

Figure 8.8 [TraceFind] Dialog Box ([IRQ7-0] Page)

RENESAS




[Don't care]: Detects no IRQ input condition when this box is checked.

[Setting]: Detects the specified IRQ input condition.

[IRQ7] to [IRQQ]:

Select IRQ input conditions (not available when [Don't care] has been

checked).
Don't care: Detects no selected IRQ input condition.
High: The status of the IRQ input is high.

Low: The status of the IRQ input islow.

8.1.13 TraceFiltering Function

While using the emulator, the [Trace Filter] dialog box has the following pages:

Table87 [TraceFilter] Dialog Box Pages

Page Description

[General] Selects the range for filtering.

[Address] Sets address conditions.

[Data] Sets data conditions.

[R/W] Selects the type of access cycles.

[Area] Selects the area being accessed (not available when a time stamp is not
acquired).

[Status] Sets the status of a bus (not available when a time stamp is not
acquired).

[Probes] Selects the states of four probe signals (not available when a time stamp
is not acquired).

[IRQ7-0] Selects the states of eight IRQ input signals (not available when a time

stamp is not acquired).

[Timestamp]

Specifies the time stamp value for bus cycles (only available when a time
stamp is acquired).

The [IRQ7-0] page is specific to this emulator. The description is given below.
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e [IRQ7-0] page

Select the status of IRQ signals. The selection is not available when atime stamp is acquired.

Trace Filter x|
General I Address | Data Fi M | Area |
Status | Probes IRL70

Setting
IRE7 IDon't care 'I IFGE Im
1RG5 IDon't care 'I IRQ4 IDon't care Yl
IRO3 IDon't care Yl IRQ2 IDon't care 'l
1RO IDon't care Yl RGO IDon't care Yl

ak I Cancel | Apply |

Figure 8.9 [TraceFilter] Dialog Box ([IRQ7-0] Page)

[Don't care]: Detects no IRQ input condition when this box is checked.

[Setting]: Detects the specifi

[IRQ7] to [IRQQ]:
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ied IRQ input condition.

Select IRQ input conditions (not available when [Don't care] has been
checked).

Don't care: Detects no selected IRQ input condition.
High: The status of the IRQ input is high.

Low: The status of the IRQ input islow.
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8.2 Notes on Usage of the H8S/2633 E6000 Emulator

There are the following notes on usage of the emulator.

821 Environment for Execution of the Tutorial Program

To execute the tutorial program, specify “Tutorial.hws’ stored in the following directory:
OS installation drive \Workspace\Tutorial\E6000\2633

The directory mentioned above cannot be specified depending on the version of the software. In such cases,
specify the following directory instead.

High-performance Embedded Workshop installation destination directory
\Tools\Renesas\DebugComp\Pl atform\E6000\2633\T utorial
822 1/0 Register Differences between the Actual MCU and the Emulator

In the E6000 emulator, one evaluation chip emulates several types of MCU. Therefore, there are some
differencesin 1/O registers between an actual MCU and the emulator. Note these differences when accessing the
1/0 registers.

1/0 port isin the input state at default. The |/O register contentsindicate the emulator port status. When the user
system interface cable is not connected, the read value is 1 due to pull-up resistors.

In the emulator, accesses to the following registers for controlling the flash memory are invalid.

e RAM emulation register (RAMER: H'FEDB)

e Flash memory control register 1 (FLMCR1: H'FFA8)

e Flash memory control register 2 (FLMCR2: H'FFA9)

o Block register 1 (EBR1: H'FFAA)

e Block register 2 (EBR2: HFFAB)

e Flash memory power control register (FLPWCR: H'FFAC)

Note: The addresses indicate the lower 16 bits.

823 Accessto the Reserved Area
When accessing the reserved area, note the following:

If the reserved areais used, the operation in the actual MCU cannot be guaranteed. If the user program extends
to the reserved area during debugging, select the MCU having the largest ROM capacity (for example, debug the
H8S/2631 program in the H8S/2633 mode).

824 Using the Internal RAM Area as External Addresses

When the RAME hitin SYSCR is 0, theinterna RAM area can be used external addresses. Note that, however,
the only memory that can be accessed is User (external), not Emulator (emulation memory). In this case, the On-
Chip Read-write (Internal RAM) setting is applied for memory mapping.

825 Support of Flash Memory

This emulator does not emulate the flash memory in the MCU.
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8.2.6 Hardwar e Standby

This emulator does not support the hardware standby function. Therefore, checking [User Standby enable] in the
[Configuration Properties] dialog box isinvalid.
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Appendix A 1/O File Format

High-performance Embedded Workshop formats the [1O] window based on information it findsin an 1/0
Register definition file. When you select a debugging platform, High-performance Embedded Workshop will
look for a“<device>.10” file corresponding to the selected device and load it if it exists. Thisfileisaformatted
text file that describes the 1/0 modules and the address and size of their registers. Y ou can edit thisfile, with a
text editor, to add support for memory mapped registers or peripherals you may have specific to your application
(e.g. registersin an ASIC device mapped into the microcomputer's address space).

The following describes two formats of the “<device>.10” file that supports or not the bit field.

A.l Fileformat (Bit Field Not Supported)

Each module name must be defined in the [Modules] definition section and the numbering of each module must
be sequential. Each module corresponds to a register definition section and within the section each entry defines
an 1/O register.

The [BaseAddress] definition is for devices where the location of 1/0 registers movesin the address space
depending on the CPU mode. In this case, the [BaseAddress] value is the base address of the I/O registersin one
specific mode and the addresses used in the register definitions are the address locations of the registersin the
same mode. When the 1/0 register fileis actually used, the [BaseAddress] value is subtracted from the defined
register address and the resultant offset added to the relevant base address for the selected mode.

The [Register] definition entry is entered in the format <name> = <address> [<size> [<absolute>]].
1. <name> register name to be displayed.
2. <address> address of the register.
3. <size>which may be B, W or L for byte, word, or longword (default is byte).

4. <absolute> which can be set to A if the register is at an absolute address. Thisis only relevant
if the 1/0 area address range moves about on the CPU in different modes. In this case, if a
register is defined as absolute the base address offset calculation is not performed and the
specified address is used directly.

Comment lines are allowed and must start with a*“;” character.

An example is shown below.
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Example:
; H8S/2655 Series 1/0 Register Definitions File
[ [Modules]
BaseAddress=0
Module Modulel=Power_Down_Mode_Registers
definition Module2=DMA_Channel_Common
Module3=DMA_Channel_0

Comment

Module42=Bus_Controller
Module43=System_Control
Module44=Interrupt_Controller

[DMA_Channel_Common]
DMAWER=0xffff00 B A
DMATCR=0xffff01 B A
DMACROA=0xffff02 B A
DMACROB=0xffff03 B A
DMACR1A=0xffff04 B A
DMACR1B=0x{fff05 B A
DMABCRH=0x(ffff06 B A
DMABCRL=0Xffff07 B A

Register
definition

[DMA_Channel_0]
MAROAH=0xfffeeO W A
MAROAL=0xfffee2 W A
I0OAROA=0xfffeed W A
ETCROA=0xfffee6 W A
MAROBH=0xfffee8 W A
MAROBL=0xfffeea W A
I0OAR0OB=0xfffeec W A

—— ——————— ETCROB=0xfffeee W A
Address |

Register name

Size

Absolute address flag
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A2 Fileformat (Bit Field Supported)

Each module name must be defined in the [Modules] definition section and the numbering of each module must
be sequential. Each module corresponds to a register definition section and within the section each entry defines
an 1/0 register.

The user must define “FileVersion=2" at the start of the section. It means that this 1/O register fileis described
with the version that supports the bit field.

The [BaseAddress] definition is for devices where the location of 1/0 registers movesin the address space
depending on the CPU mode. In this case, the [BaseAddress] value is the base address of the 1/0 registersin one
specific mode and the addresses used in the register definitions are the address locations of the registersin the
same mode. When the 1/0 register fileis actually used, the [BaseAddress] value is subtracted from the defined
register address and the resultant offset added to the relevant base address for the selected mode.

Each module has a section that defines the registers forming it along with an optional dependency. The
dependency is checked to seeif the module is enabled or not. Each register name must be defined in the section
and the numbering of each register must be sequential. The dependency is entered in the section as dep=<reg>
<bit> <value>.

1. <reg>istheregister id of the dependency.
2. <bit> isthe bit position within the register.
3. <vaue> isthe vaue that the bit must be for the module to be enabled.

The [Register] definition entry is entered in the format id=<name> <address> [<size>
[<absolute>[<format>[<bitfields>]]]].

1. <name> register name to be displayed.
2. <address> address of the register.
3. <size>which may be B, W or L for byte, word, or longword (default is byte).

4. <absolute> which can be set to A if theregister is at an absolute address. Thisis only relevant
if the I/O area address range moves about on the CPU in different modes. In this case, if a
register is defined as absolute the base address offset calculation is not performed and the
specified address is used directly.

5. <format> format for register output. VValid values are H for Hexadecimal, D for decimal, and
B for binary.

6. <bitfields> section defining the bits within the register.

Bitfield sections define the bits within aregister each entry is of the type bit<no>=<name>.
1. <no>isthebit number.
2. <name> isasymbolic name of the bit.

Comment lines are allowed and must start with a*“;” character.

An example is shown below.
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Example:
Comment ; H8S/2655 Series 1/0 Register Definitions File
[ [Modules]
FileVersion=2
BaseAddress=0
Modulel=Power_Down_Mode_Registers
Module2=DMA_Channel_Common
Module3=DMA_Channel_0
Module
Module42=Bus_Controller
Module43=System_Control
Module44=Interrupt_Controller

[DMA_Channel_Common]

reg0=regDMAWER

regl=regDMATCR

e reg2=regDMACROA

definition reg3=regDMACROB

reg4d=regDMACR1A
reg5=regDMACR1B
reg6=regDMABCRH
reg7=regDMABCRL

L dep=regMSTPCRH 7 0

Module

Register name
Bit
Value

Register [regDMAWER]
__definition id=DMAWER 0xffff00 B A H dmawer _bitfields
Register name |
Address
Size
Absolute address flag
Format
Bit field

[dmawer_bitfields]
bit3=WE1B
bit2=WE1A
bit1=WEOB
bitO=WEOA

Bit-field
definition
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Appendix B Menus

Table B.1 shows GUI menus.

TableB.1 GUI Menus

Toolbar
Menu Option Shortcut  Button Remarks
View Difference Opens the [Difference]
window.
Command Line Ctrl +L Opens the [Command Line]
window.
TCL toolkit Shift + = Opens the [Console] window.
Ctrl + L oo
Workspace Alt + K Opens the [Workspace]
window.
Output Alt+U Opens the [Output] window.
Disassembly Ctrl + D Opens the [Disassembly]
window.
CPU Registers Ctrl + R Opens the [Registers] window.
Memory... Ctrl + M Opens the [Memory] window.
10 Ctrl + 1 Opens the [IO] window.
Status Ctrl + U Opens the [Status] window.
Extended Monitor Opens the [Extended Monitor]
=i window.
Monitor  Monitor Shift + . Opens the [Monitor] window.
Setting... Ctrl+E
Windows Opens the [Windows Select]
Select... dialog box to list, add, or edit
the [Monitor] window.
Sym-  Labels Shift + Opens the [Labels] window.
bol Ctrl + A
Watch Ctrl + W Opens the [Watch] window.
Locals Shift + Opens the [Locals] window.
Ctrl + W
Code  Eventpoints Ctrl + E Opens the [Eventpoints]
window.
Trace Ctrl+T Opens the [Trace] window.
Stack Trace Ctrl + K Opens the [Stack Trace]

window.
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TableG.1 GUI Menus (cont)

Menu Option

Toolbar

Shortcut  Button

Remarks

View Gra-
(cont) phic

Image...

Shift + E
Ctrl + G

Opens the [Image] window.

Waveform...

Shift +
Ctrl +V

Opens the [Waveform]
window.

Per- Performance
form-  Analysis
ance

Shift +
Ctrl + P

Opens the [Performance
Analysis] window.

Debug Debug Sessions...

Opens the [Debug Sessions]
dialog box to list, add, or
remove the debug session.

Debug Settings...

Opens the [Debug Settings]
dialog box to set the
debugging conditions or
download modules.

Reset CPU

Resets the target hardware
and sets the PC to the reset
vector address.

Go

F5

Starts executing the user
program at the current PC.

Reset Go

Shift + F5

Resets the target hardware
and executes the user
program from the reset vector
address.

Go To Cursor

Starts executing the user
program at the current PC until
the PC reaches the address
indicated by the current text
cursor position.

Set PC To Cursor

Sets the PC to the address at
the row of the text cursor.

Run...

Launches the [Run Program]
dialog box allowing the user to
enter the PC or PC breakpoint
during executing the user
program.

Display PC

Shift +
Ctrl+Y

Opens the Editor or
Disassembly window at the
address of the PC.
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TableG.1 GUI Menus (cont)

Menu Option

Shortcut

Toolbar
Button

Remarks

Debug Step In
(cont)

F11

™

Executes a block of user
program before breaking.

Step Over

F10

[

Executes a block of user
program before breaking. If a
subroutine call is reached, then
the subroutine will not be
entered.

Step Out

Shift +
F11

Executes the user program to
reach the end of the current
function.

Step...

Launches the [Step Program]
dialog box allowing the user to
modify the settings for stepping.

Step Auto
Mode

Steps only one source line when
the [Source] window is active.
When the [Disassembly] window
is active, stepping is executed in
a unit of assembly instructions.

Assembly

Executes stepping in a unit of
assembly instructions.

Source

Steps only one source line.

Halt Program

Esc

Stops the execution of the user
program.

Initialize Disconnects the debugging
platform and connects it again.
Connect Connects the debugging
= platform.
Disconnect Disconnects the debugging

platform.

Save Memory...

Saves the specified memory
area data to a file.

Verify Memory...

Verifies file contents against
memory contents.

Configure Overlay...

Selects the target section group
when the overlay function is
used.

Download Modules

Downloads the object program.

Unload Modules

Unloads the object program.

RENESAS
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TableG.1 GUI Menus (cont)

Menu Option

Toolbar

Shortcut  Button

Remarks

Setup Customize...

Customize the High-performance
Embedded Workshop
application.

Options...

Sets option of the High-
performance Embedded
Workshop application.

Format Views...

Configure fonts, colors,
keywords and so on, for the
window.

Radix Hexadecimal

Decimal

Uses a hexadecimal for
displaying a radix in which the
numerical values will be
displayed and entered by
default.

Uses a decimal for displaying a
radix in which the numerical
values will be displayed and
entered by default.

Octal

Uses an octal for displaying a
radix in which the numerical
values will be displayed and
entered by default.

Binary

Uses a binary for displaying a
radix in which the numerical
values will be displayed and
entered by default.

Emu-
lator

System...

Opens the [Configuration] dialog
box allowing the user to modify
the debugging platform settings.

Memory
Resource...

Opens the [Memory Mapping]
dialog box allowing the user to
view and edit the debugging
platform's current memory map.
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Appendix C Command Lines
Table C.1 lists the High-performance Embedded Workshop commands.

TableC.1 High-performance Embedded Workshop Commands

No. Command Name Abbreviation Function

1 ! - Comment

2 ADD_FILE AF Adds a file to the current project

3 ANALYSIS AN Enables or disables performance analysis

4 ANALYSIS_RANGE AR Sets or displays a performance analysis range

5 ANALYSIS_RANGE_ AD Deletes a performance analysis range
DELETE

6 AUTO_COMPLETE AC Enables or disables command complement function

7  ASSEMBLE AS Assembles instructions into memory

8 ASSERT - Checks if an expression is true or false

9 BREAKPOINT BP Sets a breakpoint at an instruction address

10 BREAKPOINT_CLEAR BC Deletes breakpoints

11 BREAKPOINT_ BD Displays a list of breakpoints
DISPLAY

12 BREAKPOINT_ENABLE BE Enables or disables a breakpoint

13 BREAKPOINT_ BS Sets sequential breakpoints
SEQUENCE

14 BUILD BU Starts a build operation on the current project

15 BUILD_ALL BL Starts a build all operation on the current project

16 CHANGE_ CcC Sets the current configuration
CONFIGURATION

17 CHANGE_PROJECT CP Sets the current project

18 CHANGE_SESSION CS Changes the session of the current project

19 CLOCK CK Set the CPU clock rate in the emulator

20 CONFIGURE_ CPF Sets the debugging environment for the emulator
PLATFORM

21 CLOSE_WORKSPACE CW Close the current workspace

22 DEFAULT_OBJECT_ DO Sets the default object (program) format
FORMAT

23 DEVICE_TYPE DE Selects a device type to emulate

24 DISASSEMBLE DA Disassembles memory contents

25 ERASE ER Clears the [Command Line] window

26 EVALUATE EV Evaluates an expression

27 EXMONITOR_DISPLAY EXMD Displays the content of the expansion monitor

28 EXMONITOR_SET EXMS Selects whether or not to display the items in the

expansion monitor

29 EXMONITOR_ EXMSR Sets the time to update the expansion monitor during
SETRATE emulation or a break

30 FILE_LOAD FL Loads an object (program) file

31 FILE_SAVE FS Saves memory to a file

32 FILE_UNLOAD FU Unloads a file

33 FILE_VERIFY FV Verifies file contents against memory
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TableH.1 High-performance Embedded Workshop Commands (cont)

No. Command Name

Abbreviation Function

34 GENERATE_MAKE_ GM Creates a makefile to be built outside the High-
FILE performance Embedded Workshop

35 GO GO Executes user program

36 GO_RESET GR Executes user program from reset vector

37 GO_TILL GT Executes user program until temporary breakpoint

38 HALT HA Halts the user program

39 HELP HE Displays the syntax of a command

40 INITIALIZE IN Initializes the debugging platform

41 LOG LO Controls command output logging

42 MAP_DISPLAY MA Displays memory mapping

43 MAP_SET MS Sets memory mapping

44 MEMORY_COMPARE MC Compares memory contents

45 MEMORY_DISPLAY MD Displays memory contents

46 MEMORY_EDIT ME Modifies memory contents

47 MEMORY_FILL MF Modifies the content of a memory area by specifying
data

48 MEMORY_FIND Ml Searches for data within the memory range

49 MEMORY_MOVE MV Moves a block of memory

50 MEMORY_TEST MT Tests a block of memory

51 MODE MO Sets or displays the CPU mode

52 MODULES MU Sets up or displays the on-chip peripheral functions

53 MONITOR_CLEAR MOC Deletes a monitor point

54 MONITOR_DISPLAY  MOD Displays the content of the monitor

55 MONITOR_REFRESH MOR Controls an automatic update of the content of the
monitor

56 MONITOR_SET MOS Sets or displays a monitor point

57 OPEN_WORKSPACE OW Opens a workspace

58 QUIT QU Exits High-performance Embedded Workshop

59 RADIX RA Sets default input radix

60 REFRESH RF Updates windows related to memory

61 REGISTER_DISPLAY RD Displays CPU register values

62 REGISTER_SET RS Sets CPU register contents

63 REMOVE_FILE REM Deletes the specified file from the current project

64 RESET RE Resets CPU

65 SLEEP - Delays command execution

66 SAVE_SESSION SE Saves the session of the current project

67 STATUS STS The content of the [Platform] sheet in the [Status]
window is displayed.

68 STEP ST Steps program (by instructions or source lines)

69 STEP_MODE SM Sets the step mode

70 STEP_OUT SP Steps out of the current function

71 STEP_OVER SO Steps program, not stepping into functions

72 STEP_RATE SR Sets or displays rate of stepping
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TableH.1 High-performance Embedded Workshop Commands (cont)

No. Command Name Abbreviation Function

73 SUBMIT SuU Executes a command file

74 SYMBOL_ADD SA Defines a symbol

75 SYMBOL_CLEAR SC Deletes a symbol

76 SYMBOL_LOAD SL Loads a symbol information file

77 SYMBOL_SAVE SS Saves a symbol information file

78 SYMBOL_VIEW SV Displays symbols

79 SAVE_WORKSPACE SW Saves the current workspace

80 TCL - Enables or disables the TCL

81 TIMER TI Sets or displays the timer resolution

82 TOOL_INFORMATION TO The information on the tool registered is outputted by

the file

83 TRACE TR Displays trace information

84 TRACE_ACQUISITION TA Sets or displays trace acquisition parameters

85 TRACE_BINARY_ TBC Compares a trace binary file with the current trace
COMPARE information

86 TRACE_BINARY_SAVE TBV Outputs trace information into a binary file

87 TRACE_FILTER TF Filter the trace information

88 TRACE_STATISTIC TST Analyzes statistic information

89 TRACE_SAVE TV Outputs trace information into a file

90 TRIGGER_CLEAR TGC Deletes the trigger output condition for EXT.2

91 TRIGGER_DISPLAY  TGD Displays the trigger output condition for EXT.2

92 TRIGGER_SET TGS Sets the trigger output condition for EXT.2

93 UPDATE_ALL_ ubD Updates the dependencies for the current project
DEPENDENCIES

94 USER_SIGNALS us Enables or disables the user signal information

95 WATCH_ADD WA Adds a watch item

96 WATCH_AUTO_UPDAT WU Selects or cancels automatic update of watch items
E

97 WATCH_DELETE WD Deletes a watch item

98 WATCH_DISPLAY wi Displays the contents of the Watch window

99 WATCH_EDIT WE Edits the value of a watch item

100 WATCH_EXPAND WX Expands or collapses a watch item

101 WATCH_RADIX WR Changes the radix of a watch item to be displayed

102 WATCH_SAVE ws Saves the contents of the Watch window to a file

For the syntax of each command, refer to the online help.
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Appendix D Diagnostic Test Procedure

This section describes the diagnostic test procedure using the E6000 test program.

D.1 System Set-Up for Test Program Execution

To execute the test program, use the following hardware; do not connect the user system interface cable and user
system.

a b~ W N

E6000 emulator (HS2633REPI61H or HS2633EPI61H)

Host computer

The E6000 PC interface board (Select one interface board or card from the following depending on the PC
interface specifications.):

PCI bus interface board (HS6000EICO1H or HS6000EI CO2H)

PCMCIA interface card (HS6000EI PO1H)

USB adapter (HS6000EIUO01H or HS6000EIUO2H)

LAN adapter (HS6000EL NO1H)

. Install the E6000 PC interface board in the host computer and connect the supplied PC interface cable to the

board.

. Connect the PC interface cable to the emulator.

. Connect the supplied AC adapter to the emulator.

. Initiate the host computer to make it enter DOS prompt command input wait state.
. Turn on the emulator power switch.
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D.2 Diagnostic Test Procedure Using Test Program

Insert the CD-R (HS2633REPI61SR supplied with the emulator) into the CD-ROM drive of the host compuiter,
move the current directory to <Drive>:\Diag with a command prompt, and enter one of the following commands
according to the PC interface board used to initiate the test program:

1. PCI businterface board (HS6000EICO1H or HS6000EI CO2H)
>TM2633 -PCI (RET)

2. PCMCIA interface card (HSB000EIPOLH)
> TM2633 —-PCCD (RET)

3. USB adapter (HSB000EIUO1H or HSB000EIUO2H)
>TM2633 -USB (RET)

4. LAN adapter (HSB000ELNOLH)
> TM2633 -ELN (RET)

The High-performance Embedded Workshop must be installed before the test program is executed.

Be sure to initiate the test program from <Drive>:\Diag. Do not initiate it from adirectory other than
<Drive>:\Diag, such as > <Drive>:\Diag\TM 2633 —PCl (RET). If the test program isinitiated when the current
directory is not <Drive>:\Diag, the test program will not operate correctly.

When -Sis added to the command line such as >TM2633 —PCl —S (RET), steps 1 to 19 will be repeatedly
executed. To stop the execution, enter Q.

Notes: 1.  <Drive> isadrive name for the CD-ROM drive.

2. Do not remove the CD-R from the CD-ROM drive during test program execution.
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The following messages are displayed during test. Thistest consists of steps 1 to 19.

M essage

E6000 H8S/2633 EMULATION BOARD Tests Vx.x

SIMM module fitted? (1. None 2. IMB 3. 4MB) : 1
Searching for interface card ........... OK, card at H'd0000000
Checking emulator is connected ......... OK

Emulator Board Information:

Main Board ID H'S
Emulation Board ID H'd
Revision H'x
SIMM No SIMM module inserted

Downloading firmware .....

01) Testing Register

C.E.S. G/B ittt OK
Register Test ........iiiiiinnnnna.. OK
READ ADDRESS = 1F10 READ DATA = 40
READ ADDRESS = 1F11 READ DATA = 00
READ ADDRESS = 1F12 READ DATA = 0B
READ ADDRESS = 1F13 READ DATA = 38
READ ADDRESS = 1F14 READ DATA = 46
READ ADDRESS = 1F15 READ DATA = 07
READ ADDRESS = 1FF1 READ DATA = 65
READ ADDRESS = 1FF3 READ DATA = 8D
READ ADDRESS = 1FF5 READ DATA = F1

02) Testing Dual-Port RAM :

Decode TeSt ...uivirinnnninennnnnnnn OK
Marching Test «.uuvvvveitmnneeennnn OK

RENESAS

Description

Test program start
message. Vx.x shows the
version number.

Enter 1 because the SIMM
memory module is not
installed in this
example.

Shows that the PC
interface board is
correctly installed in
the host computer and
displays the address
assigned to the board.
The displayed address
depends on the settings.

Shows that the E6000 is
correctly connected to
the host computer.

Shows the ID number of
the lower board of the
E6000 (always 5).

Shows the ID number of
the upper board of the
E6000 (always d).

Shows the revision number
of the upper board of the
E6000 as x.

Shows whether the SIMM
memory board is
installed.

Loading the test program.

Shows the check results
for the registers in the
E6000 (normal
completion) .

Shows the results of
decoding test and
marching test for the
dual-port RAM in the
E6000 (normal
completion) .
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03) Testing Firmware RAM

Decode Test. page range H'700 - H'71f .......... OK

Marching Test. page range H'700 - H'71f ........ OK

Downloading firmware .....

04) Testing Trace RAM

Decode Test. page range H'000 - H'04f .......... OK

Marching Test. page range H'000 - H'04f ........ OK

05) Testing Mapping RAM

Decode Test. page range H'200 - H'27f .......... OK

Marching Test. page range H'200 - H'27f ........ OK

06) Testing Option RAM :

No SIMM fitted - test skipped

07) Testing STEP Operation

Single Step Operation .............. OK
Step Into Operation ................ OK

08) Testing Internal ROM and RAM

Setting up, please wait
Decode TeSt .....viiiiiiiiinennnn.

Marching Test

09) Testing Key Break

Key Break .....uiiiiiiniininiinnnn. OK

10) Testing Emulation RAM Hardware Break

GRD Break .........oiiiiiiiennnnnnn. OK
WPT Break .......oiiiniinnennnnnnnnn. OK
212

RENESAS

Shows the results of
decoding test for the
firmware RAM in the E6000
(normal completion) .

Shows the results of
marching test for the
firmware RAM in the E6000
(normal completion).

Loading the test program.

Shows the results of
decoding test for the
trace RAM in the E6000
(normal completion) .

Shows the results of
marching test for the
trace RAM in the E6000
(normal completion).

Shows the results of
decoding test for the
mapping RAM in the E6000
(normal completion) .

Shows the results of
marching test for the
mapping RAM in the E6000
(normal completion) .

Shows the check results
for the optional SIMM
memory module in the
E6000 (not installed).

Shows the check results
for the step execution
controlling circuits in
the E6000 (normal
completion) .

Shows the results of
decoding test and
marching test for
internal ROM and RAM in
the E6000 (normal
completion) .

Shows the check results
for the forced break
controlling circuits in
the E6000 (normal
completion) .

Shows the check results
for the illegal access
break controlling
circuits in the E6000
(normal completion) .



11)

Wri
NO
ROM

12)

Bre
Eve
Che
Che:
Che:
Che
Che
Che:
Che:
Che
Tes
Tes
Tes

13)

Gua
Gua
Gua
Gua
Wri
Wri
Wri
Wri
ROM
ROM
ROM
ROM

14)

Fre
Ran
Poi
Sta

15)

Tes
Tes
Tes

16)

A23
WIN
ASE
CNN

17)

0w o

)
)
)
D

Tim
Tim

Testing Internal ROM Write-Protect
te-Protect ........... .. ...l OK
CLK BIT (MONIT3E,MONIT30:Dl) ....OK

Write ACK BIT (MONIT30:D5) ..... OK

Testing Hardware Break
ak Point Initialized ............ OK
nt Detectors CES channel 1-12 ...OK
ck Access Either ................ OK
ck Access Read .................. OK
ck Access
ck Access
ck Access Delay .....covevvennnn. OK
ck Compare Either ............... OK
ck Range Break .................. OK
ck Range Break for Data ......... OK
t Sequencing 1

t Sequencing 2
t Sequencing 3

Testing Memory Mapping

rded Read
rded Write
rded Read Break OFF)
rded Write (Break OFF) ..
te-Protect Read (Break ON) ..........
te-Protect Write (Break ON) ..........
te-Protect Read (Break OFF) .........
te-Protect Write (Break OFF) .........
Write-Protect Read (Break ON)
Write-Protect Write (Break ON) .
Write-Protect Read (Break OFF) ..... OK
Write-Protect Write (Break OFF) ..... OK

Break ON)
Break ON)

(
(
(
(

Testing Emulation RAM Trace

e Trace Test .............oiunnn. OK
ge Trace Test ..., OK
nt to Point Trace Test .......... OK
rt and Stop Event Trace Test ....OK

Testing Runtime counter
ting clock at 25MHz .
ting clock at 20MHz ............. OK
ting clock at 10MHZ ............. OK

Testing Emulation Monitor

to A0 (MONITO0O, MONIT1E, MONIT10) ......... OK
DOW (MONIT3E:D3) .ivvviiniiiieennnnnnnnnnns OK
BRKACK (MONITOE:D7,MONIT2E:D7) .........o.o... OK
(MONIT3E:DL) o vviiiiii e ieiiiiiieeeeeaannn OK

Testing PERM_GA

Time Measure Test .. .
PERM_POINT TO POINT Time Measure Test ..... OK
PERM_SUBROUTINE Time Measure Test ......... OK
PERM Time Out Bit Test

e Out Test l........iiiiniiininnnnnnnnnn OK

e Out Test 2........iiiiniiiinnnnnnnnnn OK

Shows the check results
for the internal ROM
write-protection
controlling circuits in
the E6000 (normal
completion) .

Shows the check results
for the hardware break
control circuits in the
E6000 (normal
completion) .

Shows the check results
for the memory mapping
controlling circuits in
the E6000 (normal
completion) .

Shows the check results
for the trace controlling
circuits in the E6000
(normal completion) .

Shows the check results
for the run-time counter
in the E6000 (normal
completion) .

Shows the check results
for the emulation monitor
controlling circuits in
the E6000 (normal
completion) .

Shows the check results
for analysis controlling
circuits in the E6000
(normal completion).
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18) Testing Bus Monitor

Setting

up, please wait

A) Register LesSh...uun e ettt inenennnennnn

B) Parallel RAM test
C) SPRSEL2 test

Setting up, please wait
D) RAM monitor test.................ooiuiinn.n. OK

19) Testing Parallel Access

A) IN ROM Parallel Read Access(WORD) .......... OK
B) IN ROM Parallel Write Access(WORD) ......... OK
C) IN ROM Parallel Write Access(High Byte) ....OK
D) IN ROM Parallel Write Access(Low Byte) ..... OK
E) IN RAM Parallel Read Access (WORD) . OK
F) IN RAM Parallel Write Access(WORD) ......... OK
G) IN RAM Parallel Write Access(High Byte) ....OK
H) IN RAM Parallel Write Access(Low Byte) ..... OK
I) SIMM Parallel Read Access(WORD) ............ skip
J) SIMM Parallel Write Access(WORD) ........... skip
K) SIMM Parallel Write Access(High Byte) ...... skip
L) SIMM Parallel Write Access(Low Byte) ....... Skip
0 total errors

Tests passed, emulator functioning correctly
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Shows the check results
for the bus monitor
controlling circuits in
the E6000 (normal
completion) .

Shows the check results
for the parallel access
controlling circuits in
the E6000 (normal
completion) .

Total number of errors.

Shows that the E6000 is
correctly operating.
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